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Copyright Notice
Copyright © 1998 Magellan Corporation.  All rights reserved.  
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duced, translated, stored in a retrieval system, or transmitted in any form or by a
means, electronic, mechanical photocopying, recording, or otherwise, without pr
written permission of Magellan. Your rights with regard to this publication and th
computer programs are subject to the restrictions and limitations imposed by the
yright laws of the United States of America (“U.S.A.”) and/or the jurisdiction in 
which you are located.  

For information on translations and distribution outside the U.S.A. please contac
Ashtech.
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Trademark Notice
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SOFTWARE LICENSE AGREEMENT

IMPORTANT: BY OPENING THE SEALED DISK PACKAGE CONTAINING THE SOFT-
WARE MEDIA, YOU ARE AGREEING TO BE BOUND BY THE TERMS AND CONDI-
TIONS OF THE LICENSE AGREEMENT (“AGREEMENT”).  THIS AGREEMENT 
CONSTITUTES THE COMPLETE AGREEMENT BETWEEN YOU (“LICENSEE”) AND 
MAGELLAN CORPORATION. (“LICENSOR”).  CAREFULLY READ THE AGREEMENT 
AND IF YOU DO NOT AGREE WITH THE TERMS, RETURN THIS UNOPENED DISK 
PACKAGE AND THE ACCOMPANYING ITEMS TO THE PLACE WHERE YOU OB-
TAINED THEM FOR A FULL REFUND.

LICENSE.  LICENSOR grants to you a limited, non-exclusive, non-transferable, personal
cense (“License”) to (i) install and operate the copy of the computer program contained in
package (“Program”) in machine acceptable form only on a single computer (one central 
processing unit and associated monitor and keyboard) and (ii) make one archival copy of
Program for use with the same computer.  LICENSOR and its third-party suppliers retain
rights to the Program not expressly granted in this Agreement.

OWNERSHIP OF PROGRAMS AND COPIES.  This License is not a sale of the original P
gram or any copies.  LICENSOR and its third-party suppliers retain the ownership of the 
gram and all copyrights and other proprietary rights therein, and all subsequent copies of
Program made by you, regardless of the form in which the copies may exist.  The Program
the accompanying manuals (“Documentation”) are copyrighted works of authorship and co
valuable trade secret and confidential information proprietary to LICENSOR and its third-p
suppliers.  You agree to exercise reasonable efforts to protect the proprietary interests of L
SOR and its third-party suppliers in the Program and Documentation and maintain them in
confidence.

USER RESTRICTIONS.  The Program is provided for use in your internal commercial busi
operations and must remain at all times upon a single computer owned or leased by you.
may physically transfer the Program from one computer to another provided that the Progr
operated only on one computer at a time.  You may not operate the Program in a time-sha
service bureau operation or rent, lease, sublease, sell, assign, pledge, transfer, transmit e
ically or otherwise dispose of the Program or Documentation, on a temporary or permane
sis, without the prior written consent of LICENSOR.  You agree not to translate, modify, ad
disassemble, decompile, or reverse engineer the Program, or create derivative works of t
gram or Documentation or any portion thereof.

TERMINATION.  The License is effective until terminated.  The License will terminate witho
notice from LICENSOR if you fail to comply with any provisions of this Agreement.  Upon 
mination, you must cease all use of the Program and Documentation and return tem, and
copies thereof, to LICENSOR.

GENERAL.  This Agreement shall be governed by and construed in accordance with the 
of the State of California and the United States without regard to conflict of laws provision
thereof and without regard to the United Nations Convention on Contracts for the Internat
Sale of Goods.
 iii
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DISCLAIMER OF WARRANTIES AND LIMITATION OF LIABILITY

LICENSOR AND ITS THIRD-PARTY SUPPLIERS MAKE NO WARRANTIES OR REPRE-
SENTATIONS, EXPRESS OR IMPLIED, REGARDING THE PROGRAM, MEDIA, DOCU-
MENTATION, RESULTS OR ACCURACY OF DATA AND HEREBY EXPRESSLY 
DISCLAIM ANY WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PAR-
TICULAR PURPOSE AND NONFRINGEMENT.  LICENSOR AND ITS THIRD-PARTY 
SUPPLIERS DO NOT WARRANT THE PROGRAM WILL MEET YOUR REQUIRE-
MENTS OR THAT ITS OPERATION WILL BE UNINTERRUPTED OR ERROR-FREE.

LICENSOR, its third-party suppliers, or anyone involved in the creation or deliver of the Pro-
gram or Documentation to you shall have no liability to you or any third-party for special, inci-
dental, indirect or consequential damages (including, but not limited to, loss of profits or 
savings, downtime, damage to or replacement of equipment or property, or recover or replace-
ment of programs or data) arising from claims based in warranty, contract, tort (including neg-
ligence), strict liability, or otherwise even if LICENSOR or its third-party suppliers have been 
advised of the possibility of such claim or damages.  The liability of LICENSOR and its third-
party suppliers for direct damages shall not exceed the actual amount paid for this Program Li-
cense.

Some states do not allow the exclusion of limitation of implied warranties or liability for inci-
dental or consequential damages, so the above limitations or exclusions may not apply to you.

U.S. GOVERNMENT RESTRICTED RIGHTS

The Program and Documentation are provided with RESTRICTIVE RIGHTS.  Use, duplication, 
or disclosure by the Government is subject to restrictions as set forth in subdivision (c)(1)(ii) of 
the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subdi-
vision 9(C)(1) and (2) of the Commercial Computer Software - Restricted Rights 48 CFR 
52.227.19, as applicable. 

Should you have any questions concerning the License Agreement or the Limited Warranties 
and Limitation of Liability, please contact in writing:  Ashtech, 1170 Kifer Road, Sunnyvale, 
CA 94086
Reliance Office User’s Guide
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Reliance field asset management tools provide managers with reliable, accurate 
positioning for more cost-effective control over their assets. Ashtech’s superior 
technology offers software that is easier to use and positional accuracy down to the 
centimeter level for the first time in a GIS mapping system.

The Reliance System

The Reliance system utilizes the Global Positioning System (GPS) to tag positions of
assets with extensive feature and attribute information. These feature positions and 
attributes are made available in formats that allow you to easily update GIS database
Reliance system comes in three packages differentiated by the level of accuracy the
achieve.

The Ashtech Reliance Submeter package comprises of a GPS receiver capable of 
providing submeter accuracy, a backpack, a GPS antenna, interconnecting cables, 
handheld controller with data collection software for the field, and Reliance software
the office.

The Ashtech Reliance Decimeter package includes the same equipment as the stand
package, except that its GPS receiver is capable of providing one to two decimeter 
accuracy.

The Ashtech Reliance Precision package includes the same equipment as the stand
package, except the receiver provides 1-3 centimeter accuracy for point features aft
minutes of stationary occupation. It provides 1-3 decimeter accuracy for all other fea

The difference between these systems is that the Submeter GPS receiver logs only L
code phase measurements. For the Decimeter product, the GPS receiver logs both L
code and carrier phase data. The Precision System also logs code and carrier data, but i
such a way that special post-processing software can provide point feature accuracy
centimeter range.

Main Components

Reliance is a Windows software application used to determine accurate geographic 
positions of a number of features, assign attributes for these features, and export the
features to several well-known GIS Software packages. Reliance provides the ability
view and filter feature and attribute data before exporting.

Reliance field systems centers around an  SCA-12 GPS receiver and a handheld 
controller, to gather GPS data for features of interest in the field and tag the features
n 1
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er’s 
appropriate attribute values. This system utilizes Feature Files pre-defined using 
Reliance. The Feature File is a hierarchical structure of features, attributes, and 
attribute values defined by the user prior to the field session. Feature files provide five 
levels of data:

1. Feature types:

• points
• lines
• areas

2. Feature names such as:

• pole
• road
• lake

3. Attribute names such as:

• height
• weight
• species

4. Attribute values:

• alphanumeric
• numeric
• menus

5. Attribute submenus:

Allowing user to further describe the condition of your feature.

Advantages

Automatic Base File Download From The Internet

Reliance provides the ability to automatically download base files from Internet 
CORS sites.

Compatibility

Reliance offers compatibility with other GIS software packages from manufactur
such as Autodesk, E.S.R.I, Intergraph and MapInfo.

Batch Processing

Reliance provides the ability to transfer, process, and export project data 
automatically. 
Reliance Office User’s Guide
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Join Files/Interpolation

The Join Files feature allows you to concatenate several consecutive Base Station 
files into one file.

The Interpolation feature (for RINEX data files) allows you to create a new RINEX 
O-file with a faster data interval. For example, this program will help you to match 
the 30-second Reference Station data from the CORS sites to your 2-second Rover 
data files by creating a 2-second Base file. 

Types of Reliance Surveying

The Reliance system is very versatile, cost effective tool that allow several levels of 
accuracy during a single surveying session. The following tables list the different 
requirements, possible applications, and published accuracies.

 Table 1.1: Reliance Requirements

Submeter Decimeter Precision

• Corresponding epoch 
between base and rover

• Minimum of 5 satellites 
common between base and 
remote continuously tracked 
for at least 5 minutes.

• less than 500km baseline
• PDOP < 6

• P option installed in SCA-12 
• Corresponding epoch 

between base & rover.
• Minimum of 5 satellites 

common between base and 
remote continuously tracked 
for at least 15 minutes.

• Baselines less than 100km
• PDOP < 3.5

• P & V options installed in the 
SCA-12

• Minimum of 5 satellites 
common between base and 
remote, continuously 
tracked for at least 30 
minutes.

• Static occupation of point for 
prescribed time period.

• Less than 10 km baseline.
• PDOP less than 3.5
n 3
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 Table 1.2: Reliance System Applications

Submeter Decimeter Precision

• Utility mapping 
(power poles)

• Road signs
• Lamp poles
• Fire Hydrants, man 

hole covers, water 
mains

• Parks and recreation 
assets (picnic tables, 
benches, grills)

• Wetland and forest 
management

• Crop scouting, weed 
management

• Lease boundaries 
(not legally binding)

• Projects with specifications requiring better 
than 50 cm control including:
•Utility mapping (power poles)
•Road signs
•Lamp poles
•Fire Hydrants, man hole covers, water 
mains

•Parks and recreation assets (picnic tables, 
benches, grills)

•Wetland and forest management
•Crop scouting, weed management
•Lease boundaries (not legally binding)

• Updating existing maps to higher level of 
accuracy or larger scale

• Registration of map to known published 
control points

• Single points with 
high level of 
accuracy.

 Table 1.3: Reliance System Accuracies

Submeter Decimeter Precision

• 35 cm, static or 
dynamic, 67% 
probability, post-
processed

• 75 cm, static or 
dynamic, 95% 
probability, post-
processed

• 45 cm, 2-sec RTCM 
latency, 67% 
probability, real-
time correction

• 10 cm, tracking satellites for 20 min, static 
or dynamic, 67% probability, post-
processed

• 15 cm, tracking satellites for 20 min, static 
or dynamic, 95% probability, post-
processed

• 15 cm, tracking satellites for 10 min, static 
or dynamic, 67% probability, post-
processed

• 30 cm, tracking satellites for 10 min, static 
or dynamic, 95% probability, post-
processed

• 15 cm, tracking satellites for 10 min, static 
or dynamic, 67% probability, post-
processed

• 35 cm, instantaneous, static or dynamic, 
67% probability, post-processed

• 75 cm, instantaneous, static or dynamic, 
95% probability, post-processed

• 45 cm, 2-sec RTCM latency, 67% 
probability, real-time correction

• 1 cm, static only, 
tracking satellites for 
> 30 min, 67% 
probability

• 1.5 cm, static only, 
tracking satellites for 
> 30 min, 95% 
probability

• Same accuracy as 
Decimeter system 
for occupation times 
<30 minutes or when 
moving

• 45 cm, 2-sec RTCM 
latency, 67% 
probability, real-
time correction
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Reliance Submeter System

The Reliance Submeter System provides the most economical method of asset 
position acquisition with the fewest limitations on field methods. Submeter positions 
can be achieved static or moving, for baselines up to 500 km provided only that 5 
common satellites are tracked by base and rover for at least 5 min, and PDOP is less 
than 6.0. Submeter RTCM differential operation can also easily be achieved by the 
use of a private, or public reference station.

The Reliance Submeter System offers optimal economy of field collection time while 
producing position accuracies adequate for most GIS and FAM applications.

Reliance Decimeter System

For applications where the accuracy requirements are 1-3 decimeters, Reliance offers 
the total feature asset management (FAM) solution. The Reliance Decimeter system 
uses the same carrier phase measurements as the centimeter system, yet important 
differences allow a static or moving rover to attain results as good as one decimeter in 
as little as 20 minutes.   

In order to achieve results as good as one decimeter for baselines up to 100 km, only a 
few basic criteria must be met. At least five satellites common to base and remote 
receivers must be tracked continuously for a minimum of 20 minutes. The PDOP 
index should remain below 3.5 for the duration the session. Rover antenna setup, and 
reference coordinate errors add directly to resulting position errors, but with careful 
field procedures they can be virtually eliminated. If satellite obstruction becomes a 
problem at some point during feature collection, field operatives can simply continue 
work in the open for 20 minutes to ensure the continuity of decimeter results.

Without sacrificing accuracy for economy the Reliance Decimeter Processor provides 
the best of both worlds for precision GIS and FAM applications.

Reliance Precision System

In order to achieve accuracies as good as 1 cm, the Reliance Processor resolves 
inherent ambiguities in the carrier phase measurements made by the receiver. This 
sensitive process requires that certain minimum criteria be met. At least five satellites 
common to base and remote receivers must be tracked continuously for a minimum of 
30 minutes. The base and rover receivers must remain static (no movement) for the 
duration of each cm occupancy. The geometric distribution of the satellites (measured 
by PDOP index) should remain below 3.5 for the duration of each cm occupancy. Due 
to distance dependent errors which adversely affect Reliance Processor’s ability to 
resolve carrier phase ambiguities, cm processed points should be no farther than 10 
km from the base location.
n 5
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In spite of Reliance’s ability to provide precise positions of logged features, external 
error sources such as faulty antenna height measurement or centering can 
significantly degrade results. Errors in measured rover antenna position and errors in 
the known base station coordinates apply directly to position uncertainty of logged 
features. With careful field procedures, errors resulting from these sources can be 
practically eliminated. If for some reason, the Reliance Processor cannot successfully 
resolve measurement ambiguities, the system will automatically revert to Decimeter 
processed results.

Although data collection for cm processing can be time consuming, it is very 
rewarding in terms of accuracy. There simply is no faster, easier way to achieve 
precise, GIS ready asset positioning than with Reliance CM Processor.

Office Software Installation

Reliance uses Install Shield to load files on your computer. The following section 
describes the Install Shield process.

To install Reliance:

1. Insert the Reliance CD 1 into your CD-ROM drive.

Exit all Windows applications before installing Reliance.

2. From the Windows File Manager, select Run from the File menu. The Run 
dialog box opens (Figure 1.1).

3. Browse for the file SETUP.EXE in the DISK1 directory on the CD-ROM.

 Figure 1.1: Run Dialog Box
Reliance Office User’s Guide
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4. Click OK to launch the Reliance Install Shield. Once Install Shield 
determines your computer is properly configured for installation, the 
software license agreement opens (Figure 1.2).

5. Read the text thoroughly before accepting.

6. Click Yes. 

The Welcome window opens (Figure 1.3).

 Figure 1.2: Software License Agreement

 Figure 1.3: Welcome window
n 7
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7. Read the text thoroughly before accepting and click Next.

The Choose Destination Location window opens (Figure 1.4).

8. The default directory is c:\Reliance. Click OK to install Reliance into 
this directory.

9. If you wish to install Reliance into a different directory, click Browse. The 
Choose Directory window opens (Figure 1.5). 

 Figure 1.4: Choose Destination Location window

 Figure 1.5: Choose Directory window
Reliance Office User’s Guide
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10. Select a target directory and click OK. The Choose Directory window 
closes, and the Choose Destination Directory window opens with the 
selected directory listed.

If you typed in a directory that does not exist, a dialog box opens asking if 
you wish to create the directory. Click Yes to create the directory.

11. Click Next. 

The Options Selection window opens (Figure 1.6).

12. Select which files you wish to have installed on your computer.

If you select Geoid Model, Install Shield requires considerable additional 
hard disk space in order to copy all the files.

 Figure 1.6: Options window
n 9
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13. Click Next once you have selected the files for installation.

The Start Copying Files window opens (Figure 1.7).

14. Should you find the settings appropriate, click Next. If you wish to change 
any of them, click Back.

The Installation process begins installing Reliance into the specified 
directory. The Installation Progress dialogs open displaying the percentage 
of the installation completed (Figure 1.8). 

 Figure 1.7: Start Copying Files window

 Figure 1.8: Installation Progress Dialogs
Reliance Office User’s Guide
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The status bar in the Setup dialog box indicates the progress of the total 
installation, and Table 1.4 defines the progress icons.

15. Install Shield creates a Reliance program group and places Reliance, 
UnInstall Reliance, Reliance Help, Mission Planning and Readme icons 
into it. 

If you are running Windows95 or Windows NT 4.0, Install Shield creates a 
Reliance menu item in the Program menu accessible by clicking Start.

16. Upon completion of installation, Install Shield opens an Information dialog 
box informing you that the setup is complete.

17. Before running Reliance, your computer must reboot. Verify that the Yes, I 
want to restart my computer radio button is checked, and click Finish.

After you computer has rebooted, Reliance is ready to run.

Double click on the “Release Notes” icon in the Reliance program group. This file contains the latest
release information and changes that have not been captured in this User’s Guide.

In addition to the Reliance and the Read Me File, the installation includes a DOS 
program called Mission Planning. For information about Mission Planning and 
Survey planning, refer to Chapter 2, Planning a Field Session.

 Table 1.4: Installation Progress Icons

Icon Definition

This progress bar indicates the percentage the current file 
has completed in loading.

This progress bar indicates the percentage the current disk 
has completed in loading.

This progress bar indicates the percentage of disk space 
available on the Target Drive.
n 11



12
 Reliance Office User’s Guide



 2

Planning a Field Session
Planning a

P
lanning a F

ield 

ning 

lf the 

ce 

tion.

ich 

this 

te the 

 scale 
r 
eter 
it 

ion 
f 
Background

Taking the time to properly plan a Field Session is just as important as data quality. A 
well-planned session saves valuable field time and costs while getting the most accurate 
results. A poorly planned session costs time and money and results could be poor enough 
that you’ll have to revisit the mapped features. Although this chapter covers the plan
required to utilize the Reliance system, it does not cover the specifics for planning 
mapping mechanics.

When planning a GPS/GIS Field Session, the first thing you need to do is ask yourse
following questions:

1. What is the proper “target” accuracy needed to provide a sufficient confiden
that the accuracy specified for the project will be achieved.

2. How great is the benefit of positional accuracy versus the cost of data collec

3. What is the positional accuracy requirement of the GIS or BASE map for wh
the data is being collected?

4. What is the scale of the final map product; at a scale of 1:24000, the dot on 
letter “i” is over 5 meters wide.

Your answers to these questions will determine the time and effort needed to comple
survey.

For example, if you want to update telephone pole locations on an existing map at a
of 1:10,000 so repair men can go out and easily locate poles, the Reliance Submete
system can provide the solution. If the telephone poles are typically 50m apart, subm
accuracy positioning of the poles would be more than adequate. Workers could revis
pole locations by means of RTCM waypoint navigation or large scale map products 
generated by the GIS.

If you are planning to map property corners for legal or tax purposes Reliance precis
system can meet your needs with proper planning and field procedures accuracies o
1.5cm can be achieved. Refer to “Types of Reliance Surveying” on page 3 for more 
application examples.
 Field Session 13
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After determining the level of accuracy required, planning for the field work to begin 
should include these additional steps:

• Reconnaissance and observation scheduling
• Create the project file
• Create the feature and waypoint files
• Transfer the feature and waypoint files to the handheld controller.

GPS Availability

Completing pre-survey reconnaissance and scheduling data collection are impo
steps for efficient use of project resources.

GPS survey planning requires verifying satellite coverage ensure accurate resul
GPS availability is particularly important with the Reliance Precision System whi
requires 30 minutes of continual tracking of at least six satellites. If the number o
satellites drops below six, the results may be compromised.

We provided Mission Planning as a means of determining satellite availability. 
Mission Planning gives you the ability to determine visibility and dilution of 
precision (PDOP, HDOP, etc.) using information transmitted from the satellites. 
easy to use interface allows you to determine the best “time window” of availabil
for data collection anywhere on earth.

Refer to the Mission Planning manual for details.

 Figure 2.1: Mission Planning Program (main window)
Reliance Office User’s Guide
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Project Creation

Once the reconnaissance and planning has been completed, creating the project and 
downloading associated files into the handheld can begin. Chapter 4, Getting Started 
provides information necessary for:

• creating a project •  loading a project
• creating a feature file •  viewing data
• defining attributes •  filtering data
• setting up a project •  processing data
• transferring files to the handheld •  exporting data
• transferring data from a receiver

Conducting the Survey

After you have created a project, established a feature file with attributes, and 
transferred this file to the handheld controller, you can travel to the survey area a
begin data collection. We have provided a Reliance Field Operations Manual which 
describes the following:

• the accuracy levels of the three Reliance systems
• system setup
• logging feature and attribute data
• waypoint navigation
• troubleshooting

Refer to this manual when conducting field operations.
 Field Session 15
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Data Analysis

Having successfully conducted a field operation using Reliance, you are now ready to 
analyze the data. This activity consists of the following tasks:

• transferring files
• loading files into sessions
• viewing data in a Time view and/or in a Map view
• data manipulation

- filtering
- hiding/unhiding
- joining/unjoining
- processing
- exporting

Chapter 4, Getting Started describes these tasks in their basic form. Subsequent 
chapters explain each task in greater detail.

Final Thoughts

The Reliance system is a powerful tool for productivity. Reliance, like any tool, 
requires its users to invest time to learn proper operating procedures. Learning 
procedures for both office and field systems will ensure that productivity and qua
assurance are maximized.
Reliance Office User’s Guide
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A Brief Description of Reliance

Reliance is a field-to-finish Field Asset Management (FAM) tool that runs on the 
Microsoft Windows95/NT operating system. Reliance automates your FAM tasks and 
provides robust data that can be loaded into the front end of database, CAD, and GIS 
programs. Reliance combines the following functions into one asset management tool:

• FAM database management system
• Geographical data viewer
• Chronological data viewer
• GPS post-processor
• Project data filter utility
• Map System coordinate transformation
• GIS export utility

Understanding the functional components of Reliance will help you use the system 
effectively.

Features and Attributes

Reliance names categories of assets encountered in the field, called “features,” clas
observable properties of these features, called “attributes.” A feature can be any phy
object, such as the following:

• fire hydrant
• tree
• road
• lake

An attribute can be any physical property associated with a feature, such as the follo

• color
• dimension
• condition
• weight

For example, a field worker encounters a Utility Pole (a feature) that has an estimated 
height (a numeric attribute) to be entered as a number (an attribute type) and which bears a
Serial Number (a second attribute) that is alpha-numeric text (its attribute type). The field 
worker estimates the utility pole to be nine meters high, determines the serial numbe
tals 17
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“120438,” and enters both of these attribute values into the handheld controller. 
GPS receiver automatically records the position of the utility pole so the worker 
concentrate on describing the pole.

Prior the the field sessions, a project manager determines the feature names an
(point, line, and area), plus the attribute names and types (alpha, numeric, and m
in the Feature Editor. They are entered and stored in a hierarchical database cal
the Feature File. The name of each feature, and its associated attributes, are def
in the course of building a Feature File.

Reliance Work Units

There are three work units within Reliance:

• Projects
• Sessions
• Occupancies

The primary work unit is the Project. There can be several projects going at onc
each in various stages of completion, but the Reliance only one project is allowe
be active at any one time. You save projects to your hard disk using unique nam
each, and open one at a time as you need to work on it.

The secondary work unit is the Session. A session begins when a field worker tu
on the Rover receiver and ends when the field worker turns the receiver off. Ses
may overlap in time when there are several field workers taking data simultaneo
for the same project.

The tertiary work unit is the Occupancy. A field worker occupies a site when 
recording an asset’s attribute data. A session will consist of many occupancies a
there will be an occupancy associated with each asset recorded.

Waypoints

Reliance also allows the creation of geographic markers, Waypoints, prior to field 
work. A waypoint can be any location significant to field operations:

• starting point
• ending point
• route points
• observation points

The waypoint list is saved in a file called the Waypoint File. This file will be 
transferred to the handheld in order to perform waypoint navigation in the field.
Reliance Office User’s Guide
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Data Transfer Utility

Reliance performs the following types of data transfer:

• Uploading - Connect a field handheld system controller to Reliance prior
a trip to transfer the Waypoint and Feature Files into the controller. This 
provides information for the field workers so they know what to look for, 
where to look, and what to record.

• Downloading - The SCA-12 connects to Reliance after field operations t
download the gathered rover data.

• Remote Data Transfer - Reliance provides a direct link to a selected remot
communications application for transfer of data over a modem from a fie
site. This application is selected in the Directories dialog in the Project Se
Tab dialog.

Graphical Viewer/Editors

Reliance provides two methods for viewing and editing gathered data:

• Geographically
• Chronologically

The Geographical view (Map View) displays the gathered data in the form of a m
with symbols of the gathered data shown at each position. The Chronological vi
(or Time View) shows the features, their order of acquisition, and the duration of
position measurement in a bar-graph form.

The data displayed in these views comprises all the data in the project and may
contain many sessions. If a project contains several sessions (for information ab
sessions, refer to “Reliance Work Units” on page 18), Reliance displays all of the
views. Reliance also provides the ability to edit various aspects of the gathered 
Data may be viewed and edited at any time. Reliance’s Time View makes no 
distinction between unprocessed and processed data other than that the accura
estimates of the recorded positions greatly increases after processing.

Reliance provides a Project Data Filter Utility which filters the data displayed in th
views. This lets you view just point features, just features recorded on a particula
or by a particular worker, just houses and roads, all line features but only trees t
than 10 meters, etc.
tals 19
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Project Data Filter Utility

The Data Filter selectively hides or displays a project’s sessions and features from th
two graphical viewers. Data may also be filtered by session, processing status a
feature’s attribute value (refer to Chapter 9, Filtering Collected Data).

Data that is hidden by a filter setting does not appear in Map View, Time View, or exported.

The Data Filter utility, Map View, and Time View interact. The project’s filter settin
may be repeatedly modified while the Map View or Time View are open. The filte
also controls what features and/or sessions are exported from the project.

When you wish to retain a filter for future use you may save it to a file which can
loaded at any time with any project - this way the same filter may be applied to m
projects. The flexibility of the filter is its ability to filter by feature, session, or 
attribute value.

GPS Post-Processor

The GPS Post-Processor analyzes the gathered data and computes accurate po
Data correction is often necessary because the stand-alone GPS position data i
accurate to only 100 meters about 95% of the time. Reliance utilizes proprietary
algorithms to provide optimum accuracy of 10 centimeters (0.1 meters).   This is
accomplished through the use of a second receiver recording data at a known loc
during the time of field data gathering. This second receiver is known as a Reference 
Station. Reliance applies these algorithms to the GPS Reference Station data an
performs Differential Correction. Differential Correction is the process of analyzing
and comparing the autonomous base position with its known position. The differe
can be applied to any rover within about 500 km.

Alternatively, Radio Technical Commission for Maritime Services (RTCM) 
corrections may be used to eliminate the need for post-processing when accura
less than one meter is all that is required. RTCM is a method by which the Rover
is corrected at the time of collection. This is accomplished by the Rover GPS rec
obtaining correction data transmitted from a GPS base station by radio modem. 
type of data does not require additional processing as long as the accuracy 
requirement is only around one meter.

In some applications, 100 meter accuracy is sufficient for the task at hand. In thi
case, the rover data does not require differential correction (you might still want 
process it in Map View for quality control). For improved accuracy, unprocessed
stationary point positions are averaged (lines and areas are not averaged).
Reliance Office User’s Guide
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Export Utility

An Export Utility is provided so you may transfer data database, CAD, and GIS 
applications. Reliance can export  feature positions and descriptions in a variety of 
data formats that are read by software programs offered by such companies as 
Autodesk, E.S.R.I, Intergraph, MapInfo, Microsoft, and others. Virtually all GIS 
applications accept one of these formats.

Batch Processing

Reliance now has the ability to perform the following tasks automatically:

• Data Transfer
• Processing
• Exporting

Refer to Chapter 12, Batch Processing for instructions on how to perform these task
automatically.

Project Setup Utility

Project directories automatically set up when Reliance is installed. The defaults 
set up for storage and retrieval of various data files. For example:

• Rover files are stored in a ROVER subdirectory
• Base station GPS data files are stored in a BASE subdirectory

While this is the default installation of the Reliance software, organization of you
projects can be done any way you like. Reliance Project Setup allows you to put the 
various project data files anywhere you choose.

Reliance Data Files

Reliance utilizes several distinct data file types. Each plays its role in providing 
convenient Field Asset Management with highly reliable position accuracy. 

Project Files

Project files contain all project specific information such as the window positions
session definitions, and so forth. These text files (*.PRJ) are in Microsoft Windows 
tals 21
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INI file format. They may be viewed and edited manually without loss of data; 
however, it is best to maintain them in Reliance.

Filter Files

Filter files specify the features to display or hide in a project. These files are created/
modified in the Filter Data dialog box and loaded when the project is open. Any filter 
file works with any project. Reliance filters have a safeguard when a feature is not 
contained in the filter file: it is hidden during exporting (it will pass through the 
filter).

Feature Files

Features are classifications for field assets (“Utility Pole,” “Traffic Sign,” “Fence,”
“Lake,” etc.). Attributes are definitions of what is to be recorded about a feature 
(“Height,” “Condition,” “Type of Sign,” “Surface Material,” etc.). Each feature 
generally has several attributes. Attributes are assigned to the feature they are 
associated with and cannot be shared between features (a utility pole may have
condition and a fence may have a condition, but these two “Conditions” are sepa
one associated with “Utility Pole” and one associated with “Fence”).

Waypoint Files

Waypoint files contain a list of positions to which you wish to navigate to while in 
field. Waypoints are created in the Map View, saved to a file, uploaded to the 
handheld controller for use. Waypoint files may be shared across sessions, and
projects.

Rover Files

Though the Rover File appears to be a single file stored in the GPS receiver, it i
actually divided into three parts within Reliance and stored in the default Rover D
Directory:

• GPS Data
• Feature Data
• Ephemeris Data

These three files are not directly referenced by Reliance. Their names are stored
“stub” file. The person performing the upload refers to the Rover File by the sess
name assigned to it during field operations the stub file name is the same as the
session name.

GPS Data Files

The major share of GPS receiver data is stored in the GPS Data File. The GPS 
File (also called the “B-File”) is the raw GPS satellite measurement data for the 
Reliance Office User’s Guide
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period of time the receiver was switched on. The number of entries in the GPS Data 
File is determined by the length of time the GPS receiver was on and the time 
intervals at which data was recorded

Alternatively, this file may be a C-File, which contains position-only data. The C-File 
is useful because it has less data storage requirements in the GPS receiver. However, 
since this file cannot be diferentially corrected by Reliance, if you want better than 
100m accuracy these positions should be corrected in real-time using and RTCM 
differential radio link.

Feature Data File

The Feature Data File (also called the “D-File”) contains a list of all the features an
their attributes that were recorded in the field. Its contents, coupled with the GPS 
File (B-File) and the Ephemeris Data File (E-File), provide data essential to the 
proper operation of Reliance.

Ephemeris Data File

The Ephemeris Data file (also called the “E-File”) contains information on GPS 
satellites’ positions in space for the period of time the rover receiver is switched 
and is automatically collected by the receiver. GPS is fundamentally a system of
measurements, By multiplying the speed of radio waves by the amount of time 
between transmission  by the satellites as receptacle the receiver, you can calcu
the distance between the satellites and the receiver. You need the ephemeris da
information on the satellite positions in space to determine the receiver’s positio
earth. 

Reference Station Files

Like rover data, base station data also consists of a GPS data file (B-File), and a
ephemeris data file (E-File) to which is added the reference station data file. 
Reference station data files must be collected from a stationary GPS receiver at
known location. During GPS post-processing, Reliance uses the Rover’s GPS a
ephemeris data together with the reference station’s GPS and ephemeris data to
correct the positions of features. The site identification name for the base must n
changed during a session.

Almanac Files

The Almanac file is broadcast by GPS satellites to the receiver and then downlo
to the Mission Planning program (Mission Planning uses almanac data) to calcu
the positions of GPS satellites and their health. Using the Mission Planning prog
you can plan the best time to log features that have limited satellite visibility, suc
features between buildings. The almanac data changes from time to time as sat
become unhealthy, as satellites are moved to new orbits, or when new satellites
tals 23
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launched and put into service. Mission Planning displays a warning message if the 
almanac file is more than 60 days old. If this occurs, download a new almanac file 
from the receiver to the Reliance/MP directory.

Change Files

A Change file creates automatically when a session loads. The Change file contains 
feature, attribute, and position information from the rover files which allows Reliance 
to quickly load, display, filter, and export the collected data. If the session is 
processed, the feature positions in the Change file are updated with the differentially 
corrected positions. There is only one Change file per session.

More on Features and Attributes

Features

Each feature in the Feature file is defined by two database fields: 

• Name
• Type

- Point
- Line
- Area

You choose from among these three feature types each time you define a new fe
Features cannot be changed in the handheld controller. They are defined in Rel
operations and uploaded to the handheld system controller prior to field work. Fi
operations may add points, lines, and areas from a “generic” list of standard entit
case they which to map a feature not defined in the Feature file. For example, the
worker may decide it is important to map in a road that is not on his map. If he 
believes that all roads were already mapped, there may not be a “road” feature i
Feature file. By selecting, “Generic Line”, the field worker can give it an attribute
name such as “unpaved road, or single lane road.”

Attributes

Each attribute is defined by two database fields: Type and Name. An attribute ty
may be one of the following:

• Alpha-text entered by field worker into handheld
• Numeric-numbers entered by field worker into handheld
• Menu-a special attribute that produces a selection menu, or “pick-list” in 

handheld.
Reliance Office User’s Guide
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The types and names for attributes cannot be changed in the handheld controller. 
They are defined in the Feature Editor module within Reliance and uploaded to the 
handheld prior to field work. Values specified as attributes may be entered into the 
handheld controller in the field. In fact, the objective of field work is to enter the 
values specified as an attribute whenever a field worker encounters an asset.

Every failure file contains three default features: 

• Generic Point
• Generic Line
• Generic Area

They cannot be changed or deleted and should be used to record unanticipated o
in the field. Each of these three default features has two default attributes: a text
attribute named “Description” and a numeric attribute named “Value.” These def
attributes cannot be changed, added to, or deleted. Any new features created do
have default attributes preassigned to them and are fully editable.

Reliance provides the flexibility to add new features and attributes and to delete
existing features and attributes from the Feature File at any time in the office. Yo
can also edit feature name, attribute names, the size of text attributes, the range
measurement units of numeric attributes, the structure of menu attributes, and e
the data type of attributes.

The design of the Feature File database is entirely up to you, but as can be infer
from the preceding paragraph, poorly structured, vague, or restrictive feature an
attribute definitions can be very hard to work with. To obtain the greatest flexibili
features should not be overly specific. For example, rather than defining four fea

• Barbed Wire On Wood Fence
• Barbed Wire On Steel Fence
• Split Rail Fence
• Wood Lath On Steel Fence

You might consider naming the feature “Fence” and assigning to it an attribute na
“Composition.” Composition could then have four menu items:

• Barbed Wire On Wood
• Barbed Wire On Steel
• Split Rail
• Wood Lath On Steel

The field worker would choose from these menu items. The objective is to minim
the size of selection lists by adding hierarchical menu choices so that data entry
simplified. On the other hand, it would not be reasonable to expect a whale surv
crew to have to select “Whale” from a menu each time one is encountered when
is the only type of animal they are collecting data on. Feature File design is an 
ongoing enterprise and Reliance has the tools you need to make the job as pain
possible, provided an upfront logical design is incorporated. 
tals 25
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When designing Feature Files, there are few points to keep in mind:

1. Comprehensiveness (do these features and attributes adequately describe the 
assets?)

2. Ease of use (can feature lists be condensed or be presented more compactly 
as menus?)

3. Lifetime (is this a set of features for a single project or could it evolve into a 
standard to be used for a long time to come?)

You may wish to make backups of old Feature Files for use as templates in the future 
and document their structures and objectives for ready reference.
Reliance Office User’s Guide
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This chapter explains how to use the Reliance Processor’s basic features with step-by-st
procedures. These procedures use the example files shipped with Reliance so you 
required to gather any data. For information concerning transfer of data into the Reli
refer to Chapter 6, Data Collection.

Starting Reliance

Start the Reliance by double clicking the Reliance icon in the Program Manager. Wh
Reliance begins, it occupies the entire screen and contains the following:

• The Reliance Title
• A system menu bar across the top
• A Minimize/Maximize button pair at the upper right

The Reliance defaults to a maximized window and clicking on the minimize button 
restores Reliance to its normal state: a small window across the top of the screen. W
this is done, applications behind Reliance are accessible (you do not need to switch
between applications to access them). This is referred to as an unbounded interface. 
Reliance windows appear as separate applications running side by side; however, th
actually all part of the same application. This interface yields organizational benefits
provides simple access to other applications while Reliance is running. For example
might run your Windows GIS program alongside Reliance so you can verify your 
exported results. Choose the display with which you feel most comfortable. The Reli
automatically saves your choice for future projects.

 Figure 4.1: Reliance Main Window
rted 27
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Creating a Project

1. With Reliance running, select New from the Project menu. The choices on 
this menu deal with project creation and maintenance.

2. The Create a New Reliance Project dialog opens (Figure 4.2).

3. Enter the name of new project into the File Name: field. For this example, 
enter MAINST.PRJ (Main Street) as a sample project.

The selected directory is the project’s directory installed by the Reliance installer and the file type 

defaults to the Reliance Project (*.PRJ) file type. You do not need to enter the “.PRJ” extension.

4. Click OK. 

 Figure 4.2: Create a New Reliance Project dialog
Reliance Office User’s Guide
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5. Reliance creates the project file and displays the Project Control tool box 
(Figure 4.3), and lists the project file name in the Reliance title bar.

Creating a Feature File

Before gathering data, you must know what kinds of features you are intending to 
record. You must define the feature attributes (the information about a feature you 
wish to obtain) in a Feature File and subsequently transfer that file to the handheld 
controller before entering the field.

In the Main Street project, you will record information about the objects along the 
sidewalk of a fictional Main Street. You need to create several features to accomplish 
this. The kinds of features you might find along a typical downtown sidewalk are 
trees, light poles, power poles, newspaper dispensers, various parking zones, sewer 
drains, fire hydrants, bus stops, and public parking areas. Others might include the 
businesses along the sidewalk, driveways, and so forth. You need to know what 
features you want to gather before going into the field. In this example we create 
three features:

• Light poles
• Parking zones
• Public parking lots

These features were chosen because they illustrate the three types of features:

• Points-light poles
• Lines-the sidewalk itself and the parking zones alongside
• Areas-the public parking lots

Feature File creating and editing are accomplished in the Feature Editor. In this 
example begin by creating the feature file MAINST.FDF.

 Figure 4.3: Project Control Tool Box
rted 29
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1. Click the Feature Editor button in the Project Control tool box to open the 
Feature Editor (Figure 4.4).

2. In the Features listbox there are three “Generic” features. Use these fea
to enter data about unanticipated objects during the field trip.

The title bar indicates the file UNTITLED.FDF is open or a new feature file 
has been created in memory but not yet saved to the disk. There are two
group boxes titled “Features” and “Attributes”. Features are created and
edited in the “Features” group and their attributes are created and edited
the “Attributes” group. 

3. To create the first feature, click New... in the Features group to open the 
Feature dialog (Figure 4.5).

 Figure 4.4: Feature Editor

 Figure 4.5: Feature dialog
Reliance Office User’s Guide
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4. Enter the name of the first feature, light pole, in the Name field. Use the 
option buttons to indicate a type of feature. A light pole feature is a point 
feature because it occupies a single point. 

5. Click OK to close the dialog and return to the Feature Editor.

This screen shows a new feature added to the features list box with no 
attributes, because attribute definitions have not been assigned. 

6. Highlight light pole and click New... in the Attributes group to open the New 
Attribute dialog (Figure 4.6).

The New Attribute dialog takes one of three forms depending upon the 
setting of the Type option buttons as shown by the illustrations above. They 
all have an attribute name field and the three option buttons.

• Alpha option button - this attribute accepts alpha-numeric text. The amo
of alpha-numeric characters that may be entered in the field is specified
the “character field length” edit field (up to 40 characters are allowed).

• Numeric option button - this attribute accepts numeric values between th
Minimum and Maximum ranges specified and defaults to the value 
specified in the Default Value field. Numeric data display precision is 
controlled by the number of decimals set in the Digits After Decimal Poin

 Figure 4.6: Attribute-Alpha dialog
rted 31
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field and is in the unit of measure selected in the “Measurement Unit” 
combo box.

• Menu option button (Figure 4.8) - this attribute provides the list of choice
specified in the Menu Items list. Menu items may also have a submenu 
which is specified by highlighting the menu item to contain the submenu 
clicking the Submenu button. The default menu or submenu item can be 
selected by highlighting the item and clicking Set Default.

 Figure 4.7: Attribute-Numeric dialog

 Figure 4.8: Attribute-Menu dialog
Reliance Office User’s Guide
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A Point Feature

In this example, we want to record the light pole’s condition, its illumination type a
an estimated height. This means we need to add three new attributes to the Ligh
feature.

Creating Line or Area feature is accomplished in the same manner as a Point feature. 

Alpha Attributes

The light pole’s condition is going to be a subjective evaluation of the overall 
condition of the light pole so it should be of type Alpha.

1. Specify the attribute name by typing Condition in the Attribute 
Name field. 

2. Click Alpha to select the attribute. 

3. Specify the maximum amount of text for the Condition attribute. Enter 40 in 
the Character Field Length edit field.

4. Click OK, to add the attribute to the Light Pole feature and to return to th
Feature Editor.

Numeric Attributes

Now create a numeric attribute for the “light pole” feature called “Height”.

1. Click New... in the Attribute area.

2. Enter Height in the Attribute Name field and click on the Numeric radio 
button.

3. Enter a Minimum value of 0 and a Maximum value of 50. The Maximum 
value is the largest valid value expected for the height of a light pole.

4. Enter 30 in the Default Value field (assume that most of the light poles ar
about 30 feet high). 

5. Enter 1 in the Digits After Decimal Place field (it is probable that the field 
worker’s estimation accuracy is no better than 1/10 foot).

6. Select US Survey Foot in the Measurement Units drop down list box. 

7. Click OK to add this attribute to the Light Pole feature and to return to th
Feature Editor.

Menu Attributes

Now create another attribute for the Light Pole feature to indicate the type of 
illumination used in the light pole.

1. Click New... in the Attribute area.    
rted 33
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2. Enter Illumination Type in the Attribute Name field, and click 
Menu.

3. In the Menu Items field, type Mercury Vapor and press <Enter> (or 
click Add).

4. Add the menu items Filament and Fluorescent to the Menu Items 
list.

5. When complete, click on the Mercury Vapor item in the “Menu Items” list 
and click Set Default.

This action identifies “Mercury Vapor” as the default value for this menu
attribute.

6. Click OK to return to the Feature Editor.

Feature Symbol Selection

To select a symbol for the Light Pole feature:

1. In the Symbol area, click Edit to display the Feature Symbol dialog (Figu
4.9).

2. Select a symbol to represent the Light Pole feature by scrolling the list b
and clicking on the symbol.

You can add more point feature icons to the ones displayed in Figure 4.9.  Simply put the *.ICO files 
you have in the RELIANCE\BIN\ICONS directory.

3. Click OK to return to the Feature Editor dialog.

 Figure 4.9: Feature Symbol dialog
Reliance Office User’s Guide
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Symbols for line features include different line types and colors. Symbols for area features include 
different fill patterns and colors.

The Light Pole feature is fully defined. It has three attributes:

• Condition an alpha-numeric field
• Height a numeric field)
• Illumination Type (a menu) 
• light pole symbol for map display.

You can use any number and combination of attributes and attribute types, to define a feature.

Completing the Process

1. Try creating the following three features by repeating the steps outlined
previously:

• Sidewalk: a line feature
• Parking Zone: a line feature
• Parking Lot: an area feature

Think about the types of information (attributes) you want to obtain for the
features in the field and add them as attributes.

2. When you have completed setting up the remaining features, save the fe
file by clicking Save and entering the name of this new feature file.

3. Click OK to save the file and return to the Feature Editor.

Copying Features and Attributes

Existing features, along with all their attributes, can be copied to a new feature b
performing the following steps:

1. In the Features listbox of the Feature Editor dialog, highlight the feature 
wish to copy and press <CTRL-C>.

2. Press <CTRL-V> to create a new feature. You will be prompted to enter
new feature name, since duplicate names are not allowed.

You can also copy attributes from one feature to another by performing the follow
steps:

1. In the Attributes listbox of the Feature Editor dialog, highlight the attribu
from the feature you wish to copy and press <CTRL-C>.

2. Highlight the feature in the Features listbox you wish to add the attribute

3. Highlight an attribute in the Attributes listbox, for the feature you wish to
add the attribute to and press <CTRL-V>.
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You can also delete features and attributes by highlighting them and pressing <CTRL-X>.

Sorting Features and Attributes

In order to organize the features and attributes lists you have created, several types of 
sorting are available in the Feature Editor dialog. 

You can always revert back to your original unsorted lists of features and attributes by choosing 
“<Unsorted>”.

Setting up the Project

After creating a feature file, a session must be created in the project. A session is the 
field data recorded from the time the receiver is turned on to when the receiver is 
turned off. In this example, we expect to only have one session.

Begin setting up the project as follows:

 Table 4.1: Feature and Attribute Sorting

Method Description

By Name Ascending or Descending - alphabetically.

By Type Ascending or Descending:
1. Features: point, line, area
2. Attributes: alpha, numeric, menu                                         
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1. Click the Project Setup icon button in the Project Control tool box to open 
the Project Setup (Figure 4.10).

Session 1 is automatically created. This is done automatically when a new 
project is created.

2. Rename Session 1 Main Street by clicking in the Selected field and typing 
the new name.

3. Select Rover and Base Files after field operations are complete and the data 
has been downloaded to the PC.

4. Click on the Map System tab to choose the desired map system.

5. Click back on the session settings tab and enter the position of the base 
station.

6. Click OK and the project data will load.

 Figure 4.10: Set up the open project window
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Transferring Waypoint and Feature Files to 
the Handheld Computer

For the Main Street project we will transfer the feature file created to the handheld 
computer for use in our field data collection.

1. Connect the handheld controller to the PC using the supplied cable.

2. Click on the Transfer Data icon button in the Project Control tool box to 
open the Transfer Data dialog.

3. Click on the Transfer information between the PC and the handheld 
device button.

4. Click OK a dialog opens asking if the handheld is connected and HCOM is 
running (Figure 4.12).

The lowest COM port that is inactive is utilized by Reliance the first time that a transfer is initiated. 
Once the user sets the COM port, the setting is saved and is used for each subsequent transfer 
operation. Verify HCOM is running on the handheld, and click OK.

If HCOM is not running, type HCOM at the handheld controller Dos prompt.

 Figure 4.11: Transfer Data dialog

 Figure 4.12: HCOM dialog
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5. The Transfer Data Between PC and Handheld window (Figure 4.13) opens.

6. Click the boxes in the Show pane for the types of files to display in the PC 
and Handheld.

7. Highlight the file to transfer (either from the PC or Handheld listboxes).

8. Click the directional arrow indicating the direction of transfer. Reliance 
transfers the selected files to or from the handheld.

9. Click Close to close the Handheld Transfer dialog.

Transferring Collected Data from a Receiver

Since the example does not involve actual data gathering and the receiver does not 
contain any GPS data to transfer, this operation will not be detailed here. For 
information concerning transfer of collected data from a receiver, refer to Chapter 7, 
Transferring Field Data. 

Assume the data has been transferred from the GPS receiver to the Reliance and are 
ready to proceed to the next step, Loading a Sample Project.

Loading a Sample Project

A sample project has been included on the Reliance software installation disks. To 
open EXAMPLE.PRJ, perform the following steps:

 Figure 4.13: Handheld Transfer dialog
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1. Select open from the Project menu.

2. The Open File dialog opens (Figure 4.14).

3. Select the project called EXAMPLE.PRJ.

4. Click OK.

The open Reliance Project dialog closes as the selected file.

Viewing Collected Data in Map View

Once EXAMPLE.PRJ is loaded, we can view the unprocessed data.

To examine the topographical data view,  “Map View”:

1. Select Tools from the Reliance Main Menu and click on the “Map View” 
menu item (you may also open Map View by selecting View Data from 
Project Control).

 Figure 4.14: Open a Reliance Project dialog

 Figure 4.15: Map View Selection
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The Map View window (Figure 4.16) opens and displays the collected data.

Map View may initially display positions that are not accurate because the GPS positions have not 
been updated by processing (also called Differential Correction).

Figure 4.16 displays the features recorded on the example field trip. They are 
identified by the symbols specified in the Feature Editor where the feature 
file was created. Features are displayed as follows:

2. Uncheck Symbol in the View pull down menu. The tree feature symbol is 
now a gray dot: Position Identifier. It identifies the position of the point 
feature. 

3. Click once on the position identifier for the tree feature.

A red circle appears surrounding the position identifier indicating the feature 
is selected.

4. Double click on the position identifier. The Feature Information dialog 
(Figure 4.17) opens.

 Figure 4.16: Map View Window
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The Feature Information dialog displays 

• session name
• name and type of the feature.
• point-displays position and accuracy
• line-displays length
• area-displays the perimeter and area

The accuracy of a point is unavailable until the data has been processed.

5. Click Attributes to open the Feature Attributes dialog (Figure 4.18). This
dialog is not available for base data files.

The Feature Attributes dialog indicates the attributes of the feature reco
in the field. For example, a “tree” feature shows values entered for the 
following attribute names:

 Figure 4.17: Feature Information dialog

 Figure 4.18: Feature Attributes dialog
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• Type
• Diameter
• Height
• Health

You can edit the attribute information in the Feature Attributes dialog. Highlight the value you wish 
to change, modify it, press the Return key, then press the OK button.

6. Click OK to return to the Feature Information dialog.

7. Click on OK or Cancel in the Feature Information dialog  to return to the 
Map View Window.

Filtering Data

1. In the Map View window, select Filter from the View menu. The Project 
Data Filter dialog opens (Figure 4.19). Filter can also be selected from t
View menu in Time View or Project Control.

Table 4.2 describes the components of the Project Data Filter dialog:

 Figure 4.19: Project Data Filter dialog
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If a session is in the Show list, all the features not in the Hide list are displayed in the Map View.   If a 
session is in the Hide list, all its features will not be displayed in the Map View. 

2. To hide everything but the tree feature.

a. Move each feature to the Hide list box by double clicking on the item 
(or moving them all at once). 

b. Make sure Session 1 and “Tree” is still in the Show list box.

3. Click OK to accept the parameters and return to the Map View.

Viewing Collected Data Chronologically

Another way to view collected data is chronologically. In the Time View, feature 
occupations (the period of time for which a feature was logged) are shown in a b
graph display with the horizontal axis representing elapsed time increasing to th
right, and the vertical axis showing the receiver which recorded the GPS data. 

 Table 4.2: Project Data Filter dialog

Name Function

Session/Features to Show Select item(s) to show when data is filtered.

Session/Feature to Hide Select item(s) to hide when data is filtered.

• > or <

• >> or <<

• Moves the highlighted item in one list 
to the other list. Double clicking an 
item will also move it.

• Moves all the items in the one list to the 
other list.
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1. Select Time View from the Tools menu (Figure 4.20) (you can also open 
Time View by selecting View Data from Project Control).

The Time View window opens (Figure 4.21 Overview Mode, Figure 4.22 
Receiver Mode).

In the Time View window, the collected features collected are represented 
by the time and duration of occupation as a bar for each feature.

You do not need to close the Map View window to display to Time View window. The two windows 
may be open at the same time.

 Figure 4.20: Time View Selection

 Figure 4.21: Time View Window-Overview Mode
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2. Click on one of the bars and the color-coded features appear.

The colored bands represent the actual time of occupation at the feature. 
Table 4.3 contains the meaning of the color bands.

Overlapping bands indicate nested features. Sections of the bar that do not have any colored bands 
are Trajectory data, indicating that GPS data have been collected for that period of time, but no 
features were recorded. Trajectory data are not displayed in Map View or exported.

To the left of the bar is a button with the name of the receiver. By default, the 
name of a receiver is its serial number but it can be assigned a familiar name 
such as “Field Worker 1”. 

3. Select Receiver info from View Menu to open the Receiver Information 
dialog (Figure 4.23) 

 Table 4.3: Color Meanings

Color Meaning

Green Point Features

Red Line Features

Yellow Area Features

Blue Base Station

 Figure 4.22: Time View Window-Receiver Mode
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You can bring up receiver info this way, but it brings up a different dialog than is shown in Figure 
4.23.

The receiver information dialog displays information about the receiver used 
to collect the data.

4. Click OK to return to the Time View window.

5. Double click on one of the time bands Feature Information dialog (Figure 
4.24).

The Feature Information dialog the information about the feature on which 
you double clicked is displayed. The fields adjacent to the “Start Date an
Time” and “End Date and Time” labels indicate the actual occupancy 
information for that feature.

 Figure 4.23: Receiver Information dialog

 Figure 4.24: Feature Information dialog
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6. Click Offset to display the Offsets dialog for the Tree feature.

This dialog displays the offset information about the feature (if an offset was 
entered in the field). Offsets are used when a feature is in an inaccessible 
place. The distance to the feature can be determined in the same manner. For 
example, suppose we are recording sewer caps along our fictional street 
Main Street. If the sewer cap is located in the middle of a busy street, we 
could use offsets to record the feature safely from the sidewalk.

Offsets are also available for line and area features, but it is restricted to one offset per feature, and 
they are not editable.

7. Click OK to return to the Feature Information dialog.

8. Click OK to return to the Time View window.

9. Select Filter from the View menu to display the Project Data Filter dialog.

10. Highlight the “Tree” and click  to hide the tree.

11. Click OK to return to the Time View window.

The point feature (green band) has disappeared. This is because the Tr
feature is the only point feature in the data set and it has been hidden b
filter. The filter automatically updates the Time View and Map View 
windows. 

 Figure 4.25: Offsets dialog

>
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Processing Collected Data

To this point, we have been examining unprocessed data. That is, the position of the 
features we collected are accurate within 100 meters. By processing collected data 
with the base station data as a reference, Reliance can obtain an optimum accuracy of 
about 0.1 meters.

To process collected data: 

1. Click the Process Data button in the Project Control toolbox to open the 
Process Selection dialog (Figure 4.26).

Two list boxes are provided in order to choose which session to process. The 
buttons between the two lists move the sessions back and forth, depending 
on which ones you want to process.

2. Choose Submeter, Decimeter, or CM Processor by clicking the 
corresponding radio button.

3. Click the 2-Sigma accuracy filter radio button if necessary.

The 2-Sigma filter automatically calculates the standard deviation of a 
collection of positions that were recorded at a single point feature. They are 
automatically averaged. This filter deletes any of the positions that are more 
than two standard deviations away from the average position. The average 
position is then recalculated.

4. Click Begin to start processing data for the selected sessions.

 Figure 4.26: Process Selection dialog
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The Processing Data dialog opens indicating the progress of the data 
processing.

After processing, the sessions processed are indicated with an asterisk (*).

5. Click on CLOSE and again open the Map View. The feature positions in 
Map View are updated (Figure 4.28).

Approximate accuracies of the corrected point features are listed in the Feature Information dialog 
in Map View.

 Figure 4.27: Processing Data dialog

 Figure 4.28: Map View With Processed Data
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Exporting Collected Data to a GIS

Reliance exports and processed collected feature and attribute data to database, CAD, 
and GIS software applications, from such manufacturers as Autodesk, E.S.R.I., 
Intergraph, MapInfo, and Microsoft. Reliance provides this with its Export Data 
feature. To export collected data, perform the following steps:

1. Set the Project Data Filter to show only the features you want to export (refer 
to “Filtering Data” on page 43).

2. Click the Export Data button in the Project Control toolbox to open the 
Export Data dialog (Figure 4.29).

This screen is the same as the File Open dialog used to open the project with one important 
difference. The selection in the “Save File As Type” combo box determines the file format to which 
Reliance exports the data. The choice of file format depends upon the target application. For 
Autocad, choose from two file types (Binary and ASCII). For ArcView, choose “Shape.” For 
Intergraph, choose “Intergraph.” For Arc Info, select “Generate.” For Map Info, choose Map Info.

3. Select a format in the “Export Format” drop down list box and enter a file
name in the File Name edit field (select a different drive and directory if 
necessary).

[

 Figure 4.29: Export Data dialog
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4. Click Options to open the Export Data Types dialog (Figure 4.30).

5. Select the data type(s) to export and click OK.

6. Click OK in the Export Data dialog to accept the parameters and begin 
exporting the data to a file of the selected format.

7. When the progress dialog reached 100%, you have successfully exported the 
data.

8. Start the target application and use the data you have exported from 
Reliance.

 Figure 4.30: Export Data Types dialog
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This chapter explains how to setup a Reliance Processor project in preparation for field 
operations. These procedures are more detailed than those in Chapter 4, Getting Started.

Creating a New Project File

To create a new Reliance Processor Project:

Existing project may be opened by selecting Open... from the Project menu.

1. Select New... to create a new project.

2. Select a drive and a directory for the project files and enter in a name for the 
project file in the File Name field.

Project files have a “.PRJ” extension.

3. Click OK to accept the parameters and create the Project File.

 Figure 5.1: Create A New Reliance Processor Project dialog
 a Project 53
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Project Control Toolbox

The Project Control Toolbox (Figure 5.2) lists all main software functions as buttons. 
While the Project Control toolbox opens each time you open a project, you may close 
the toolbox by clicking on the close box. The project remains open.

 Table 5.1 describes the software functions of the Project Control Toolbox.

 Figure 5.2: Project Control

 Table 5.1: Project Control Toolbox Functions

Function Description

Project Setup Brings up a tab dialog that allows you to: 
• Set up Sessions of Rover and Base Files
• Set up the Map System and units
• Set up the Default Directories and other miscellaneous items

Feature Editor Allows you to set up the features and their attributes into a Feature File.

Transfer Data Allows you to transfer data to and from Reliance to the Handheld and transfer dat
from the GPS receiver.

Filter Data Allows you to filter collected data by Session, Feature Name, and/or Attribute Valu

View Data Brings up two windows that allow you to see the collected features in a Time View a
a Map View.

Process Data Allows you to process the collected data in sub-meter, decimeter, or CM process
modes.

Export Data Allows you to export the collected features to several popular GIS file formats.
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Project Setup

Click the Project Setup icon button on Project Control to open the “Project Setup”
dialog.

The following procedure creates a new project.

Sessions

1. When the Project Setup dialog opens, the tab with Session Settings is 
displayed.

An initial session titled “Session 1” appears in the “Defined Settings” list
box and also in the “Name:” edit box. Additional sessions are created by
clicking New (this adds a new entry into the “Sessions” list box titled 
“UnNamed001”).

2. Give the initial session a distinctive name by replacing “Session 1” in the
“Name:” edit box.

 Figure 5.3: Project Setup dialog / Session Settings tab
 a Project 55
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Selected Sessions Definition

3. If you wish to download a rover file from your receiver, click on the 
Download Rover Data check box.

Before downloading rover files, make sure correct com ports are selected in “Settings” under the 
“Tool” dropdown menu.

This will inactivate the file name text box and a Receiver File Selection tab 
will appear.

If you download a rover file from your receiver, perform the following steps 
(otherwise continue with Step 4).

a. Click on the Receiver File Selection tab.

b. You can select files using four different methods:

 Figure 5.4: Project Setup dialog / Receiver File Selection tab

 Table 5.2: Receiver File Selection Methods

Method Description

All Files All rover files would be downloaded

Date/Time Last 12 hours Last 24 hours Specify Time Frame
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When you specify the Start and Stop times to download data, the files in the receiver that begin at a 
time between these two times will be downloaded.

c. Once you have selected the appropriate File Selection parameters, 
continue with the next step.

4. If you wish to select a rover file which already has been downloaded to a 
local drive, browse and select the appropriate file.

The Rover File will be in the format of “aaaaaaaa.Sxx”.

• aaaaaaaa is the session name you entered in the handheld 
computer

• xx is a number between “00” and “99”

5. If you want Reliance to Auto Search a Base file, click on the Auto Searc
Base check box.

Reliance searches for a Base File automatically by looking in all director
specified in the Base File Path section of the Directories dialog.

This will inactivate the file name text box.

6. If you wish to select a Base file which already exists on a local drive, bro
and select the appropriate file.

The Base file will be in the format of “Bssssayy.ddd”.

• ssss is the four character site name of the base station
• a is a letter
• yy is the year
• ddd is the day of the year

7. If you wish to select a Waypoint file which already exists on a local drive
browse and select the appropriate file. If you are creating a new Waypo
file, type in an appropriate name here.

Base Station Position

8. If you know the coordinates of the base station, specify these coordinate
the base station for which the Base File data was collected in the Map 
System being used (the default is WGS-84).

You can enter these coordinates as degrees/minutes/seconds, degrees
minutes, or degrees by selecting the proper menu button on the display.

Name Rover files with specified name would be downloaded

Date/Time & Name Rover files with specified name and within time frame would be downloaded

 Table 5.2: Receiver File Selection Methods

Method Description
 a Project 57
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This is only available for Geographic display systems.

These coordinates will be used along with the data in the Base File by the 
Differential Correction processing technique to provide accurate positions 
for the features in the Rover File.

9. If you do not know the coordinates of the base station, check the Use 
Averaged Base Position checkbox. The Base Station Position fields will be 
inactive.

You should always attempt to use the exact base station coordinates. If you must use the averaged 
base position, the processing precision will not be guaranteed.

10. If you are auto-searching the CORS sites for Base files, you should check the 
Use Average Base Position checkbox. Reliance will automatically fill in the 
known position of the CORS site that is selected.
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Map System

To select a map system and its parameters, click the Map System tab of the Project 
Setup dialog.

Reliance defaults to a Map System of WGS84. If you need to change the system before entering the 
base position, click on the Map System tab. 

11. Pick a map system appropriate to your project in the “System” dropdown
box.

If you wish to create a new map system or to edit an existing map syste
refer to Chapter 13, Setting Up a Map System.

12. Select a Datum or Zone from the dropdown list or choose “< Create New
to define a new zone. The zones for predefined map systems are not edi
but the names of predefined systems can be changed.

13. Choose a display coordinate system, either Geographic, Standard, or L
Grid. 

 Figure 5.5: Project Setup dialog / Map System tab
 a Project 59
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14. Choose the Height Datum either Height Above Ellipsoid (HAE) or Mean 
Sea Level (MSL).

By choosing MSL, the GEOID 96 model will automatically be used for data in North America. 
Otherwise, the OSU91, model will used. Also when choosing MSL, the height accuracies are labelled 
“N/A” after processing due to the limited knowledge of how accurate these model are.

15. The units that you want your position data to be displayed and exported in 
may be selected here as well. Choose from several different units including 
the following:

• feet (both US Survey and International)
• meters
• degrees
• radians

If you had to display a different Map System on the Map System tab, changing the Map System on 
this dialog will automatically change the Base Position Parameters on the Session Settings tab. 
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Directories

16. Click on the Directories tab of the Project Setup dialog.

Project Default Directories

The Directories tab defines the directories in which Reliance Processor 
stores and retrieves the project’s data files. Reliance Processor uses the
directories in the Project Session Setup to file the various data file comb
boxes and to find the files during project load. Transfer Data uses them 
determine where to find files to upload and where to put files for downlo
The Feature Editor uses these directories to determine where to find fea
files.

17. To enter a default directory, you can manually enter the disk drive and p
of each by directly typing the path into the edit field below its title or you c
click on Browse (the button with the picture of the open folder) adjacent t
its edit field to open the Directory Browser dialog.

18. In the Directory Browser dialog you can select the desired directory and
click OK to return to the Default Directory Setup dialog.

 Figure 5.6: Project Setup dialog / Directories tab
 a Project 61
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Upon returning, the edit field adjacent to the browse button contains the 
selected directory or the original directory if Cancel was used to exit the 
Directory Browser dialog. Paths to the following files may can be changed:

• The Default Rover Files Directory defines the directory which contai
the Rover data.

• The Default Base File Path defines the list of directories (separated 
commas) containing the base station files to use when processing th
Rover data.

• The Default Feature File Directory defines the directory for the Feat
Definition Files and their associated icon files.

• The Default Waypoint File Directory defines the directory for the 
Waypoint files created in the project or to be used by the project.

• The Default Change File Directory defines the directory for the Chan
files created by Reliance Processor when a position is edited or a se
processed.

19. If you selected to download rover files from your receiver, the “Receiver
File Dir” indicates where the files will be saved on your local drive.

20. If you select Auto Search Base in the Session Setting tab, Reliance will
search all directories listed in the Default Base File Path for a base file t
completely covers the rover file time span.

21. In order to access the Internet CORS sites, you must add its FTP addre
the Base File Path by typing in “,FTP://CORS”. Files downloaded from the 
CORS sites will be saved in the first directory specified in the Base File 
Path.

For Rover files that are greater than 30 days old, the CORS FTP site will not be searched for Base 
files. (Base files that are greater than 30 days are archived and are still available by request to 
CORS.)

If you have selected a specific rover and base file in the Session Settings dialog, the directories 
displayed in the Directories dialog have no relevance.

CAUTION

If you are accessing data from the Internet, make sure your Internet connection settings 
are correct under Settings in the Tools menu. See Chapter 14, Tools for details.
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Miscellaneous

22. If you wish to select a filter file which already exists on a local drive, browse 
and select the appropriate file or type in the name and directory path in the 
Filter File Used textbox.

23. If you wish to select a a remote communications application, browse and 
select the appropriate file or type in the name and directory path in the 
Receiver Communications Application textbox.

24. Select the appropriate time zone for use with the open project, Local or 
UTC.

25. If you click on the Enable Activity and Error Tracking checkbox, Reliance 
will track each button or control accessed. This history is stored in 
ACTIVITY.LOG in the...\Reliance\bin directory. This is useful if technical support 
is required to resolve a problem.

Loading a Project

26. Click OK on the Project Setup dialog once everything is set up the way you 
want it.

A progress dialog will appear while the project is being loaded. 

o

 Figure 5.7: Project Load Progress dialog
 a Project 63
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27. If you are getting data from the Internet, an additional progress dialog is 
when while loading the project.    

Moving a Project

From the Project pull-down menu, you can choose Move to move an existing project.

In order to use the Move function, you must close all projects.

 Figure 5.8: Internet Download Progress dialog

 Figure 5.9: Move Project Menu Selection
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Once you have selected Move, the Move a Reliance Project dialog is displayed.

When moving a selected project, you need to specify which directory you wish to 
move it to in the Destination field of this dialog. The directory will become the root 
(or archive) directory where the project file is saved. Move Project will perform the 
following functions:

1. Create base, rover, feature, waypoint, and change subdirectories under the 
specified root directory.

2. Move the Base, Rover and Change files into the base, rover and change 
subdirectories.

3. Copy the Feature and Waypoint files into the feature and waypoint 
subdirectories.

4. Copy the Filter file into the specified root directory.

5. Move the Project file into the specified root directory.

6. Modify the Project file to reflect the new directory structure of the files.

After a project has been moved, you can more easily archive it using 
applications such as WinZip™.

 Figure 5.10: Move a Reliance Project dialog
 a Project 65
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Deleting a Project

From the Project pull-down menu, you can choose Delete to delete an existing 
project.

In order to use the Delete function, you must close all projects. 

Once you have selected Delete, the Delete a Reliance Project dialog is displayed.

 Figure 5.11: Delete Project Menu Selection

 Figure 5.12: Delete a Reliance Project dialog
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When deleting a selected project, all files associated with that project are deleted 
except feature and waypoint files.

Deleting a project that contains a given dataset will also delete that particular data 
from any other project it appears in. If a deleted dataset (including base data) is used 
in any other project, it will be lost. One way to prevent this is to create discrete 
directories for each project. Keeping all base data and rover data in the default 
directories could compromise data integrity when project deletion is used.

The files that are deleted are put in the Windows Recycle Bin. This way, if a mistake is made, you can 
recover the files that were deleted.

“Save As” Defaults

You can save several project settings as defaults for when new projects are created by 
clicking on Save As Default in the project pull-down menu.

WARNING

This deletion also includes the raw GPS data file you collected in the field 
specified in that project.

 Figure 5.13: Save As Default Menu Selection
 a Project 67
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Default settings include the following:

• All window positions and sizes
• Default directories
• Map System setup

Session setup is not saved as part of the project default setup.
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Before performing field data collections with a Reliance system, you must first set up a 
Feature File with a list of all the features and their appropriate attributes you may need to 
log in the field. Features can be one of three types: points, lines, or areas. Attributes can be 
character fields, number ranges, menus, and submenus. The Feature File is created using 
the Feature Editor. For details refer to “Creating a Feature File” on page 29 in Chapt
Getting Started.

Along with the Feature File, you can also create a Waypoint File to be used in the fie
waypoint navigation. The Waypoint File is optional; it is not necessary to create this fi
order to do your field work. Use Map View to add waypoints to a Waypoint File.

After these files are created, they must be uploaded to the handheld. This is accomp
in Transfer Data.

Collecting data with the Reliance Rover System by itself (in autonomous mode) can 
provide 100 meter position accuracy. To improve this accuracy, you must also be 
collecting data from a GPS base station. Reliance performs a technique called “differ
correction” on these two data sets can improve your accuracy to submeter, decimete
even centimeter level. Refer to Chapter 10, Processing Collected Data, for more 
information.

You can set up your own GPS base station or you may be able to use data from an e
GPS base station in your area, including data from CORS sites on the Internet.

Transferring Feature Files and Waypoint Files 
to the Handheld

To transfer files to the handheld, use the following steps:

1. Turn on the handheld and connect it to one of the COM ports on your PC us
the cable provided.
ction 69
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2. Bring up the Transfer Data dialog from the Tools pull-down menu of the 
Reliance main menu.

3. After clicking on the icon representing Transfer information between the 
PC and handheld device, a reminder message appears.

 Figure 6.1: Transfer Data dialog

 Figure 6.2: HCOM Reminder dialog
Reliance Office User’s Guide
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4. After making sure that your handheld is on and running HCOM, click OK 
and the Transfer Data Between PC and Handheld dialog appears.

Table 6.1 describes the components of this dialog.

o

 Figure 6.3: Transfer Data Between PC and Handheld dialog

 Table 6.1: Transfer Data Between PC and Handheld

Name Meaning

PC
• Files

• Drive

• A list of all files in the current directory. You may select one by 
clicking on it or by using the arrow keys on your keyboard to 
traverse the list and pressing the space bar.

• Selects which drive to use on the PC.

Handheld
• Files

• Handheld Drive

• Delete
• Refresh

• A list of files of all the sub directories and files in the current 
directory on the handheld. You may select a file by clicking on it or 
using the arrow keys on your keyboard an pressing the space bar.
You may change directories by double-clicking on the desired 
directory. The parent directory is denoted by [...]. As you change the 
path, the current path is displayed as static text about the View 
group.

• A list of all the drives available on the handheld controller. You may 
select a new drive by clicking on the arrow and selecting a drive 
from the dropdown list. The directory listing will be updated.

• Deletes selected files on the handheld controller.
• Allows you to query the handheld controller and update the display 

in the handheld listbox.
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You may also transfer Waypoint and Feature Files back from the handheld if you wish.

Error Sources of GPS

Position data collected with the Reliance Rover System by itself is only accurate to 
within 100 meters 95% of the time. This can be dramatically improved to submeter, 
decimeter, or even centimeter accuracy with Reliance using a technique called 
“differential correction”. Differential correction requires data from a GPS base sta
to be collected at the same time the Rover system was collecting its field data. 
Therefore, Reliance is a DGPS (Differential GPS) system. Described below are 
several error sources that affect the accuracy of DGPS.

GPS Signal Multipath

Multipath is the most unpredictable source of errors in GPS position accuracy. It
affects the rover and base stations differently and cannot be canceled out by 
differential processes. Multipath errors can be large, (greater than 5m) and small
than 2m). To avoid large multipath errors, do not place the GPS antenna near a
metal objects, or other solid surfaces because satellite signals reflect off these o
easily. Also, try to mount the antenna as high as possible, (at least 2m) to reduc
effect of ground multipath reflections. 

Satellite Geometry

Satellite geometry is the strength of satellite coverage for a given area and is 
measured by an index called PDOP (Position Dilution of Precision). PDOP is affe
by the quantity of satellites visible and their relative positions in the sky. When th
are many (5-8) widely spaced satellites visible at a location, the PDOP is 4 or le
When there are less satellites visible, or they are unevenly spaced in the sky, PD

PC COM Port Allows selection of PC serial port to which the handheld is connected 
to.

Show
• Waypoint Files
• Feature Files
• All Files

• Displays only Waypoint files in the PC and the handheld.
• Displays only Feature files in the PC and the handheld.
• Displays all files in the PC and the handheld.

Close Closes the dialog.

Help Displays Help menu.

 Table 6.1: Transfer Data Between PC and Handheld (Continued)

Name Meaning
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values can be 6 or higher. Fortunately, the PDOP in an open sky is typically around 3, 
and quoted Reliance system accuracies assume this norm.

Maintaining Lock to Satellites

The number of satellites tracked is very important, and can affect GPS measurements 
in two ways. As mentioned above, the greater number of satellites tracked, the better 
the PDOP will be. More importantly, the number of satellites tracked dictates what 
kind of position solution can be computed with GPS. Three satellites will enable the 
receiver to compute a two-dimensional position (X,Y) and four will enable a unique 
solution in three dimensions (X,Y,Z). The Reliance system can compute positions 
with three or four satellites, but it will achieve optimum results with 5 or more 
tracked. Objects that obstruct the direct path from satellite to antenna will affect 
tracking and therefore, accuracy.

Selective Availability

Selective availability (SA) is the intentional degradation of the GPS satellite signal by 
the US Department of Defense. Like multipath, it is hard to predict, but unlike 
multipath, it affects the base and rover receivers the same, and can by removed by a 
Differential GPS system (such as Reliance). Small SA degradation will still exist in 
real-time systems such as RTCM due to the unpredictability of SA, and the time delay 
of the radio link. This is one reason why post-processed DGPS yields better accuracy 
than real-time DGPS.

Although there are many and varied error sources affecting GPS position accuracy, 
utilizing the proper planning and field procedures can greatly reduce the risk of 
degraded positions. The Reliance system uses a combination of powerful receiver 
technology and robust processing techniques to insure that even novice users can 
easily meet or exceed their positioning needs.

Setting Up a Base Station

For a high degree of accuracy, the Reliance system depends on data collected from a 
GPS reference station as well as the Reliance Rover system. If you are setting up your 
own Ashtech Reliance base station, refer to the Field Operation Manual.

You may have access to data from an existing GPS base station in your area. 
Typically, this data is provided to you in RINEX format. The Reliance RINEX 
Converter can convert the RINEX data format into the Ashtech data format, which is 
necessary to use this data in Reliance software. For more information about 
converting RINEX data into Ashtech data please refer to Chapter 14, Tools.
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After the field work is complete, you must transfer data from the Reliance Rover system 
back to your PC. You may also have to transfer GPS Base Station (sometimes known as 
reference station) data to your PC.

If the field data was corrected to submeter accuracy in real-time (using a radio link to 
obtain the RTCM differential corrections), you may not require any base station data. But 
to process the data in the Reliance , base station data is required. To perform the 
processing correctly, base station data must be collected at the same time as the Rover 
data.

Data sets can be transferred from the Rover system: the data from the GPS receiver. The 
GPS receiver should be connected to one of the COM ports on your PC to download the 
GPS data.

Base Station data may be transferred to your PC from a GPS receiver connected either 
directly to your PC, remotely using a modem and a remote communications software 
application, or even from the Internet - as with the CORS sites.

If you are using data from another brand of GPS receiver as base station data, you must first convert the 

files (which are in a proprietary format) to RINEX. Refer to Chapter 14, Tools.

Downloading Collected Data From the Reliance 
Rover System

Perform the following steps to transfer data from the Reliance Rover System:

1. Connect the SCA-12 GPS receiver to one of the COM ports on your PC using the 
provided interface cable with the cable labelled “Port C / PC Data.”
ng Field Data 75
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2. Bring up the Transfer Data dialog.

You must open a project or create a new project to make the Transfer Data dialog active.

3. Click on the icon representing Download GPS data from GPS receiver.

A reminder message appears indicating to connect the receiver to the PC.

Make sure the GPS receivers cable and battery are connected and the receiver is turned on before 
proceeding. 

 Figure 7.1: Transfer dialog

 Figure 7.2: GPS Receiver Transfer Reminder dialog
Reliance Office User’s Guide



Transferri

T
ransferring F

ield D
ata
4. Click OK.

The Download dialog appears:

Table 7.1 explains the various components of this dialog:

 Figure 7.3: Download dialog

 Table 7.1: Download dialog

Name Meaning

Destination This text indicates the download destination of the files. 

Available Files This listbox displays available files from the connected receiver. The listbox 
shows the filename with file date and size (in kilobytes). All possible files 
displayed in this listbox include user-defined eight-character session names 
with index extension, and an almanac file. 
An asterisk next to a filename indicates that the file has been successfully 
downloaded.

COM Port Lists all PC COM ports available for communication. The default is set to the 
first COM port from the COM port combo box the first time you use the 
Download dialog. If the connected receiver is not responding to the default 
COM port, you can select another COM port from the combo box and retry 
establishing communication. The selected port is saved before exiting the 
Download dialog. For the next download, the Download dialog uses which-
ever COM port that was last selected as its default.

Baud Rate Sets the baud rate of the serial port to what is desired to communicate with the 
GPS receiver. Default is “Max”, which is 38,400 baud.
ng Field Data  77
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Set Path... Displays the Set Path dialog. This button is disabled until there are file(s) in 
the Selected Files listbox. Select this button to set a destination directory for 
downloading files. The selected directory applies to all highlighted files. 
Refer to “Set Path Dialog” on page 79.

Rcvr info Displays the Receiver Information dialog (refer to “Receiver Information 
Dialog” on page 81). This button is always enabled after successful connec-
tion to a receiver.

Refresh • This button is enabled after the connection process is completed. Allows
you to reload the listbox with receiver files from the connected receiver 
or retry connection in case of communication error. When you select 
Refresh, the Download module tries to establish communication with the 
receiver.

Exit • Disconnects communication with the connected receiver, saves the COM
port setting in the Reliance .INI file, and closes the Download dialog. 
Disabled during the connection process.

• The Rover receiver is automatically turned off.

Help Displays help on the Download dialog.

Download • This button is disabled until there is a file(s) highlighted in the listbox. It 
starts the transfer of receiver files to selected directory. 

• Sufficient disk space must also be checked prior to downloading the 
selected files. When Reliance  detects insufficient disk space available to
download the files, a warning message will appear. When this happens, 
select another destination or free up some disk space before proceeding
to download.

• In the case of duplicate files during the download process, an error dialog
appears to warn you that the file to be downloaded already exists in the 
destination directory and asks you if you want to overwrite the existing 
file. Respond Yes, to overwrite that file; Yes To All, to overwrite all 
future duplicate files; No, not to overwrite that file; Cancel, to cancel the 
download process.

• A Progress dialog shows the status during the download process. The 
status shows which file is being downloaded and what percentage of the
files have been downloaded so far. Select Cancel at any time to stop the
download process.

• When a file is successfully downloaded, an asterisk appears in front of 
the file in the Available Files listbox. This helps keep track of which 
file(s) have already been downloaded.

Delete • Deletes files from the receiver that are highlighted in the listbox. This 
will allow more space in the receiver for future missions. A warning 
dialog confirms deletion.

• A Progress dialog shows status if you respond Yes to the confirmation. 
The status shows which file is being deleted. You can select Cancel at 
any time to stop the file deletion process. The cancel takes effect only 
after a complete deletion of the file currently shown to be deleted. It will 
not stop immediately in the middle of a file deletion.

 Table 7.1: Download dialog (Continued)

Name Meaning
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In the Download dialog, an hourglass appears as Reliance  tries to establish 
communication with the connected receiver on a default COM port, which is 
the first choice from the available COM ports. If the connection is 
successful, GPS receiver files are displayed in the listbox. Otherwise, an 
error dialog appears indicating communication failure and a troubleshooting 
tip.

Set Path Dialog

The Set Path dialog selects the destination directory and drive in which to download 
the selected receiver files. The selected directory affects all highlighted files in the 
listbox.

Approx. Total File 
Size (KB)

Displays the approximate size of all the files selected. 

Available Disk 
Space (KB)

Displays the approximate space available for the disk selected under Set 
Path.

 Figure 7.4: Download Error dialog

 Figure 7.5: Set Path dialog

 Table 7.1: Download dialog (Continued)

Name Meaning
ng Field Data  79
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Table 7.2 explains the various components of this dialog.

File Information Dialog

Clicking the right mouse button on a filename in the listbox, brings up the File 
Information dialog.

 Table 7.2: Set Path dialog

Name Meaning

Directories This field displays the current directory. If the length of the directory path is longer than 
the space allocated for it, the directory path is automatically shortened to fit in the text.

Directories 
Listbox

A box is displayed below the directories field that lists all available subdirectories that 
exist under the directory or drive specified. Double click on a subdirectory to select it. 
The Directories Text is updated accordingly.

Drives: • This box displays the current drive. Click on the drop-down arrow to select anothe
drive from the available drives listed in this combo box. The Directories Text and th
Directories Listbox are updated accordingly.

• If you select a disk drive that does not have a floppy disk or is not formatted, a 
warning message appears. Click Retry after verifying what the warning message 
suggested or Cancel to select another drive.

OK This button accepts the directory and/or drive selected, closes the Set Path dialog, retu
to the Download dialog, and tags the destination directory to all files in the Selected Fil
listbox. 

Cancel This button closes the Set Path dialog and aborts the path selection. It returns to the 
Download dialog.

Help This button displays help on the Set Path dialog.

 Figure 7.6: File Information dialog
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Table 7.3 explains the various components of this dialog:

Receiver Information Dialog

Clicking on the Rcvr Info button in the Download dialog brings up the Receiver 
Information dialog.

 Table 7.3: File Information dialog

Field Meaning

Name: Displays the file name.

Size: Displays the approximate file size in kilobytes.

Start Date: Displays file start date in month-day-year.

Stop Date: Displays file stop date in month-day-year.

Start Time: Displays the file start time in hours:minutes. Hours range from 0 to 23.

Stop Time: Displays the file stop time in hours:minutes. Hours range from 0 to 23.

Type: Displays file type:
• Geodetic (L1 C/A code and carrier, positions)
• Position Only

OK Closes File Information dialog and returns to the Download dialog.

 Figure 7.7: Receiver Information dialog
ng Field Data  81
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Table 7.4 explains the various components of this dialog:

Transferring Reference Station Data From a Local 
Base Station

This operation is described in “Downloading Collected Data From the Reliance 
Rover System” on page 75.

Transferring Reference Station Data From a Remote 
Base Station

To download Base Station data from a remote site using a modem, Reliance  pro
a “hot-link” to a desired remote communications application. Perform the followin
steps:

 Table 7.4: Receiver Information dialog

Field Meaning

Type: Displays the type of receiver:
• Z-12
• SCA-12
• MD-12

Capabilities: Displays what the receiver is capable of tracking:
• L1 C/A-code
• L1 C/A-code and carrier
• L1/L2 P-code and carrier

Mem Size: Displays the size of the RAM board in the receiver in kilobytes.

Chan Ver: Displays the version number of the receiver Channel software.

Nav Ver: Displays the version number of the receiver Nav software.

OK Closes the Receiver Information dialog and returns to the Download dialog.
Reliance Office User’s Guide
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1. Bring up the Project Setup dialog.

2. Click on the Directories tab and notice the Miscellaneous section at the 
bottom.

 Figure 7.8: Project Setup dialog

 Figure 7.9: Project Setup dialog/Directories tab
ng Field Data  83
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The Remote Communications Application is not set by default. Select an 
application by clicking the Folder icon button. The Select a 
Communications Application dialog appears.

3. Browse through you current directories and drives to find the application 
you wish to use.

4. Select “Download GPS data from a remote GPS receiver” from the Tran
dialog once the proper remote communications application is set up (refe
Figure 7.1).

Your selected application should appear.

 Figure 7.10: Select a Communications Application dialog
Reliance Office User’s Guide
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Once a project is loaded, rover and base station data can be displayed by one or both of 
Reliance’s powerful viewers. The Time View display exhibits data chronologically ov
the course of minutes, days or months.   Map view shows data by its position on the
ground, creating a digital topographic map displayed in a user-selectable coordinate
system. Reliance supports user-definable datums and projections in addition to com
coordinate systems from around the world. Features will be displayed in Map View u
the symbols, line types, colors and fill patterns as defined in the feature file with whic
they were collected. Fast attribute information is available by simply double-clicking 
feature.   All available data for the project will initially be scaled to fit into the current 
display window which can later be panned and zoomed for a “closer look”.

Map View allows a full display zoom with user selectable origin and a point-and-drag 
zoom for extra flexibility. Feature symbols and reference grid can be toggled and full f
access are provided from the toolbar. Waypoint production and editing are also 
accomplished from Map View. A toolbar icon toggles between “Normal” and “Waypoi
modes allowing the seamless manipulation of map and waypoint data in the same dis
Other utilities such as the “Ruler”, which can measure distances in user selectable u
and “On-line” help, make Map View an potent tool for data analysis. While Reliance 
not a GIS system, it provides a means for office personnel to view and edit field data
user-friendly environment before the data is exported to GIS formats.

A key feature of these windows is when selecting one of the features in Time View, t
Map View window will automatically select the same feature. This will allow you to 
easily see the relationship between the occupation times of the features and their po
accuracies.

Viewing Collected Data in Map View

To view collected feature data in geographical format, perform the following steps:

1. Load a project with a session containing features.
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2. Select Map View from the Tools pull-down menu of the Reliance main 
window.

The features of the collected data will appear in the display. If the data is unprocessed, 
each point making up the map will have an accuracy within 100m and so may have a 
jumbled appearance. After processing, the data on the display should look fine.

Table 8.1 explains the menu choices of this window:

 Figure 8.1: Map View window

 Table 8.1: Map View Menu choices

Name Meaning

Edit (pull-down menu)
• Place Waypoint • Turns on waypoint mode to allow placing of waypoints with the 

cursor on the display. Selecting again will toggle this command.

• Delete Waypoint • Deletes a selected waypoint on the display.

Filter... • Brings up the Project Filter Data dialog. For information on  
filtering, refer to Figure 9.1 on page 103.

• Join Points... • Joins selected point features into a new line or area feature (hides
original point features).

• Delete Join Feature • Unjoins the line or area feature previously joined and the original
point features will be visible again.

• Print... • Allows printing of the current display in the Map View window.

A B C D
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Table 8.2 explains the Toolbar icon buttons of this window:

• Close • Closes the Map View window.

View (pull-down menu)
• Feature Info...

• Undo Selection

• Shows the Feature Information dialog for the last feature that was 
highlighted in the display.

• Removes the red circle around a feature that was selected in the 
display.

• Hide Points

• Unhide Points...

• Hides those points selected within Map View. Selection of points 
is by dragging the mouse from upper left to lower right.

• Displays a list of those features currently hidden, which can be 
selected to return the feature to its original state.

• Ruler • Turns on a mode where you can measure distance from any point 
in a feature to anywhere else on the display. Click and drag 
mouse from an existing point to show distances and azimuths as 
you move the mouse.

• Zoom In

• Zoom Out

• Normal Size View

• Zoom in one step closer to the object in the center of the display. 
At least three positions must be selected for zoom to function.

• Zoom out one step further from the object in the center of the 
display.

• Returns to the initial state of Map View which shows all the 
feature available in the display.

• Symbol
• Grid

• Toggles the Toolbar on and off.
• Toggles the Statusbar on and off.

• Toolbar
• Status bar

• Toggles the point feature symbols on and off.
• Toggles the grid lines on the display on and off.

Help Displays the Help information for Map View.

 Table 8.2: Map View Toolbar Icon Buttons

Name Meaning

Waypoint Mode Turns waypoint mode on and off.

Delete Waypoint Deletes the currently selected waypoint on the display.

Symbols Toggles the point feature symbols on and off.

Undo Selection Removes red circle highlight from the selected feature or waypoint.

Grid Toggles the grid lines on and off.

Zoom In Zooms the display closer.

Zoom Out Zoom the display out.

Ruler Turns on measurement mode in order to measure distance and azimut
from features.

 Table 8.1: Map View Menu choices (Continued)

Name Meaning
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Table 8.3 explains the Status Bar of this window (refer to Figure 8.1):

Table 8.4 explains operations you can perform with the mouse buttons while in this 
window.

Feature Information Dialogs

The format of the Feature Information dialog is dependent on the feature type.

The following actions may be taken to obtain information about a feature:

• Click once on any point of a feature to highlight that feature by circling a
its points in red. Click View from the menu bar and select Feature Info...

• Double-click on a highlighted feature to bring up the Feature Information
dialog.

Normal View Size Returns to the initial display state of the window.

Filter Brings up the Project Filter Data Dialog.

Help Brings up the Help menu.

 Table 8.3: Map View Status Bar

Label Meaning

A Gives the display mode of the Map System currently selected (Geographic, 
Standard Grid, or Local Grid).

B Shows the current X cursor position on the display.

C Shows the current Y cursor position on the display.

D Shows the grid scale (1 Grid-xx meters) where xx varies depending on your 
display mode and how far zoomed in or out you are on the display.

 Table 8.4: Map View Mouse Button Operations

Action Function

Single-Click, Left mouse button Selects the feature the cursor is currently on (a red circle will appear on 
each point of the feature).

Clicking and Dragging the Mouse Area zoom is activated. The cursor will change to a magnifying glass 
and a dashed box will appear as you move the mouse down and to the 
right of the display.

Double-Click, left mouse button Shows the Feature Information dialog for the feature the cursor is on.

Double-Click, right mouse button “Center-on-point” function. When doing this, the view of the map 
centers on the location of the cursor regardless of where it was at.

 Table 8.2: Map View Toolbar Icon Buttons

Name Meaning
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For point features, their position will be shown in the proper display mode for the 
Map System you have currently selected (refer to Chapter 13, Setting Up a Map 
System). If in Geographic display mode, you will see position displayed in Latitude, 
Longitude, and Height. For Standard and Local Grid display mode, you will see 
position displayed in East, North, and Height.

The following three figures are the Feature Information dialogs for a point, a line, and 
an area:

 Figure 8.2: Feature Information dialog (point)

 Figure 8.3: Feature Information dialog (line)
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The Feature Information dialog has three formats which are dependent on the feature 
type:

Attribute Information Dialog

For all three types of Feature Information dialogs, you can view the list of attribute 
names and values of the feature by clicking Attributes. These attributes were entered 
during the data collection process using the handheld controller and can be edited in 
Reliance.

To edit the attribute values in the Feature Attributes dialog, highlight the cell  to 
change and type in the new text. Then press the ENTER key or click on another cell 

 Figure 8.4: Feature Information dialog (area)

 Table 8.5: Feature Types

Feature Information Format Displayed Information

Point A feature’s position and calculated precision are displayed.

Line A features calculated distance (length).

Area A feature’s area and perimeter.

 Figure 8.5: Feature Attributes dialog
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in this dialog. After making all the necessary changes, press the OK button to return 
to the Feature Information dialog.

If two features overlap, use the filter to show the feature and its information dialog one at a time.

Map View in Waypoint Mode

Selecting Place Waypoint from the Edit menu pull-down enables a mode for creating 
and editing waypoints. The Waypoint Mode will be signified by a change to a “pl
sign in the pointer icon. When this mode is active, clicking on a point within the 
display area starts the waypoint creation process. Entry of a waypoint name and
modifying its position values can then be done if needed.

To cancel Waypoint Mode without placing a waypoint, select Place Waypoint again 
from the Edit pull-down menu.

As soon as you place a waypoint on the Map View, the Waypoint dialog appears

If a waypoint file name has not been set up in the Session Settings tab dialog, a default file name 
called WPT00.WPT will be created to save your entered waypoints.

 Figure 8.6: Waypoint dialog
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Table 8.6 explains the various components of this dialog:

Hide/Unhide

Reliance provides you the capability of hiding points. This is useful if you do not 
wish to have a graphical display of unnecessary points shown in Map View.  Hidden 
points will not be exported. To hide points, perform the following steps:

1. Select a feature you want to hide. All of the points which make up a feature 
should be highlighted with a red circle.

2. Select Hide Points within the View drop-down menu.

You must select a feature before the software enables this menu item. Hide points operation can only 
be performed on one feature at a time.

3. Click the left button and drag the mouse down and to the right to select a 
group of points to hide—a rubber band rectangle will be displayed to sh
the enclosed points.

4. Release the left mouse button. All the selected points will now be hidde

If the rubber band rectangle encloses points other than the selected feature, they will be ignored.

5. Once the points are hidden, they will not be displayed in Map View or Ti
View, nor will they be placed in any export files.

“Unhide Points” allows you to remove the hidden points selected features. This m
item will be available when there are one or more features with hidden points. To
unhide a feature, perform the following steps:

 Table 8.6: Waypoint dialog

Name Meaning

Waypoint Name Name given to Waypoint that can be edited. This name can be up to 
20 characters long.

Position For Geographic Map Systems
• Latitude coordinates of the Waypoint.
• Longitude coordinates of the Waypoint.
For Grid Map Systems
• X coordinate
• Y coordinate

OK Closes Waypoint dialog and saves information about the Waypoint 
file as specified.

Cancel Closes Waypoint dialog without saving the displayed 
information.
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1. Select Unhide Points from the View drop-down menu to display a dialog 
with all of the hidden feature names.

2. Select a feature name in the dialog box and click OK.

3. All the points in the selected feature should be unhidden.

Join/Unjoin

Joining point features into a new line or area feature can be done by performing the 
following steps:

1. Select Join in the Edit drop-down menu to display the Join Points dialog.

2. Select the session, point feature, and text attribute that will be used for 
joining points.

3. Chose whether to create a line or an area feature.

 Figure 8.7: Unhide Points dialog

 Figure 8.8: Join Points dialog
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4. Choose whether to perform a “nearest neighbor” or “time-ordered” 
connection of points.

5. Enter the common text value that all point features to be joined have.

6. Click OK.

When the dialog closes, all point features with the common text value wil
joined into the feature type selected. The name of the new feature creat
will be that of the common text value.

Point features to be joined MUST have the exact same text (alpha) attribute value.

Should you need to remove the newly created line or area feature and reinstate 
original point features, perform the following steps:

1. Select the joined feature to be deleted on the Map View window.

2. Select Delete Join Feature from the Edit drop-down menu.

3. The line or area will then be deleted and the point features will become 
visible again.

The Filter dialog will be updated to indicate the point features that have been joined into a new 
feature (either Generic Line or Generic Area) with their appropriate attribute value filtered out. 
You can remove this attribute filter to display both the original point features as well as the new line 
or area feature created (refer to “Filtering By Attribute Values” on page 105).

Viewing Collected Data in Time View

While Map View provides a geographical representation of the data collected in 
Reliance, it is often helpful to view the same data in a chronological representation. 
Time View does this by graphically presenting the feature information collected by 
each receiver on a horizontal bar chart, or time line. Point, line, and area features are 
designated by unique colors on this time line for easy identification.

With Time View, nesting and pausing operations performed in the field are 
immediately visible. Time View can also be used to identify base station data that was 
collected simultaneously with the rover data, which is required for post-processing. 
Since the Project Data Filter affects the data in Time View, the affects of filtering 
point, line, or area features can be easily determined.

Since feature information is presented on a time line, Time View can be used to 
review the feature information in the order it was collected. This is helpful when 
matching feature and attribute information to field notes. Also, Time View can be 
used to review the rate at which features were collected in the field. This information 
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can be used to improve the structure of the Feature File as well as improve the field 
data collection techniques.

The Time View display can be zoomed in for a close look at individual feature 
occupation times, or it can be zoomed out for a broader examination of rover data 
collection time spans. For ease of use, the collection times can be viewed in UTC or 
in any local time system.

Once a feature has been selected in Time View, the Feature Information dialog can be 
used to view the following:

• Session Name
• Feature Name
• Type
• Minimum number of satellites tracked during the logging of that feature
• Summary of the feature occupation time
• Recording interval
• Antenna height

The Attribute Information dialog can then be used to view a list of the attributes (
any) for that feature. An Offset dialog is also available to view any offset informat
that may have been entered in the field.

To view collected data chronologically and edit it, perform the following steps:

1. Access the Time View window from the Tools pull-down menu of the 
Reliance main window.

The Time View window will be displayed in Overview Mode.

 Figure 8.9: Time View window-Overview Mode
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2. Click on one of the Receiver buttons to display Time View in “Receiver 
Mode.”

Table 8.7 explains the menu choices of this window:

 Figure 8.10: Time View window-Receiver Mode

 Table 8.7: Time View Menu Choices

Name Meaning

Edit (pull-down menu)
• Filter...

• Exit

• Provides a “hot-link” to the Filter dialog, which has 
control over what features (and with what attribute 
values) are displayed on the Time View. Refer to 
Chapter 9 for more details on the Filter dialog.

• Closes the Time View window and returns you to the 
Reliance main window.
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Table 8.8 explains the Toolbar icon buttons of the Time View window:

View (pull-down menu)
• Feature Info...

• Receiver Info...

• Zoom In
• Zoom Out
• Scroll Left
• Scroll Right
• Overview mode

• Grid

• Toolbar

• Status Bar

• Displays Feature Information dialog. Refer to 
“Feature Information Dialog” on page 99.

• Displays Receiver Information dialog. Refer to 
“Receiver Information Dialog” on page 101.

• Narrows the Time View by one “step.”
• Expands the Time View by one “step.”.
• View features collected earlier in session.
• View features collected later in session.
• Default display that allows viewing of all receiver 

sessions.
• Toggles the grid on and off for the time display. A 

checkmark indicates whether or not the Grid is on.
• May be toggled on or off. A checkmark indicates 

whether the Toolbar is on or not. Refer to Table 8.8 
for a description of the Toolbar.

• May be toggled on or off. A checkmark indicates 
whether the Status bar is on or not. Refer to Table 8.9 
for a description of the Status bar.

Help
• Help
• Feature Legend...

• Displays Help menu.
• Depicts the color bars associated with feature types.

 Table 8.8: Time View Toolbar Icon Buttons

Name Meaning

Feature Information Displays the Feature Information dialog with a list 
of all features in the project.

Receiver Information Displays the Receiver Information dialog for the 
selected receiver bar.

Zoom In Expands the Time View by one “step.”

Zoom Out Narrows the Time View by one “step.”

Reset Resets the Time View display to its initial default

Grid Display or hides the Time Ruler Grid.

Filter Displays the Project Data Filter window.

Help Displays the Time View Help information.

 Table 8.7: Time View Menu Choices

Name Meaning
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Table 8.9 explains the Status Bar of the Time View window:

Above the occupation area is a ruler of time values. These values increase from left to right and 
constitute the value at their position for the horizontal axis of Time. At each end of the Time Ruler 
are scroll buttons. Clicking on these moves the occupation area in the direction to which they point. 
The Time Ruler indicates the values at their positions.

The time and duration of recording at a feature is known as an “occupation”. Thi
data is displayed in the Time View for each occupation recorded in the project. 
Receivers are shown as a column of buttons to the left of the window, while thei
occupations are shown to the right as an occupation bar. The occupation bar for
rover can contain up to three colored bands, while the occupation bar for the bas
contain only one color. Each color represents a different feature type.

 Table 8.9: Time View Status Bar

Label Definition

Time Zone Indicates time zone of data collection

Date Span Indicates beginning and ending date of data collection.

Time Span Indicates beginning and ending time of data collection.

Time Scale Indicates measurement scale of time display.

 Table 8.10: Time View Color Bands

Color Bands Identification

Green Point Features

Red Line Features

Yellow Area Features

Blue Base Data
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Suppose a fence feature was being recorded and the field worker encountered a power 
pole which was part of the fence. The power pole is a point feature, and the fence is a 
line feature. If the field worker wanted to record the fact that there was a power pole, 
they would use “nesting” to record both the fence and the power pole. This woul
result in the power pole (a point feature) and the fence (a line feature) to share d
points and hence, occupations.

If the session contains a base station file, the base station receiver is also displa
the Time View. Receiver bars for base stations look similar, except they contain 
a single blue color band.

The Time View only displays the receiver once. When multiple sessions are collected from the same 
Rover receiver, the occupations for each session are shown on a single receiver bar, from left to right, 
ordered according to the time and date of recording.

Feature Information Dialog

The Feature Information dialog displays information about the selected feature. I
be accessed from the menu by clicking on the “View” menu and then on the “Fea
Information” menu item, or by clicking on the appropriate icon in the Time View 
Tool Bar, or by double clicking on the feature’s occupation in the receiver bar. 

This dialog shows the feature name, feature type, number of satellites during the
occupation, and the recording interval (epoch setting). It also shows the starting
ending dates and times of the occupation. If an antenna height value was entere
the field, it would be shown here. This value may be changed, but the change wi
affect the position unitl after the data is processed.

 Figure 8.11: Feature Information dialog
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The Attributes button displays the Attribute dialog (refer to Figure 8.5). The Offset 
button displays the Offset dialog, described below.

Offsets Dialogs

The Offsets dialogs are shown in one of two forms, one for point features, and one for 
line and area features.

The Offset dialog for point features displays feature offsets that may have been 
entered in the field in two ways: as a three-dimensional grid distance or as a bearing, 
and horizontal/vertical displacement. These offsets can be edited if desired, but they 
do not take affect on the position of the point feature until after processing.

The offset dialog for line or area feature shows the horizontal and vertical distance 
that the entire feature can be offset by, along with what direction (left or right) it was 
offset. These can not be edited.

Only one offset per feature is allowed.

 Figure 8.12: Offsets dialog for Point Features

 Figure 8.13: Offsets dialog for Line or Area Features
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Receiver Information Dialog

The Receiver Information dialog displays information about the selected receiver. 
Display it by clicking on the “Edit” menu and then on the “Receiver Information” 
menu item, by clicking on the appropriate icon in the Time View tool bar, or by 
double clicking on the receiver name in the receiver bar.

This dialog shows the receiver name, serial number, type, capability, channel ve
and Nav version. The receiver name defaults to the receiver’s serial number but
be changed to a familiar word or phrase if desired. This is done by typing in the 
desired name or phrase.

 Figure 8.14: Receiver Information dialog
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Filtering limits the data displayed and exported by Reliance Processor. This chapter 
explains project data filtering by features, by entire session, and by the value of attributes.

Filtering By Feature and Session

The Project Data Filter dialog specifies the features and sessions which are hidden from 
view in the Map View and Time View. Data which is not hidden will be exported. This is 
accomplished by building a list of the features and/or entire sessions to be hidden from a 
list of features to be shown. When a feature or object is shown, it is said to be “visibl
The Project Data Filter dialog contains these lists as well as the controls to move the
between each other. Access to the Project Data Filter is provided from the following:

• Reliance Processor main window Data pull-down menu
• Project Control - Filter Data
• Map View window - Edit pull-down menu
• Time View window - Edit pull-down menu

Selecting Filter by any of these methods will provide the same Project Data Filter dialog.

 Figure 9.1: Project Data Filter dialog
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Table 9.1 explains the various components of this dialog.

 Table 9.1: Project Data Filter dialog

Name Function

Sessions/Features to Show Session and Features which will be visible in the project. Ini-
tially, a new project will have all its sessions and features vis-
ible.

Movement Buttons
• Single Item
• All items

• Hide or unhide a session or feature.
• Hide or unhide all sessions and features in listbox.

Sessions/Features to Hide Those sessions and features that you have selected to hide.

• Load...

• New...

• Save As...

• By Value...

• OK
• Cancel
• Help

• Clicking opens the Load Project Data Filter dialog 
where the desired file is selected and loaded. This also 
causes the project’s currently active filter setting to be 
set to the loaded filter file.

• Clicking opens the Create a New Filter File dialog. In 
this dialog, the file name specifies the name of the new 
filter file to be created. Different from the Save As... 
function, this button causes the filter to be reset to all 
sessions and features being visible.

• Saves filter sets with a different name for later use with 
the same or different projects. Displays standard 
Windows Save As dialog.

• Specifies attribute values which a feature must satisfy in 
order to be visible. Refer to “Filtering By Attribute 
Values” on page 105.

• Filter Project data by the parameters specified.
• Closes this dialog without changing any of the previous 

settings.
• Displays help on the Project Data Filter dialog.
Reliance Office User’s Guide



Filtering C

F
iltering C

ollected D
ata

ed.
Filtering By Attribute Values

Clicking By Value... in the Project Data Filter dialog displays the Filter Data By 
Value dialog. This dialog specifies the values a feature’s attributes must satisfy in 
order to be visible on the Map View and Time View displays, and also be export

Table 9.2 explains the various components of this dialog.

 Figure 9.2: Filter Data by Value dialog

 Table 9.2: Filter Data By Value dialog

Name Function

Features Contains all features in the project.

Attributes Contains attributes defined for the feature selected in the Feature 
listbox.
ollected Data 105



106
Filter Selection

• Text

• Numeric

• Menu

Shows what attribute values can be selected to filter for the selected 
attribute. Each type of attribute (text, numeric, menu) has a differ-
ent format:
• Provides a field to type in the text value you want to show. 

Possible ways to filter are “Equal To” or “Not Equal To”.
• Provides a field to type in the numeric value you want to 

show along with showing the range of values allowed. 
Possible ways to filter are “Less Than”, “Greater Than”, 
“Equal to”, “Not Equal To.”

• Shows the list of menu items that you can select “Equal To” 
or “Not Equal To.” in order to show them

Include Point Features
• All Points

• Only unprocessed 
points

• Only processed 
points

• Only CM points

• Standard filter which allows all points to be displayed and 
exported.

• Used to view/export those points which were unable to be 
processed.

• Used to view/export only those points which were 
successfully processed.

• Used to view/export only those points which were 
successfully CM processed.

• With horizontal RMS 
less than X meters

• Used to view/export only these points with horizontal RMS 
values less than X meters, where X can be specified.

Filter Conditions Shows the conditions that the attributes of a feature must satisfy in 
order not to be filtered out.

Buttons
• Add
• Delete
• OK
• Cancel
• Help

• Adds a new condition to the Filter Conditions area.
• Deletes a selected condition from the Filter Conditions area.
• Closes dialog and saves information.
• Closes dialog and does not save information.
• Brings up Help menu.

 Table 9.2: Filter Data By Value dialog (continued)

Name Function
Reliance Office User’s Guide



Filtering C

F
iltering C

ollected D
ata
For the three different types of attributes (text, numeric, menu), the Filter Data by 
Value dialog is displayed the following ways:

 Figure 9.3: Filter Data by Value dialog-text

 Figure 9.4: Filter Data by Value dialog-numeric
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A feature with attributes that have filter conditions from this dialog will be shown in 
the Project Data Filter dialog with a “+” in front of them. Features with a “+” in fro
of them that are in the Hide list in the Project Data Filter dialog will not be shown/
exported, even if they satisfy the filter by value conditions specified.

Effects of Filtering 

Filters are project wide.When they are changed, the scope of visible data chang
throughout the project. Filtering has no effect on processing. When the data is hi
by filtering, Time View, Map View, and exporting are affected. The displays show
hidden data as trajectory. Trajectory data is located in the Time View by double 
clicking on a receiver’s bar where no colored bands (occupations) exist. Trajecto
data is the GPS data recorded by the receiver between feature occupations. The
Reliance Processor processing engine requires the data to be continuous throug
GPS data file.

 Figure 9.5: Filter Data by Value dialog-menu
Reliance Office User’s Guide



 10

Processing Collected Data
Processing

R
eliance F

undam
entals

P
rocessing C

ollected D
ata
When features are collected and their GPS positions recorded, the position accuracy is 
about 100 meters. To obtain higher accuracy, Reliance Processor provides post 
processing. This is one of the cornerstones of the Reliance Processor product. Post 
processing uses Differential Correction to obtain highly accurate positions from collected 
data. Differential Correction is a complex mathematical algorithm. It uses the GPS data 
recorded at a known location (a base station) during the same time as the data collected at 
the Rover. The results are highly accurate feature positions. The post-processing tool is 
accessible from the Project Control window by clicking on Process Data, then clicking on 
Data menu and then on the Process menu item. The post-processing tool may also be 
accessed by clicking on the Process icon button in the Project Control dialog.

Process Selection

The Process Selection dialog is used to select which sessions of a project will be 
processed.

 Figure 10.1: Process Selection dialog
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Table 10.1 explains the various components of this dialog:

To process a project session, perform the following steps:

1. Display the Process Selection dialog.

2. Select a project session(s) to process.

3. Click on Begin.

A progress dialog will be displayed.

 Table 10.1: Process Selection Dialog description

Name Meaning

Available Sessions Displays the sessions contained in the project.

Transfer Buttons Moves sessions from Available Sessions to/from Sessions to Process.

Sessions to Process Selects project sessions from Available Sessions to process.

Processing Mode Choose between submeter, decimeter and CM processing.
• Submeter will provide an accuracy to less than a meter and 

requires approximately half the time of decimeter, processing
• Decimeter provides an optimum accuracy of 0.1 meters but 

requires approximately twice the time of  submeter processing.
• CM Processor will provide precision accuracy for point features 

collected over 30 minutes.
• Choose whether or not to apply the 2-Sigma accuracy filter. For 

point features, this filter will eliminate bad data points that are far 
away from the average of all the data points that make up the 
point feature. This filter could improve the accuracy of point 
features collected in poor environments, such as heavy tree 
canopy.

Begin Starts processing of selected sessions(s).

Close Closes Process Selection dialog without processing the selected ses-
sion.

Help Provides help on the Process Selection dialog.

 Figure 10.2: Processing Progress dialog
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Table 10.2 explains the various components of this dialog:

4. Should Reliance Processor encounter points which it can not process, a 
warning message will be displayed indicating the presence of unprocessed 
points (refer to “Filtering By Attribute Values” on page 105).

5. Once all sessions have been processed, the Process Selection dialog w
displayed.

Sessions that have been processed will have a “*” after their name. User is prompted to save 
processed features when closing the project.

 Table 10.2: Processing Progress dialog

Name Meaning

Currently Processing Indicates the project session that is currently being processed.

Time Remaining Indicates the approximate time remaining to process the project 
session(s).

Elapsed Time Indicates the total time elapsed since the start of processing the 
project session(s).

Cancel Clicking this button while actively processing a session will stop 
all processing and the Process Selection dialog will be displayed.
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Viewing and Editing Processed Data

The difference between processed data and unprocessed data is the positions of the 
features in the processed data are much more accurate. Filters and other settings will 
be applied the same regardless of position accuracy.

For example, viewing the Feature Information dialog for one of the point features will 
display an estimated position accuracy number after processing.

Prior to processing, position accuracies are labeled “Unprocessed”. For point features that are 
successfully CM processed, a “CM processed” flag will appear under the Precision value.

Exporting Processed Data

Just as with Viewing and Editing processed data, exporting processed data operates 
exactly as unprocessed data except for the accuracy of the feature locations. You 
should process data prior to exporting it because the positions are much more 
accurate; however, nothing in Reliance Processor prevents exporting unprocessed 
data.

 Figure 10.3: Feature Information dialog with accuracies
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Data Exportation makes Reliance a flexible and powerful Feature Asset Management tool. 
Combined with the Project Data Filter, Reliance can export data into many popular GIS 
and general file formats. This chapter explains how to make Reliance work together with 
your GIS package.

Exporting Data

The Export Data dialog is the standard File Save As dialog box, Figure 11.1. It allows you 
to select an export format from a list to export data to a specified directory. For each 
export file, the program also produces an INF file which contains the project name, 
current map system, unit, display, and other important information about the exported 
data. You can refer to the INF file to ensure that all the parameters are set correctly.

 Figure 11.1: Export Data dialog
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Table 11.1 explains the various components of this dialog:

Before exporting your gathered data, perform filtering to ensure that only the desired 
data is exported. Refer to Chapter 9, Filtering Collected Data.

Access the Export Data Types dialog by clicking Options on Export Data dialog box.

The Export Data Types dialog allows you to choose which feature types(s) to export.

 Table 11.1: Export Data dialog

Name Function

Save In Determines which drive and directory the exported file will be saved.

File Name Type the name of the export file. The program will create file names with 
certain extensions required by format specification.

Save as type listbox A list of export formats available with proper extensions.

Buttons
• Save

• Cancel

• Help
• Options...
• Template Setup

• Select Save to retrieve the selected export file name, begin the export 
process, and exit the Export Data dialog. If the selected file already 
exists, the program will display an overwrite message.

• Select Cancel to cancel the export process, and exit the Export Data 
dialog.

• Provides help on the Export Data dialog
• Displays the Export Data Types dialog.
• Only available for User Defined ASCII (refer to “User Defined 

ASCII Files” on page 116.

Individual Feature Files

• Create New
• Append
• Overwrite

Only available for User Defined ASCII and Map Info export types. This 
setting applies when you export features to individual file names which 
already exist in the export directory.
• Creates a new file name if a duplicate file name is found.
• Adds newly exported features to existing files with the same name.
• Overwrites the existing duplicate file with the new one.

 Figure 11.2: Export Data Types dialog
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Available Export Formats

The following is a list of the available export formats that may be selected in the Save 
File As Type listbox:

• User Defined ASCII. The file extension is user-defined, but the default is .UDA.
• Shape file format with the extension .SHP. The program also creates two 

additional files with the extensions .SHX and .DBF.
• Generate file format with the extension .GEN. The program also creates a .DBF 

file.
• AutoCAD 12 (or newer) Text file format with the extension .DXF.
• AutoCAD 12 (or newer) Binary file format with the extension .DXF.
• Intergraph file format with the extension .ASC.
• MapInfo file format with the extension .MIF the program also creates a .MID.
• Comma Delimited file (this format is no longer available—to customize an

export file in a comma delimited format, refer to “User Defined ASCII Files
on page 116).

For Shape, Generate, and MapInfo export formats, a separate file is created for each feature 
exported. For User Defined ASCII, you have the option to create either one file with all features, or 
one file per feature exported.

Export File Format Descriptions

This section describes each of the Export File Formats.

Information File

The Information File (.INF file) lists the Map System and units information for the 
positions exported. This file is created with any other exported file format. An 
example .INF file header format is shown in Table 11.2.

 Table 11.2: Information File Format

Component Data

Project Name c:\Reliance\data\day008.prj

Date 2/28/96

Map System State Plane Coordinate 1983

Zone California (Zone 3)

Datum North American 1983

Display Geographic

Height Datum Height above ellipsoid
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At the bottom of the .INF file, the columns of data are identified for each feature 
exported for the particular export format selected. If more than one file is created 
during export, then a list of filenames is shown at the end of the file.

The Information file is always generated regardless of the export file type selected.

User Defined ASCII Files

Reliance provides the user the ability to customize ASCII files. The following 
procedure describes how to customize an ASCII export file.

Customizing an ASCII Export File

1. Once the project file is open, click on Export Data in the Project Control 
dialog.

Horizontal Unit Meter

Vertical Unit Meter

Angular Unit Degree

Standard Deviation Unit Meter

Processing Mode submeter

2-Sigma Filter Off

 Table 11.2: Information File Format (continued)

Component Data
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2. Click Template Setup to open the User ASCII Template.

Table 11.3 describes the components of this dialog.

3. Create a new or modify an existing ASCII template with the appropriate 
Output File option.

 Figure 11.3: User ASCII Template Dialog

 Table 11.3: User ASCII Template Dialog

Component Description

Template Listbox Provides a list of all default and previously saved ASCII export 
file templates

Template List Buttons
• New

• Delete
• Modify

• Creates a new template with a name and opens the User 
Defined Format dialog.

• Deletes the selected template
• Opens the Defined Format dialog for the selected template

Output File Options
• All Feature/File

• One Feature/File

• All features exported will be stored in one file with the same 
name as you gave the .INF file.

• One file will be created for each feature exported. The names 
of these files will be based on each feature name exported.

Output Ext Allows user to define extension of output file

Template Viewing Provides list of fields for selected template in Template listbox

Buttons
• OK

• Cancel
• Help

• Uses the template selected by user for export file format and 
closes dialog.

• Does not use selected template and closes dialog.
• Opens the help dialog for the User ASCII Template dialog
rtation 117
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User Defined Format

When the user clicks New or Modify in the User ASCII Template dialog, Reliance 
displays the User Defined Format dialog.

Clicking New allows you to name a new template while clicking Modify allows you to modify an 
existing template listed in the Templates List.

This dialog is used to define the fields and structure of the ASCII export file. Table 
11.4 describes the components of this dialog.

 Figure 11.4: User Defined Format dialog

 Table 11.4: User Defined Format dialog

Component Description

Field Selection

Field Selection List Provides a list of available fields (refer to Table 11.5 for 
a description of the available field names)
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Decml. Place Indicates accuracy (number of places after decimal). 
Active only for the following fields:
• Northing
• Easting
• Latitude
• Longitude
• Height
• Precision (Std Devs)
• Length (Line)
• Area (Area)
• Perimeter (Area)

Quadrant Indicates either N/S and E/W, or +/-. Available only for 
Latitude and Longitude fields.

Format Provides format for date and time field. Available 
formats are indicated in listbox.

Text Entry Available only for Text: field. Limited to 120 characters.

Export File Template

Buttons
• Enter

• Delete
• Clear All

• Enters highlighted field from Field Selection and 
places in template at current cursor position. 
Double-click on a field to highlight it.

• Deletes highlighted fields in template.
• Deletes all fields in template.

Field Structure Provides a real-time structure of the ASCII template 
which will reflect modifications through the use of the 
Enter, Delete, and Clear All buttons.

Field Delimiters

Field Indicates choice of delimiters between each field 
(comma, semicolon, or vertical bar).

Text Indicates choice of delimiters between text (single 
quotes, double quotes, or none)

 Table 11.4: User Defined Format dialog (continued)

Component Description
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Buttons

• OK

• Cancel

• Save As

• Preview

• Help

• Checks template to ensure position type matches 
Map System settings. Once it determines the 
template is ok, saves template settings and closes 
dialog.

• Closes dialog without saving template 
modifications.

• Checks template to ensure position type matches 
Map System settings. Once it determines the 
template is ok, saves template modifications to 
another template name.

• Shows a preview of the field structure for the 
selected template with simulated data (refer to 
Figure 11.5)

• Displays help for User Defined Format dialog.

 Table 11.5: User Defined Format Field List

Name Description

Begin File Header Allows you to provide a header of information for the exported file. 

End File Header You must select this whenever you enter a "Begin File Header" to 
indicate the end of the information in the file header. Note that a new 
line will be created when entering this selection.

Begin Feature Header Allows you to provide a header of information for each feature in the 
file that is exported.

End Feature Header You must select this whenever you enter a "Begin Feature Header"
to indicate the end of the information in the feature header. Note that 
a new line will be created when entering this selection.

New Line Allows you to separate the exported data fields by lines.

Feature ID Indicates a unique feature ID for each feature exported.

Feature Name Shows the feature name.

Attribute Name Shows the attribute names specified for the feature.

Attribute Value Shows the attribute values entered for the feature.

Latitude Indicates the latitude of the feature in either D.d, DM.m, or DMS.s 
formats. This is only available for Geographic Map System displays.

Longitude Indicates the longitude of the feature in either D.d, DM.m, or DMS.s 
formats. This is only available for Geographic Map System displays.

Northing Indicates the north coordinate of the feature. This is only available 
for Grid Map System displays.

Easting Indicates the east coordinate of the feature. This is only available for 
Grid Map System displays.

 Table 11.4: User Defined Format dialog (continued)

Component Description
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Height Indicates the height (either HAE or MSL) of the feature.

Precision (Std Devs) Shows the precision, in standard deviation, of the positions that were 
processed. This will always show three values - one for each 
position coordinate. A string called "Unprocessed" will be shown for 
these three fields if the data has not been processed yet.

Date and Time Indicates the date and/or time the feature was collected. Note that 
you can have date and time field separated (by a comma, semi-
colon, or vertical bar) by choosing this selection twice - once for the 
date and once for the time.

Text Indicates a custom text entry, which you can enter up to 120 
characters. Note that even a space (" ") is a valid text entry.

Length The length in meters. This is only available for line features.

Area The area value in square meters. This is only available for area 
features.

Perimeter The perimeter value in meters. This is only available for area 
features.

Full Sensor Data Contains the interpolated time tag, interpolated position, and the 
string of data collected from the external sensor for when the feature 
was collected.

Position Count Indicates the number of positions that were recorded when the 
feature was collected.

Process Mode Indicates the processing mode that was used to process the data - 
sub-meter, decimeter, or CM processed.

Max PDOP The maximum PDOP value that occurred during the time the feature 
was collected. (Typical good PDOP values should be from 2 to 4.)

Min Satellites The minimum number of GPS satellites that were tracked during the 
time the feature was collected.

GPS Day of Year The day of year that the feature was collected.

GPS Week The week number when the feature was collected.

GPS Seconds of Week The number of seconds in the week, starting from Saturday at 
midnight, when the feature was collected.

 Table 11.5: User Defined Format Field List (continued)

Name Description
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Figure 11.5 shows the User Defined Format dialog with a preview of the ASCII 
export file containing simulated data.

4. Modify the field selection, field template structure, and field delimiters of 
the User Defined ASCII export file.

5. Click Save As in the User Defined Format dialog to save the template.

6. Click OK in the User ASCII Template dialog to use selected template and 
close dialog.

7. Click Save in Export Data dialog to export data in User Defined ASCII 
export file.

Shape File

The Shape file format selection supports users of ArcView. The Shape files consist of 
a main file, an index file, and a dBASE table. The main file is a direct access, 
variable-record-length file in which each record describes a shape with a list of its 
vertices. In the index file, each record contains the offsets of the corresponding main 
file record from the beginning of the main file. The dBASE table contains feature 
attributes with one record per feature.

 Figure 11.5: User Defined Format dialog with Preview
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The main file, the index file, and the dBASE table have the same prefix. The suffix 
for the main file is “.SHP.” The suffix for the index file is “.SHX.” The suffix for the 
dBASE table is “.DBF.”

Generate File

The Generate file format selection supports users of ArcInfo. The main file with 
extension “.GEN” contains feature’s coordinates. For point features, each record 
begins with a feature index, followed by a comma, and a coordinate. For line and
features, each record begins with a feature index on a separated line, followed b
series of coordinates which defines the line, or area feature. Each component of
coordinate is separated by a comma. An “END” statement signifies the end of th
record

The dBASE table with an extension “.DBF” contains feature height and attributes with
one record per feature.

AutoCAD File Format

AutoCAD files (both binary and ASCII) can be selected which support AutoCAD 
One file is ASCII while the other is binary. The DXF files are standard ASCII text files
with an extension “.DXF” and specially formatted text. They can easily be translate
to the formats of other CAD system. The overall organization of a DXF file contains 
the following sections:

1. Header contains general information about the drawing. 

2. Tables contains definitions of named items.

3. Blocks contains Block definition entities describing the entities that make
each Block in the drawing.

4. Entities contains the drawing entities: Line, Point, or Text.

• The Line section contains the coordinates for the start point, and en
point.

• The Point section contains the coordinate of the point.
• The Text section contains information of attribute such as attribute 

value, and insertion point.

5. End of File

Many GIS programs do not recognize geographic coordinates in a DXF file. Select SPC-83 or a 
similar Grid System (in Map System) before exporting.

Intergraph File Format

The Intergraph file (.ASC) contains records of feature information separated by a
blank line. Each record begins with the feature name followed by attribute values
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the feature’s coordinates. Each field is listed on a separated line. Point features 
have one coordinate values. Line, and Area features will have at least two coord
values. Each component of the coordinate is separated by a comma. Table 11.6
displays the Intergraph File format:

MapInfo File Format

Selecting MapInfo creates files which can be directly imported into any MapInfo 
application. The set of MapInfo files for each feature exported consists of the 
following:

The Main and Attribute files have the same name. One set of files is created for 
feature exported.

 Table 11.6: Format for Intergraph File

Point Feature Line Feature Area Feature

Feature_name Feature_name Feature_name

Attribute_value_1 Attribute_value_1 Attribute_value_1

Attribute_value_2 Attribute_value_2 Attribute_value_2

.... .... ....

Attribute_value_n Attribute_value_n Attribute_value_n

X1,Y1,Z1 X1,Y1,Z1 X1,Y1,Z1

X2,Y2,Z2 X2,Y2,Z2

.... ....

Xn,Yn,Zn Xn,Yn,Zn

X1,Y1,Z1

 Table 11.7: MapInfo File Format

File Extension Contents

Main file .mif Position information

Attribute file .mid Feature attributes
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The Effects of Filter and Hiding on 
Exportation

If a feature is blocked by the filter or hidden (it is not displayed in the Map View), 
then it will not be exported to the target file. It is important to set the filter to show 
only the features you want to export prior to beginning the export process. For more 
information on filtering, refer to Chapter 9, Filtering Collected Data.

Exportation of Processed Versus 
Unprocessed Data

The only difference between exporting processed and unprocessed data is that the file 
exported with the unprocessed data contains less accurate points than the processed 
data. Reliance does not require processing prior to exporting.

Using Exported Data

This section provides examples of how the various export file formats may be used in 
several GIS packages.

Using User Defined ASCII Files

User defined ASCII files are created so that you can customize the table of 
information that you want to import into your GIS software package.

The file can even be loaded into Microsoft Excel so that further modifications and data analysis 
can be done.

Using Shape Files in ArcView

Before exporting a Shape File, perform filtering to ensure that only the desired points, 
lines, or area features are exported.

The basic steps to using a Shape File in ArcView involves the following:

• Creating a new project
• Create a view
• Add a theme

1. Start ArcView.
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2. Create a project. From the File menu, choose New Project. A project called 
Untitled is created and a Project window is opened. 

3. Create a view. From the Project window, click to highlight Views and click 
New. A view window called View1 is created.

4. Add a new theme. From the View menu, select Add Theme. The Add 
Theme dialog box appears that automatically looks for the Shape File in 
your current working directory.

5. Go to the directory that contains your exported Shape File. Select the 
exported Shape File and click OK.

6. To view the feature, click on the box to the left of the feature file name.

At this point, you can add additional themes, query, or print your ArcView project. 
Refer to your ArcView Reference manuals for more details on working with 
ArcView.

Using Generate Files in PC Arc/Info

Before exporting a Generate File, perform filtering to ensure that only the desired 
points, lines, or area features are exported.

The basic steps to using a Generate File in an Arc/Info package involves the 
following:

• Creating a coverage
• Clean and build the coverage
• Create a relate item to physically merge the database file with the feature 

attribute table

The example below is for an exported points feature file called EXAMPLE.GEN. The 
Generate format in Reliance creates the following files: EXAMPLE.GEN, 
EXAMPLE.DBF, and EXAMPLE.INF.

The commands to type at the Arc/Info prompts are in bold letters.

1. Start Arc/Info.

2. Create a coverage using the GENERATE program in Arc/Info.

Arc>  GENERATE EXAMPLE 
Generate>  INPUT EXAMPLE.GEN

Generate>  POINTS

Generate>  QUIT

3. Clean and build the coverage.
Arc>  CLEAN EXAMPLE

Arc>  BUILD EXAMPLE POINTS
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4. Create a relate item value to match an item in the feature attribute table.

Arc>  TABLES

Enter Command:  SELECT EXAMPLE.PAT 

Enter Command:  ADDITEM 

Item Name: RECORDID

Item Width:  5

Item Type:  N

Decimal places: 0

Start Item (default=last item): <ENTER>

Item Name: <ENTER>  

Enter Command:  CALCULATE RECORDID = EXAMPLE_ID

Enter Command:  QUIT

5. Use the JOINITEM command to physically merge the database file with 
the feature attribute table. Use the RECORDID as the shared item to relate 
the two files.
Arc>  JOINITEM EXAMPLE.PAT EXAMPLE EXAMPLE.PAT RECORDID RECORDID 

At this point, you may want to verify that the spatial data has been converted. You 
may do this by using several of the graphic programs within Arc/Info. Refer to your 
Arc/Info Reference manuals for more details on using Arc/Info.

Using Intergraph Files in Intergraph’s MGE ASCII 
Loader (MGAL)

The Intergraph File (.ASC) can be imported using Intergraph’s MGE ASCII Load
(MGAL). MGAL will read GPS data and generate graphics in a design file, in 
addition to adding graphic attributes to the database. MGAL will also generate 
necessary database linkages from the attributes to the graphics producing a fully
capable map.

Before running MGAL, check to make sure there is a working MGE project. Som
the basic steps involved in creating a MGE Project are:

• Create a Database (such as creating a new Oracle user).
• Generate a RIS Schema (using the new Oracle user).
• Create a Project (using MGE).
• Build the Project Schema into the database (using MGE).

1. Before running MGAL, check to make sure that the features that are to 
loaded already exist in the feature table. Feature tables may be created
existing tables may be edited using Feature/Schema Builder. Use the 
Feature/Schema Builder to make sure the tables and columns that will ho
the attribution exist in the database.
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2. Start MGAL. From Modular GIS Environment menu, select Tools and 
then MGE ASCII Loader. The MGE ASCII Loader Tools menu will now 
appear. To load graphics and attribute data into the system, select Feature 
Loader. The Feature Loader form now appears.

The Feature Loader form is divided into 5 sections:

• Project- The project name is pre-defined based on what MGE 
project the user is in when MGAL is executed.

• Input ASCII File - This is the file that contains the GPS 
coordinates and attribute data.

• Output Design File - This file will contain the graphic elements 
once MGAL is run. 

If a new design file is being created and the GPS data contains 3D data, it is important that the user 
select the proper 3D seed file.

• Setup File—If the Define button is selected, you may specify 
parameters such as what lines of the file are to be loaded, the 
coordinate system, and what Record Format Files are to be use

Record Format Files - If the Define button is selected, the Record 
Format Definition form appears. On this form, the user selects a
feature and provides format information by selecting Record 
Information. A Record Format File must be generated for each 
feature that is to be loaded.

Record Information - On this form, the user provides the sta
and end column for the easting, northing, elevation, and 
attribute data found in the ASCII file. The Attribute 
Information button allows the user to define what database 
columns are to be loaded and the position of the attribute da
in the ASCII file. The Coordinate Information button allows 
the user to specify which line in the ASCII file contains the 
coordinate information.

Back on the Setup File Definition form, the user should use the 
Select button under Record Format Files to make sure that each
feature that is to be loaded has been selected.

• Loading Options—A datapoint in the Load Attributes from ASCII
File box will enable MGAL to load attribute information in the 
ASCII file into the database.

3. Once all of the parameters have been selected, click the OK button to 
execute MGAL. Use the Process List (selected from the Modular GIS 
Environment form) to monitor the execution of MGAL.
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At this point, you may want to use one of the graphics program within Intergraph to 
view the imported data. Refer to your Intergraph Reference manuals for more details 
on using MGAL.

Using DXF Files in FieldNotes

Most CAD software packages are able to import DXF Files easily. The following 
example shows how to export a DXF file format into FieldNotes, a Windows 
geographic information system (GIS) and AM/FM (mapping and CAD) package.

1. Start FieldNotes.

2. Import the DXF file. From the File menu, select Open Drawing. A Load 
Drawing File dialog appears that automatically looks for the DXF files in 
your current working directory.

3. Go to the directory that contains your exported DXF file. Select the DXF file 
and click OK.

Refer to your CAD Software Reference manuals for more details on importing DXF 
files.

Using  Files in MapInfo

The basic steps for using MapInfo involves the following:

• Importing files
• Creating a workspace
• Adding feature layers

Start MapInfo and to Cancel Quick Start

1. Import files.  From the Table menu, choose Import.  Go the directory that 
contains your exported MapInfo(.MIF and .MID) files.  Select the .MIF fil
to be imported and click Import.  A .TAB (MapInfo file)  with the same file 
name as the .MIF file is created.  Click OK at the Import into Tables dialog 
box. Repeat these steps for all features to be viewed in this workspace.

2. Create a workspace.  From the Window menu, select New Map Window.  
Choose a feature from the Map Tables drop down menu and click OK to 
open the workspace.

3. Add features to workspace. From the Map menu, select Layer Control. 
After the Layer Control dialog box appears, click Add. Choose the feature to
add to the workspace and click Add. Repeat for all features to be added to 
this workspace.
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This chapter explains how to set up a Reliance project in preparation for batch processing.

Creating a Batch Project

Perform the following steps to create a new Batch project.

Preferences

1. If you are going to download rover files from your receiver, perform the 
following:

a. Select Settings under the Tools drop-down menu. The Global Settings 
dialog appears.

b. On the Reliance settings tab, ensure the correct baud rate and COM port are 
set.

2. If you wish to download base files from the CORS sites on the Internet, perform 
the following:

 Figure 12.1: Global Settings dialog
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a. Select Settings under the Tools drop-down menu.

b. The Global Settings dialog is displayed (refer to Figure 12.1).

c. Click on the Internet Setting tab and choose the appropriate Internet 
access connection.

d. “Local Area Network” should be selected when your Internet 
connection has already been established. You must do this for Inter
access accounts that have proprietary dialing programs, such as 
America Online (AOL).

e. “Modem” should be selected if an Internet connection has not yet b
established and your Internet service provider uses a standard Wind
dialing program, such as Internet Explorer (IE4).

f. Click OK to close dialog.

3. Select Batch Wizard... from the Project drop-down menu to create a new 
batch project:

 Figure 12.2: Internet Access Dialog
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4. Select a drive and a directory for the project file and enter a name for the 
project file in the Name field.

Batch project files have a “.BRJ” extension.

5. Click Save to create the Batch Project File.

 Figure 12.3: Create a New Batch Project
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Batch Wizard

Reliance displays the Batch Wizard which will guide you through the steps necessary 
to create a “Batch” project.

6. Click Next to continue.

 Figure 12.4: Batch Project Setup Dialog
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Reliance displays the Session Settings dialog.

An initial session titled “Session 1” appears in the “Session List” list box a
also in the “Selected” edit box. Additional sessions are created by clickin
New. This adds a new entry in to the “Sessions” list box titled 
“UnNamed001”.

Selected Session Definition

7. If you wish to download the rover files from your receiver, click on the 
Download Rover Data check box.

This will inactivate the file name text box.

If you download a rover file from your receiver, perform the following ste
(otherwise continue with the next step).

a. With the Download Rover Data checkbox checked, click on Next.

 Figure 12.5: Session Settings Dialog
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b. The Receiver File Selection dialog is displayed.

c. You can select files using four different methods:

d. Once you have selected the appropriate File Selection parameters 
continue with the next step.

8. If you wish to select a rover file which already has been downloaded to a 
local drive, browse and select the appropriate file.

9. If you want Reliance to Auto Search a Base file, click on the Auto Search 
Base check box.

 Figure 12.6: Receiver File Selection Dialog

 Table 12.1: Receiver File Selection Methods

Method Description

All Files All rover files would be downloaded

Date/Time Last 12 hours Last 24 hours Specify Time Frame

Name Rover files with specified name would be downloaded

Date/Time & Name Rover files with specified name and within time frame would be downloaded
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Reliance searches for a Base File automatically by looking in all directories specified 
in the Base File Path section of the Directories dialog.

This will inactivate the file name text box.

10. If you wish to select a Base file which already exists on a local drive, browse 
and select the appropriate file. 

11. If you do not know the coordinates of the base station, check the Use 
Averaged Base Position checkbox. The Base Station Position fields will be 
inactive.

You should always attempt to use the exact base station coordinates. If you must use the averaged 
base position, the processing precision will not be guaranteed.

Base Station Position

12. If you know the Base Station Position, enter the appropriate coordinates.

Reliance defaults to a Map system of WGS84. If you need to change the system before entering base 
position, click Next to display the Map System dialog. 

If you are getting base data from a CORS site automatically, the base station position will be filled in 
by Reliance.
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13. If you want to display a different Map System, click on Next until the Map 
System dialog is displayed.

14. Choose the appropriate Map System parameters.

If you had to display a different Map System on the Session Settings Dialog, changing the Map 
System on this dialog will automatically change the Base Position Parameters on the Session Settings 
Dialog. 

15. Ensure the appropriate Base Station Position parameters have been entered 
on the Session Setting dialog.

16. Click Next.

 Figure 12.7: Map System Dialog
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17. The Directories dialog is displayed.

18. If you selected to download Rover Files from your receiver, the “Rover F
Dir” indicates where the files will be saved on your local drive.

19. If you select to auto search Base Files, the “Base File Path” indicates th
directories where Reliance will search for the Base Files

20. If you want to search for Base Files from the Internet CORS sites, you m
add “,FTP://CORS” to the Base File path.

If you have selected a specific rover and base file in the Session Setting dialog, the directories 
displayed in the Directories dialog have no relevance.

21. Click Next.

 Figure 12.8: Directories Dialog
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22. The Processing Mode and Export Format dialog is displayed.

23. If you wish to process the data, choose the appropriate Data Process Settings

 Figure 12.9: Processing Mode and Export Format Dialog
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24. If you wish to export the data, check the Export Data check box. The Export 
Settings dialog appears.

25. Click Next.

 Figure 12.10: Export Settings dialog
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26. The Run Batch Project is displayed.

27. If you wish to run the batch project at a later time, uncheck the Run the 
Batch Project checkbox.

28. Click Finish.

 Figure 12.11: Run Batch Project Dialog
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29. The Save Batch Project as a Reliance project is displayed.

30. Enter a name in the file name textbox.

31. Click Save.

32. You have successfully completed generating the batch project file and your 
project will immediately run if you checked the Run Batch Project. If you 
did not check this box, you can run this project later by selecting it under 
Open Project.

After the batch project has been run, both the Time View and Map View windows will be displayed.

 Figure 12.12: Run the Batch Project dialog
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The Map System dialog allows you to select the map system, the zone (or datum for the 
Geographic system), display mode, and units to be used in the current project. When a 
map system is selected, the list of zones is updated accordingly to show all the zones for 
the selected system. If the selected system is Geographic, then the list of datums is 
displayed instead. The Geographic system does not have zones. The initial data for the 
Map System dialog is read from a setup file (MAPDATA.TXT), and all the changes made 
are saved to that file.

Map System Dialog

To get to the Map System dialog, press the Project Setup icon located in either the Project 
Control dialog or the Reliance Processor main window toolbar. 

Click the Map System tab to get the Map System setup dialog.

 Figure 13.1: Map System dialog
 a Map System 145



146
Table 13.1 describes the components of this dialog.

 Table 13.1: Map System dialog

Name Function

Type The type of the selected system. There are three possible system types:
• Geographic-This system does not have zones, datum is selected 

instead. Also, the Display Mode is limited to Geographic only.
• User Defined-A map system defined by you, or supplied with the 

program, that can be modified, including defining new zones, and 
changing the existing ones.

• Predefined-A predefined map system based on the Universal 
Transverse Mercator System. The zone information for that system 
can’t be modified, except the local transformation.

System A list of systems to be selected. At the bottom of this list is the “< Create 
New >” item which allows you to create a new system by invoking the 
Create System dialog. If the selected system is Geographic, the Zone 
selection box changes to Datum selection box. For all other systems, the 
Zone list box contains the zones defined for the selected system.
• Edit...-Refer to “Edit System” on page 147.

Zone/Datum Depending on the selected system, a list of zones or datums to be selected. 
At the bottom of this list, except for the systems of type Predefined, is the 
“< Create New >” item which allows you to create a new zone or datum.
• Edit...-Refer to “Edit Zone” on page 148 for information about 

editing a zone. Refer to “Edit Datum” on page 153 for information 
about editing a datum.

Display Display Mode represents the format that the coordinates are displayed and 
exported. If the current system is of a Geographic type, the only valid 
option is Geographic. Otherwise, valid options are Geographic, Standard 
Grid, or Local Grid.

Height Datum Choose between Height Above Ellipsoid (HAE) and Mean Sea Level 
(MSL) for computing altitudes of positions. Since MSL is computed 
automatically using a worldwide model (GEOID96 for North America 
and 0SU91 for any other point on the earth), its absolute accuracies are not 
as well known as HAE. MSL Height Accuracy Estimates will always be 
displayed as N/A.
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Edit System

Click Edit (same line as “System”) to bring up the Edit System dialog that allows 
to edit the parameters of the selected system.

Unit
• Horizontal

• Vertical

• Angular

• A list of horizontal units which includes Meters, Kilometers, 
International Feet, US Survey Feet, Yard, US Yard, Miles, Nautical 
Miles, International Nautical Miles, Centimeters, and Inches. It is 
advised not to select the Centimeter or Inch units unless the area your 
field data cover is very small.

• A list of vertical units which includes Meters, Kilometers, 
International Feet, and US Survey Feet, Yard, US Yard, Miles, 
Nautical Miles, International Nautical Miles, Centimeters, and 
Inches. It is advised not to select the Centimeter or Inch units unless 
the area your field data cover is very small.

• A list of angular units which includes Degrees, Radians, and 
Gradients.

OK Saves changes and closes dialog.

Cancel Closes dialog without saving changes.

Help Displays on-line Help.

 Figure 13.2: Edit System dialog

 Table 13.1: Map System dialog (continued)

Name Function
 a Map System 147
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Table 13.2 describes the components of this dialog.

Edit Zone

Click Edit (same line as “Zone”) to bring up the Edit Zone dialog that allows you 
edit the parameters of the selected zone.

 Table 13.2: Edit System dialog

Name Function

System Type The type of map system currently selected. 

System Name The name of the current map system, up to 30 characters longs.

Description A space provided to allow you to describe the map system.

OK Saves changes and closes dialog.

Cancel Closes dialog without saving changes.

Help Displays on-line Help.

 Figure 13.3: Edit Zone dialog
Reliance Office User’s Guide



Setting Up

Setting U
p a M

ap System
Table 13.3 describes the components of this dialog.

 Table 13.3: Edit Zone dialog

Name Function

Name A 30-character name of the zone to be edited.

Datum

• Edit

A list of Datums to be selected. At the bottom of this list, except for the 
systems of type Predefined, is the “<Create New>” item which allows you 
to create a new Datum.
• Select to bring up the Edit Datum dialog that allows you to modify 

the parameters of the selected datum (refer to “Edit Datum” on 
page 153). The datum parameters are with respect to the WGS-84 
System.

Projection

• Type

Set of projection parameters for the selected zone. The number and the 
type of those parameters depends on the projection type. The panel is 
updated each time the new projection is selected. Each projection 
parameter is an edit box.
• A list of projections available for selection. Only four projections are 

supported. Refer to “Projection Types” on page 150 for more 
information.

Local
• Edit/Create

A list of local transformations available for the currently selected zone
• Select to bring up the Edit/Create Transformation dialog (refer to 

“Edit Transformation” on page 156) that allows you to modify/create 
the parameters of the selected local transformation.

OK Select to exit and save changes.

Cancel Select to exit and cancel changes.

Help Select to bring up the Help menu.
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Projection Types

The following projection types are available:

• Transverse Mercator
• Lambert Conformal Conic
• Oblique Mercator
• Stereographic

Figure 13.4 is the Edit Zone dialog with the Transverse Mercator Projection sele

Table 13.4 describes the components of the Transverse Mercator Projection:

 Figure 13.4: Edit Zone dialog with Transverse Mercator Projection selected

 Table 13.4: Transverse Mercator Projection

Name Function

Lat Origin The Latitude of the origin of the projection in degrees, minutes, and seconds.

Lon Origin The Longitude of the origin of the projection in degrees, minutes, and seconds.

False East The map grid east coordinates of the origin of the projection. Usually these are set 
to positive numbers so that negative grid coordinates are avoided over the 
coverage of the zone.

False North The map grid north coordinates of the origin of the projection. Usually these are 
set to positive numbers so that negative grid coordinates are avoided over the 
coverage of the zone.

Scale This is the scale factor on the central meridian.

C. Meridian The meridian (line of longitude) where the scale factor is defined.
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Table 13.5 describes the components of the Lambert Conformal Conic (refer to 
Figure 13.3 for the Edit Zone dialog with Lamber Conformal Conic Projection 
selected):

Figure 13.5 is the Edit Zone dialog with the Oblique Mercator Projection selected:

 Table 13.5: Lambert Conformal Conic

Name Function

Lat Origin The Latitude of the origin of the projection in degrees, minutes, and seconds.

Lon Origin The Longitude of the origin of the projection in degrees, minutes, and seconds.

False East The map grid east coordinates of the origin of the projection. Usually these are 
set to positive numbers so that negative grid coordinates are avoided over the 
coverage of the zone.

False North The map grid north coordinates of the origin of the projection. Usually these 
are set to positive numbers so that negative grid coordinates are avoided over 
the coverage of the zone.

North Lat The latitude of the northern parallel where the projection touches the earth.

South Lat The latitude of the southern parallel where the projection touches the earth.

 Figure 13.5: Edit Zone dialog with Oblique Mercator Projection selected
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Table 13.6 describes the components of the Oblique Mercator Projection selected:

Figure 13.6 is the Edit Zone dialog with the Stereographic Projection selected:

 Table 13.6: Oblique Mercator Projection

Name Function

Lat Origin The Latitude of the origin of the projection in degrees, minutes, and 
seconds.

Lon Origin The Longitude of the origin of the projection in degrees, minutes, and 
seconds.

False East The map grid east coordinates of the origin of the projection. Usually 
these are set to positive numbers so that negative grid coordinates are 
avoided over the coverage of the zone.

False North The map grid north coordinates of the origin of the projection. Usually 
these are set to positive numbers so that negative grid coordinates are 
avoided over the coverage of the zone.

Scale This is the scale factor on the central meridian.

ATan Azim  The arc tangent of the true north azimuth of the central meridian.

 Figure 13.6: Edit Zone dialog with Stereographic selected
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Table 13.7 describes the components of the Stereographic Projection selected:

Edit Datum

 Table 13.7: Stereographic Projection

Name Function

Lat Origin The Latitude of the origin of the projection in degrees, minutes, and 
seconds.

Lon Origin The Longitude of the origin of the projection in degrees, minutes, and 
seconds.

False East The map grid east coordinates of the origin of the projection. Usually 
these are set to positive numbers so that negative grid coordinates are 
avoided over the coverage of the zone.

False North The map grid north coordinates of the origin of the projection. Usually 
these are set to positive numbers so that negative grid coordinates are 
avoided over the coverage of the zone.

Scale This is the scale factor on the central meridian.

ATan Azim  The arc tangent of the true north azimuth of the central meridian.

 Figure 13.7: Edit Datum dialog
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Table 13.8 describes the components of this dialog.

 Table 13.8: Edit Datum dialog

Name Function

Name The 30-character name of the selected Datum.

DX, DY, 
DZ

Translation parameters: X, Y, and Z in floating point edit fields. DX is 
the translation along the x-axis. DY is the translation along the y-axis, 
and DZ is the translation along the z-axis. All translations are in meters 
and are with respect to the WGS-84 System.

RX, RY, RZ Rotation parameters: X, Y, and Z in floating point edit fields. RX is the 
rotation about the x-axis. RY is the rotation about the y-axis, and RZ is 
the rotation about the z-axis. All rotations are in seconds of arc and are 
with respect to the WGS-84 System.

X0, Y0, Z0 Centroid parameters: X0, Y0, and Z0 are used to define a common 
center between two coordinate system centers. These parameters are 
not always necessary.

Scale The floating point scale factor for the datum being edited or defined. 
This describes the scale difference in ppm between the datum and the 
WGS-84 System.

Spheroid

• Edit

A list of available spheroids. At the bottom is of this list is “< Create 
New >” item which allows you to define a new spheroid.
• Select to bring up the Edit Spheroid dialog allowing you to edit the 

selected spheroid or to define a new spheroid (refer to “Edit 
Spheroid” on page 155).

• You are allowed to enter the Semi Major Axis and Inverse 
Flattening values by default. The Semi Minor Axis is computed 
automatically. As you click on the Semi Minor Axis radio button, 
the Semi Minor Axis field becomes editable. Consequently, the 
Inverse Flattening becomes non-editable, and its value is computed 
automatically based on the values of Semi Major Axis and Semi 
Minor Axis, and vice versa.

OK Select to exit and save changes.

Cancel Select to exit and cancel changes.

Help Select to bring up the Help menu.
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Edit Spheroid

Table 13.9 describes the components of this dialog.

 Figure 13.8: Edit Spheroid dialog

 Table 13.9: Edit Spheroid dialog

Name Function

Name The name of the current spheroid.

Semi Major Axis (a) A floating point number representing the semi-major 
axis of the defined spheroid.

Semi Minor Axis (b) A floating point number representing the semi-minor 
axis of the defined ellipsoid. Click on the radio button 
to enter a value for the Semi Minor Axis.

Inverse Flattening A floating point number of the inverse flattening to 
represent the shape of the ellipsoid. Click on the radio 
button to enter a value for the Inverse Flattening.

OK Select to exit and save changes.

Cancel Select to exit and cancel changes.

Help Select to bring up the Help menu.
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Edit Transformation

Table 13.10 describes the components of this dialog.

 Figure 13.9: Transformation Dialog

 Table 13.10: Transformation Dialog

Name Function

Name A 30-character name of the local transformation.

DX, DY Translation parameters: X and Y in floating point 
edit fields. DX is the translation along the x-axis. 
DY is the translation along the y-axis. These 
translations are with respect to the origin of the 
projection zone you selected in the Edit Zone 
dialog.

RZ Rotation parameter:  Z in floating point edit fields. 
RZ is the rotation about the z-axis,which is in 
seconds of arc and is with respect to the point of 
origin of the Map Zone.

Scale This describes the scale difference in ppm between 
the zone and the local transformation being 
defined.

OK Select to exit and save changes.

Cancel Select to exit and cancel changes.

Help Select to bring up the Help menu.
Reliance Office User’s Guide



 14

T

ools
Tools
Tools

 up 
Reliance has a variety of utilities which help you manipulate files and establish settings. 
These tools include:

• Settings
• RINEX Convertor
• RINEX Interpolation
• Join Files
• Waypoint File Convertor
• Decompress GZ Files

Settings...

In the Tools pull-down menu of the Reliance main window, select Settings... to bring
the Global Settings dialog, which has two tabs – Reliance and Internet. 

 Figure 14.1: Global Settings dialog
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Reliance Settings

When you are automatically downloading data from your receiver into a Session, you 
should first make sure that the COM port and baud rate settings are set correctly in 
this Reliance settings dialog.  Refer to Chapter 5, Setting Up a Project.

You can also set to Open Most Recent Project On Startup, which allows you to 
quickly bring up the project that was most recently being worked on.

Internet Settings

Click on the Internet tab to show the Internet settings dialog.

You can choose that you have either a Local Area Network connection or a Modem 
connection to the Internet.

1. Local Area Network (LAN) should be selected when your Internet 
connection has already been established. You must do this for Internet 
access accounts that have proprietary dialing programs, such as America On 
Line (AOL).

2. Modem should be selected if an Internet connection has not yet been 
established and your Internet service provider uses a standard Windows 
dialing program, such as Internet Explorer version 4 (IE4). If Modem is 
selected, you can also choose which account to use along with the number of 
redials to be attempted in case of a poor first connection.

 Figure 14.2: Internet Settings dialog
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RINEX Converter

RINEX (Receiver INdependent EXchange) is a standard format for GPS, 
GLONASS, or GPS+GLONASS data supported throughout the industry.

The RINEX Converter utility provides a means to translate single or multiple 
RINEX formatted data files from any receiver to Ashtech formatted files, and, 
alternatively, convert Ashtech data files to RINEX format. RINEX Converter  
supports RINEX format version 2.01.

“Ashtech format” is our proprietary format for the data collected by our GPS 
receivers. This format is required in order to use the data in this application.

While you can convert any RINEX format file to an Ashtech format file, only RINE
files with Base Station data are useful for this application, since it is required tha
use an Ashtech GPS receiver for your Field data collection.

You may also convert any Ashtech format file to a RINEX format file, if desired.

Starting RINEX Converter

When RINEX Converter converts a RINEX file to Ashtech format, the conversion
produces four types of data:

Obs Observation data

Nav Navigation data

Nav G GLONASS navigation data if available 

Met Meteorological data

In addition, the observation data is separated into three files:

B-file GPS measurement data

E-file Ephemeris data

S-file Site information
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Select Rinex Converter in the Tools pull-down menu of the Reliance main window.

RINEX Converter opens the RINEX to Ashtech window,  Figure 14.3.      

Table 14.1 describes the fields in the RINEX to Ashtech window.

 Figure 14.3: RINEX-to-Ashtech Window

 Table 14.1: RINEX to Ashtech Fields 

Item Description

File Types Lists the files types: RINEX Observation (*.*O), All files (*.*). RINEX NAV-
file*.*N, RINEX Nav g-file*.*G, RINEX Met-file *.*M. To select a file type, click 
the arrow to the right of the field and select file type from the displayed list.

Available Files 
Listbox

List of files in current directory. To select a file, click on the file. To select multiple 
files for batch conversion, select the first file and then hold the Control key, while 
selecting additional files.

Obs This field lists the file name of the observation data file corresponding to the selected 
RINEX data file in the Available Files List box.

Nav This field lists the file name of the GPS navigation data file corresponding to the 
selected RINEX data file in the Available Files List box.

Navg This field lists the file name of the GLONASS navigation data file corresponding to 
the selected RINEX data file in the Available Files List box.

Met This field lists the file name of the Meteorological data file corresponding to the 
selected RINEX data file in the Available Files List box.
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Converting RINEX to Ashtech Format

RINEX data files from any GPS or GPS+GLONASS receiver can easily be converted 
to Ashtech format for post-processing.  The following procedure specifies how to  
convert RINEX data files to Ashtech format:

BEGIN Click this button to open the Conversion Status dialog and begin converting the 
RINEX files to Ashtech format. 

B-File This field lists the suggested file name for the output B-file (GPS measurement data).

E-File This field lists the suggested file name for the output E-file (ephemeris data).

S-File This field lists the suggested file name for the output S-file.(site information)

Input Dir Click this button to open the Set Input Directory dialog to specify the directory 
where source data files are stored. 

Input Directory This field displays the directory path where the source data files are stored. 

= Click this button to set the output directory the same as the input directory.

Output Dir Click this button to open the Set Output Directory dialog to specify the directory 
where converted files are stored. To minimize confusion, select a different directory 
than the source files directory for the output directory.

Output 
Directory

This field displays the directory path where converted data files are stored. 

Overwrite Files Select the overwrite privileges: Prompt for overwrite, Always overwrite, or Never 
overwrite. To select an overwrite privilege, click the arrow to the right of the field and 
select an overwrite privilege from the list presented.

GPS Check this box if GPS data will be used in conversion. This option is on by default.

GLONASS Check this box if GLONASS data will be used in conversion (on by default).

B-File Check this box to create a B-file when converting RINEX files.

E-File Check this box to create a E-file when converting RINEX files.

S-File Check this box to create a S-file when converting RINEX files.

Free Space This field displays the available disk drive space for the selected Output directory.

Exit Closes RINEX Converter.

About Displays software version number.

Help Opens on-line help system.

 Table 14.1: RINEX to Ashtech Fields  (Continued)

Item Description
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1. In the RINEX to Ashtech window,  click Input Dir to open the Select 
Input Directory dialog, Figure 14.4.      

2. At this point, you have to know where your RINEX files are located.  Using 
standard Windows file navigation procedure, select the directory where the 
files you wish to convert are located. 

3. Click OK to accept the directory and close the Set Input Directory dialog.

The Available Files listbox, similar to Figure 14.5,  lists the RINEX files, 
and the Input Directory field lists the directory path.      

 Figure 14.4: Select Input Directory Dialog

 Figure 14.5: Available Files List Box
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If you are converting RINEX files translated from a RINEX converter that does not use the standard 
RINEX naming format, the observation files may not have the format *.*O. If the files are not listed 
in the Available Files listbox, change the File Types to All Files on the Rinex to Ashtech tab and All 
Files in the Input Directory.

4. Select the file you wish to convert to Ashtech format. You can select 
multiple files by holding down the Control key while selecting files.

After selecting a file to convert, the OBS, NAV, NAV G, MET, B-File, E-
File, and S-File fields populate with suggested file names. If you selected 
multiple files, the filenames listed are associated with the file selected last. 

To avoid confusion, do not change the suggested file names. To restore the original suggested output 
file name, double-click the filename in the available files list box.

5. Click Output Dir to open the Select Output Directory dialog, Figure 14.6.   
  

6. Navigate through the directories and drives to select the directory where you 
want to store the converted files. 

To avoid confusion, save the converted Ashtech files to a different directory than where the RINEX 
files are located. 

7. Click OK to accept the directory and close the Set Output Directory dialog.   

 Figure 14.6: Select Output Directory Dialog
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The Output Directory field lists the directory path.

8. Select the Overwrite Files privileges by clicking the arrow to the right of 
the Overwrite Files field, and selecting a privilege from the list presented. 
There are three overwrite privileges:

• Prompt for Overwrite - (Default setting). If RINEX Converter detects
that a converted file has the same name as an existing file, that is, t
new file will overwrite the existing file, a dialog opens, asking if you 
wish to overwrite the existing file. If you click NO, then RINEX 
Converter skips the file, and continues to the next file.

• Always Overwrite - This option writes over existing files with a new 
file.

• Never Overwrite - This option does not convert data for a given file if 
file with the same name already exists.

9. By default, RINEX Converter assumes that the RINEX files use both GP
and GLONASS data; however,  if there is not a Nav g file, GLONASS da
will not be included in the B-file.

10. By default, RINEX Converter creates a B-file (raw data binary), an S-Fil
(receiver parameters), and an E-File (binary ephemeris),  in Ashtech form
If you do not want one or more of these file types created, uncheck the 
corresponding check boxes.
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11. Click BEGIN to convert the selected RINEX files to Ashtech format. The 
Conversion Status dialog opens (Figure 14.7). 

12. The Conversion Status dialog shows the status of each file as it converts. 
Upon completion, the box indicates 100% for each file, or 0 if a file were not 
converted for lack of data, e.g. GLONASS data, as noted above.  Click OK.

• Click Cancel to cancel the conversion to the current file type and 
proceed to the next file type.

• Click Cancel All to cancel the entire conversion.

13. A *.log file is created in the directory containing all conversion activity. 
When restarted,  RINEX converter overwrites the existing log file. To sa
the old log file, rename or move the file before restarting RINEX Convert

The selected RINEX files are now in Ashtech format and can be used with data 
from Ashtech receivers for post-processing. 

 Figure 14.7: Conversion Status Dialog
165



166
Converting Ashtech Files to RINEX Format

Ashtech files from any GPS or GPS+GLONASS receiver can easily be converted into 
RINEX format.  To convert Ashtech data files to RINEX format:

1. Select the Ashtech to RINEX tab in the RINEX main window, as shown in  
Figure 14.8.           

Table 14.2 describes the fields in the Ashtech to RINEX tab.        

 Figure 14.8: Ashtech to RINEX Tab

 Table 14.2: Ashtech to RINEX Tab Fields 

Item Description

File Types Lists the files types: Ashtech B-Files (B*.*), Ashtech E-file 
(E*.*), Ashtech S-file (S*.*) or All files (*.*). To select a files 
type, click the arrow to the right of the field and select file type 
from the list presented.

Available Files Listbox List of files in current directory. To select a file, click on the file. 
To select multiple files for batch conversion, select the first file 
and then hold the [Control] key, while selecting additional files.

Ashtech to RINEX tab
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B-File This field lists the file name of the B-File corresponding to the 

selected Ashtech data file in the Available Files List box.

E-File This field lists the file name of the E-File corresponding to the 
selected Ashtech data file in the Available Files List box.

S-File This field lists the file name of the S-File corresponding to the 
selected Ashtech data file in the Available Files List box.

BEGIN Button Click this button to open the Conversion Status dialog and begin 
converting the Ashtech files to RINEX file format. 

Obs This field lists the suggested file name for the converted 
Observation Data file.

Nav This field lists the suggested file name for the converted 
Navigation Data file.

Navg This field lists the suggested file name for the converted 
GLONASS Navigation Data file.

Met This field lists the suggested file name for the converted 
Meteorological Data file.

Input Dir Click this button to open the Set Input Directory dialog to 
specify the directory where source data files are stored. 

Input Directory This field displays the directory path where the source data files 
are stored. 

= Click this button to set the output directory the same as the input 
directory.

Output Dir Click this button to open the Set Output Directory dialog to 
specify the directory where converted files are stored. To 
minimize confusion, select a different directory than the source 
files directory for the output directory.

Output Directory This field displays the directory path where converted data files 
are stored. 

Overwrite Files Select the overwrite privileges: Prompt for overwrite, Always 
overwrite, or Never overwrite. To select an overwrite privilege, 
click the arrow to the right of the field and select an overwrite 
privilege from the list presented.

GPS Check this box if GPS data will be used in conversion. This option 
is on by default..

GLONASS Check this box if GLONASS data will be used in conversion (on 
by default)..

 Table 14.2: Ashtech to RINEX Tab Fields  (Continued)

Item Description
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2.  Click Input Dir to open the Set Input Directory dialog (Figure 14.9).

3. Navigate through the directories and drives to select the directory where the 
files you wish to convert are located. 

4. Click OK to accept the directory and close the Set Input Directory dialog.

Obs Check this box to create an Observation file when converting to 
RINEX.

Nav Check this box to create a Navigation file when converting to 
RINEX files.

Navg Check this box to create a GLONASS Navigation file when 
converting to RINEX.

Met Check this box to create a Meteorological file when converting to 
RINEX.

Free Space This field displays the available disk drive space for the selected 
Output directory.

Exit Close RINEX Converter.

About Opens the dialog which displays information pertaining to the 
software version number.

Help Opens the on-line help system.

 Figure 14.9: Set Input Directory Dialog

 Table 14.2: Ashtech to RINEX Tab Fields  (Continued)

Item Description
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5. Select the file you wish to convert from Ashtech to RINEX format.You can 
select multiple files to batch convert, by holding down the Control key 
while selecting files.

After selecting a file to convert the B-File, E-File, S-File, OBS, NAV, NAV 
G, and MET, fields populate with suggested file names. If you selected 
multiple files to batch convert, the filenames listed are associated with the 
file selected last. 

To avoid confusion, do not change the file names.

6. Click Output Dir to open the Set Output Directory dialog, Figure 
14.10.       

7. Navigate through the directories and drives to select the directory where you 
want to store the converted files. 

To avoid confusion, save the converted Ashtech files to a different directory than where the RINEX 
files are located. 

8. Click OK to accept the directory and close the Set Output Directory dialog.

The Output Directory field lists the directory path.

 Figure 14.10: Set Output Directory Dialog 
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9. Click Additional Info. to open the Additional Info for Selected Files 
dialog to the OBS Tab (Figure 14.11).

Traditionally the information listed in these tabs are stored in RINEX data files to 
give the user reference information about the data. Although this additional 
information is optional, it provides a useful reference for future use.

10. Complete the fields in the OBS Tab. The information entered in the OBS tab 
is stored in the Observation data file. Table 14.3 describes each field. 

[

 Figure 14.11: Additional Info for Selected Files Dialog - OBS Tab

 Table 14.3: Additional Info for Selected Files Dialog - OBS Tab 

Field Description

STATION INFORMATION

Station Name Name of the survey point or station where data was collected.

Station Number Number of the survey point or station where data was collected.

Observer Name or code of the surveyor who collected the data.

AGENCY (Observing) Name of the company or agency who collected the data.

AGENCY (Creating Current File) Name of the company or agency who converted the data to RINEX.

Comments Any comments pertaining to the station, data quality, cover, GPS/
GLONASS, etc. 50-character length limit.
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11. Click Apply to save the changes made to the OBS Tab, and click on the Nav 
Tab to switch to the Nav Tab (Figure 14.12).

You can enter information for all three tabs and save all the data using the Save button. The best 
practice however, is to save the data for each tab immediately after entering the data in case of a 
computer or power failure by using the Apply button.

RECEIVER INFORMATION

Receiver Serial # Serial number on the receiver to identify exactly which receiver 
collected the data.

All Optional Headers Check this box if you want all non-mandatory fields to be filled-in 
the RINEX file header.

ANTENNA INFORMATION

Offsets North (m) Horizontal distance, in meters, that the antenna is offset from the 
marker in the North/South direction. + is north, - is south.

Offsets East (m) Horizontal distance, in meters, that the antenna is offset from the 
marker in the East/West direction. + is east, - is west.

Delta Vertical (m) True vertical distance, in meters, between the bottom of antenna and 
the marker.

Radius (m) Radius of the antenna in meters.

Slant Distance (m) Measured distance, in meters, from the edge of the antenna to the 
marker.

Type Type of antenna used in data collection.

Antenna Serial Number Serial number of the antenna to identify exactly which antenna was 
used for data collection.

 Table 14.3: Additional Info for Selected Files Dialog - OBS Tab  (Continued)

Field Description
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The Save button saves the data entered on the active tab only, and closes the Additional Info for 
Selected Files dialog. 

12. Complete the fields in the NAV tab. The information entered in the NAV 
Tab is stored in the Navigation data file. Table 14.4 describes each field.     

 Figure 14.12: Additional Info for Selected Files Dialog - NAV Tab

 Table 14.4: Additional Info for Selected Files Dialog - NAV Tab 

Field Description

Agency (Creating Current File) Name of the company or agency who converted the data to 
RINEX.

Comments Any comments pertaining to the station, data quality, cover, 
GPS/GLONASS, etc. 50 character length limit.
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13. Click Apply to save the changes made to the NAV Tab, and click on the 
MET tab to switch to the MET tab, Figure 14.13.          

14. Complete the fields in the MET tab. The information entered in the MET 
tab is stored in the meteorological data file. Table 14.5 describes each field.

 Figure 14.13: Additional Info for Selected Files Dialog - MET Tab

 Table 14.5: Additional Info for Selected Files Dialog - MET Tab 

Field Description

Station Name Name of the survey point or station where data was collected.

Agency (Creating Current File) Name of the company or agency that converted the data to RINEX.

Comments Any comments pertaining to the station, data quality, cover, GPS/
GLONASS, etc. 50-character limit.

Meteorological Data Listbox Date and time atmospheric data was collected (atmospheric pressure, 
temperature, relative humidity, and ZWET (Zenith Wet Tropospheric Delay).

Edit Click this button to open the Edit dialog and edit the selected 
Meteorological data line.
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15. Click Edit to open the Edit dialog and change the Meteorological data.

16. Enter the meteorological data and the data and the UTC time that the data 
was taken, and press OK. Table 14.6 describes the fields in the Edit dialog. 

17. Click OK to accept the meteorological data and close the Edit dialog.

 Figure 14.14: Edit Dialog

 Table 14.6: Edit Dialog 

Field Description

Date The year, month, and date that the data was recorded. D is the day of the month (not 
Julian day) the data was recorded.

Time The time the data was recorded. H is the hour of the day the data was recorded in 
UTC time (24 hour time scale)  M is the minute of the hour the data was recorded in 
UTC time. S is the second of the minute the data was recorded in UTC time

Pressure (mbs) The recorded barometric pressure of the atmosphere in millibars.

Dry Temp (C) The recorded temperature of the air not corrected for humidity, in degrees Celsius.

Rel. Hum (%) The recorded relative humidity of the air in percent of 100. 

ZWET (nm) Zenith Wet Tropospheric Delay—in millimeters (default=0)
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18. Click Save to save the changes made to the Met tab and close the 
Additional Info for Selected Files dialog. 

• The Apply button saves any changes made to the active tab, and do
not close the Additional Info for Selected Files dialog.

• The Save button saves any changes made any tab, and closes the 
Additional Info for Selected Files dialog.

19. Click Begin to convert the selected Ashtech files to RINEX format.  A stat
dialog opens, showing the status of the conversion process.  Upon 
completion, the box indicates 100% for each file. 

20. Click OK.  

A *.log file is created in the conversion directory.  When started, RINEX 
converter overwrites the previous *.log file.  To save the previous *.log fi
rename or move the file before starting RINEX converter. 

Converting More than One File at a Time (Batch 
Processing)

To convert more than one file at a time:

• If the files are contiguous, use  Shift and click to select the group.
• If the files are scattered throughout the directory, use Control and click to 

select the desired files. 

If you are using a Trimble Community Base Station for your Base Station data, you must first 
convert the files (which are in the Trimble-proprietary SSF format) to RINEX. You cannot convert 
these files directly to Ashtech files.

Interpolating RINEX Data

A RINEX Interpolation program has been supplied with Reliance Processor to a
you to interpolate RINEX files to shorter intervals that will better match your Rov
data. For example, typical Base data you get from the CORS site has an interval
seconds, while your typical Rover data has an interval of 2 seconds. Therefore, 
should interpolate your CORS base data down to 2 seconds to match your Rove
interval in order to get the best possible results when processing the data.
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The RINEX Interpolation program can be accessed from the Tools pull-down menu 
in the Reliance main window. Its operation is described below. 

Clicking on the Input O-File button will bring up the screen below. From this screen, 
select the appropriate RINEX O-file (GPS measurement data) to interpolate.

 Figure 14.15: RINEX Interpolation dialog

o

 Figure 14.16: Open RINEX O-File dialog
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After selecting the Input O-File, specify the Output File Name and New Interval.

Now press the Interpolate button. A progress bar will appear at the bottom of the 
screen to show you the status of the interpolation. 

The Interpolation program does not need to alter to the RINEX N-file (ephemeris data). The original 
N-file name will be copied to the same new name you specified for the output O-file. For the example 
above, the file “rcm6rcm61390.98n” will be copied to “rmc6interp.98n”.

 Figure 14.17: RINEX Interpolation with file names dialog
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Joining Data Files

A Join Files Utility program has been supplied with Reliance Processor to allow you 
to join multiple Base files into a single file for easier processing of your Rover data.

The Join Files program can be accessed from the Tools pull-down menu in the 
Reliance main window. 

The Base Station files could be in either Ashtech or RINEX format. Select the proper 
file format in the File Type to Join box. 

In order to correctly process the Rover data, the Base Station files to be joined should 
be consecutive in time. Clicking the Options button brings up the following dialog, 
which allows you to select the maximum allowable time gap between the files you are 
joining. It is recommended that you keep this value at 120 seconds (default) or less in 
order for the Reliance Processor to process the Rover data successfully.

 Figure 14.18: Join Files Main dialog

 Figure 14.19: File Join Options
Reliance Office User’s Guide
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On the main screen, press the Add File to List button to bring up the Open dialog:

Note that you can select several files from the same directory at once in this dialog. Highlight the files 
that you would like to join and press Open. This will return you to the main screen.

To join the files shown in the listbox, press the Join Files in List button. A Save As 
dialog will now appear, which allows you to name and place the new file you are 
creating.

 Figure 14.20: Open Files to Join dialog

 Figure 14.21: Save As dialog
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After clicking Save, the Join Files program main screen will appear and show a 
progress bar at the bottom right.    

After the files are successfully joined, they will clear from the listbox display.

   

 Figure 14.22: Join Files Main dialog with Progress
Reliance Office User’s Guide
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Waypoint File Converter

A Waypoint File Converter program has been supplied with Reliance Processor for 
those who already have a list of several waypoint entered in a standard ASCII text 
file. This program allows these points to be easily converted to the Reliance 
Waypoint File format. This program allows you to convert Reliance Waypoint Files 
to readable ASCII files as well.

The Waypoint File Converter program only works with latitude and longitude positions that are in 
the WGS-84 coordinate system.

The Waypoint File Converter program can be accessed from the Tools pull-down 
menu in the Reliance main window. 

The selections in the File pull-down menu are described in the following table:

 Figure 14.23: Waypoint Converter dialog

 Table 14.7: Pull-down Menu Descriptions

Selection Description

New, Open, Save, 
Save As

Standard file operations to be used on ASCII text files (default *.txt) that contain 
waypoint information.

Import Imports Reliance Waypoint Files so that they can be saved and/or printed as an 
ASCII text file.

Export Exports ASCII text files of waypoints to the Reliance Waypoint File format.
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Below is an example of how this program is used:

1. Select Open in the File pull-down menu to open an existing ASCII text 
waypoint file.

Options Allows you to specify how an existing ASCII text file of waypoints is formatted in 
order to create a valid Reliance Waypoint File when exporting.

Print, Print Pre-
view, Print Setup

Allows you to print the current waypoint file displayed in the Waypoint Converter 
window.

Most Recent Used Shows a list of the most recently used files for quick re-selection.

Exit Exits the Waypoint Converter program.

 Figure 14.24: Open dialog

 Table 14.7: Pull-down Menu Descriptions

Selection Description
Reliance Office User’s Guide
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2. Click on the Open button to load the file into the Waypoint Converter 
window display.

3. Select Options in the File pull-down menu to make sure the format of the 
opened file is correct for exporting.

In the Options dialog you can specify how the waypoint information is delimited, 
what the order of the fields are in, and what quadrant the waypoints are in...

 Figure 14.25: Waypoint Converter dialog with Waypoints

 Figure 14.26: Options dialog
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4. Select Export in the File pull-down menu to save the ASCII waypoint file to 
a Reliance Waypoint File format.

The new file created should have the *.WPT extension so that Reliance Processor and the handheld 
FAMlog will recognize it.

 Figure 14.27: Save Waypoint File dialog
Reliance Office User’s Guide
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Decompress GZ Files

A small utility program has been provide with Reliance Processor that allows you to 
easily decompress files that have been packed by the GZIP program. Typically, files 
that have been “GZIP’ed” are Base data that is located on the CORS Internet si
These files usually have the extension “gz”

In Reliance, this program appears as a standard Save As dialog. It can be acces
selecting Decompress GZ Files from the Tools pull-down menu in the Reliance m
window..

Simply select the appropriate file to decompress, choose an appropriate destina
directory, and click on the Decompress button.

 Figure 14.28: Select Files to Decompress dialog
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System Requirements

How much hard disk space does my PC need?

With Windows running, 20 Mb of free disk space is needed to install Reliance 
Processor. You should plan on devoting a large portion of your hard disk space to the 
Reliance Processor, in order to accommodate data files and other information sets that 
will accumulate as you use the system.

What type of  processor does my PC need?

If you can run Windows 95™ or Windows NT™ on your PC, you can run Reliance
Processor. We recommend a Pentium system with 64 megabytes of RAM for best
performance. Reliance Processor will perform well on most GIS-ready PCs.

Can I run other applications while Reliance Processor is running?

Yes. Reliance Processor will run along with other Windows applications. Reliance
Processor will even download and process data while you are using other Window
applications. However, you must have enough resident memory to support the 
fundamental requirements of all the open applications.

Reliance Processor Window

Why can’t I re-size the Reliance Processor window?

Reliance Processor has a unique “unbounded” interface that allows its dialog window
to appear outside of the main Reliance Processor window. The main window can b
maximized to fill the entire screen, or can be minimized to be just a title and tool b
You can now run a Windows desktop mapping or GIS program alongside your 
processing software, for easy verification of results and simplified file transfers.

Project Setup

What is a project?

A project is the collection of all the field and base data collected for the particular re
being mapped, as well as any related Feature and Change information. A project a
has a “state,” or set of defined operating parameters, that may vary from one proje
another. As an example, one user of the data you process may wish to receive the
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exported data in Latitude/Longitude (Geographic) Coordinates, using the WGS84 
ellipsoid, while another might request all project work be delivered in UTM 
Coordinates with the North American Datum of 1927 as their frame of reference. 
These values are set in menus within the Project Control dialog window.

What is a session?

A session is a particular set of GPS measurements and features. A session can last 
as little as a few minutes or as long as several days. Each session must contain at 
least one feature. A session ends when a different feature file is selected, the 
recording interval is changed, the session name is changed, or the SCA-12 receiver 
is turned off. Sessions are the building blocks of a project: a pipeline asset 
inventory project might be called Pipeline.prj, while MondayAM.S01 and 
MondayPM.S03 would be valid sessions names for collected field data.

Do I have to use the default directories?

No. The default directory names are just a suggestion. Some users prefer to group 
the base, rover, feature, waypoint, and change files together in one directory on a 
day-by-day or project-by-project basis. However, once you set default directories 
for a project, they must remain the same throughout the project. If you change 
directory names or file locations, the software will be unable to recognize the 
address of a requested data file. We suggest you find a comfortable working setup 
and stay with it to remove chances for confusion.

What type of file can I select as a Rover file?

Files with the “S” extension followed by a two digit number are selectable as a
rover file. For example, wetland.s01 is a valid rover file name.

What type of file can I select as a Base file?

Files that begin with “B” which are in the Ashtech B-file format are selectable a
base file. These files may be logged directly into the PC, downloaded from an
Ashtech receiver, or converted from the industry-standard RINEX format using
Reliance Processor. For example, bbasea96.175 is a valid base file name.

What is a Change file?

A change file contains position and feature information for each point logged in
field. The rover and base files are condensed into a change file for faster sess
loading. Once a session has been loaded and processed, the change file cont
of the required corrected information for displaying, filtering, and exporting the
data. 
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Feature Editor

What is a feature file?

A feature file contains a list of the features that are to be logged in the field. This 
file is created in the office with the Reliance Processor Feature Editor and then 
transferred to the handheld field data logger. Most features will have a list of 
associated descriptive attributes, although some features may not have these 
additional information layers. Attributes can be numbers, text, or menu items. 
There is no limit to the number of attributes you can link to a feature. The feature 
file also describes the point symbols, line colors, line styles, fill colors, and fill 
styles used when displaying logged features in the Map View. 

Transfer and Download

How do I upload feature and waypoint files to the handheld?

Files are transferred between the PC and Handheld using the Transfer dialog. Begin 
by opening the Transfer module from the Project Control menu, or use the Tools 
menu in the Reliance Processor header bar. Once you’ve opened the Transfer 
module, turn on the Husky and exit the Reliance Processor FAMlog software (
the shift key and select the EXIT softkey, release the shift key and type “Y” to 
confirm your exit) Now connect your handheld to the PC using the supplied ca
Once you’re connected to the PC, type HCOM at the DOS prompt, and press 
yes key to launch the HCOM File Transfer Utility. Once you’ve accomplished 
these steps, select and press the “Transfer information between the PC and th
handheld device” button in the open Transfer Data dialog. You’ll see a simplifi
Transfer dialog for viewing, transfer, and file deleting on the handheld.

How do I download files from the GPS receiver?

GPS measurement data and any integrated feature & attribute information are
stored on the SuperCA-12 GPS receiver. These integrated files are transferre
the PC through the Download module in Reliance Processor. The first step in 
transferring files is to connect your receiver to a PC serial port using the stand
female DB9 connector in your backpack system. If you’re working with a base
station, use the DB9 female connector supplied with the standard base receiv
cable. Now turn on the GPS receiver. Next, press the “Download GPS data fro
the GPS receiver” button on the Transfer Data dialog. This will start the Downl
dialog. You should now be able to view, download, and delete files from any 
Ashtech GPS receiver connected to the system. Make sure you select the cor
path for your data files before transferring data. Remember to turn off the GPS
receiver when you’re done with the file transfer process.
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Why aren’t all my PC COM ports shown?

Reliance Processor automatically lists only the available COM ports. For example, 
if your PC has two COM ports and the mouse uses port 1, only port 2 will be listed.

Why are there so many rover files?

New rover files are created each time the receiver is powered on, each time 
Reliance Processor is exited and restarted, each time a session name is entered, 
each time a feature file is selected, and each time the recording interval is changed. 
The creation of these new files is required for Reliance Processor to properly post-
process and locate features in the data.

Refer to Field Operations manual for instructions on how to reduce the number of 
superfluous rover files created.

Time View and Map View

How do I view features?

You can view features in Time View by selecting a rover receiver from the listed 
files, then double-clicking on an item of interest. Selecting a rover receiver is as 
simple as pressing once on the identifying label alongside the file viewing area. In 
Map View, double click on a displayed feature graphic to view the associated 
information.

Where can I view attribute information?

Once you’ve double-clicked on a point feature in Time View or Map View, a 
“feature information” dialog will appear on screen. To view an attribute Name, 
Type, or Value, just click once on the “Attributes” button at lower right in the 
dialog.

Where can I view offset information?

Once you’ve double-clicked on a point feature in Time View, a “feature 
information” dialog will appear on screen. To view the point offset, just click on
on the “Offsets” button at lower right in the dialog.

How do I select or change the map system used in Map View?

Mapping systems are modified at the overall project level. Start by clicking on 
Project Setup icon under the Project Control menu. When the window opens, p
on the Map System button to access the various functions. Map System will dis
a selection of projections, datums or zones, and display modes. Note: Changi
these settings affects all files within the open project. If your local area is not lis
in any of possible combinations of the Map System function, you can set your o
Refer to Chapter 13, Setting Up a Map System for additional instructions.
Reliance Office User’s Guide
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Filter

How do I filter features by attribute value?

Most features will have attributes. And by definition an attribute will have a value, 
such as numbers, text, or associated menu items. These values are entered either as 
a listed value, or the field operator will have key-entered the information directly. 
To filter an attribute or feature by an associated value, the first step is to open the 
Filter Data module from Project Control, or the Tool Bar. The dialog you’ll see h
two windows; one for Sessions/Features to Show; and the other for Session/
Features to Hide. To filter a particular feature, use the arrow keys in the cente
the window to move features from one side to the other. To filter by value, ma
sure the data you wish to work with is in the Show area. Now press on the By V
button. If a feature has any associated attributes, they will be displayed in the 
Attributes list when that Feature is highlighted. The Filter Selection function loo
at the attributes, and their associated values, and will present a list of choices.
example, when using the sample dataset provided with the system, a Tree’s h
can be used as a modifying factor in your selection process, so only those surv
trees judged to be healthy will be displayed and made available for transfer to 
GIS.

Does filter affect the exported data?

Yes. Data which has been excluded in the filtering process will not be exporte
shown in Time View or Map View.

RINEX Converter

Can I use a base station receiver from another manufacturer?

Yes, provided the files have been converted to RINEX format. Once in RINEX
format, these files are readily converted to Ashtech format using the Reliance 
Processor RINEX Converter.

Can I convert Reliance Processor Data to Rinex format?

Yes, but the feature information will be lost in the conversion.

Process

What is the difference between submeter and decimeter processing?

Submeter processing uses smoothed C/A code data, and is available from all 
Reliance Processor receivers. Decimeter processing requires either the purch
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a Decimeter system, or an upgrade to your Submeter equipment. Decimeter results 
are obtained by using the carrier phase of the L1 satellite signal.

Export

What file formats can I export data to?

ESRI Shape (SHP) and Generate (GEN) formats, Autodesk Text and Binary (DXF) 
files, the standardized Intergraph ASCII (ASC) output/input structure, MapInfo 
Format (MIF) and a User-defined ASCII text (UDA) format. All GIS systems will 
accept at least one, if not all, of these basic data formats.

What exactly is exported?

Feature names, attributes, and positions are exported. Feature symbols are not 
exported.

What map system is my exported data in?

When data is exported, the map system used will the one that is selected in Project 
Setup/Map System. The INF file, which is also created when data is exported, 
contains map system information as well.

GPS 

In most cases you’ll probably find you’re within 35-50 meters of your actual position if you compare 
the system reading with a known point. However, SA fluctuates so much you could be 35 meters ove
there one minute, then 50 meters the other way 10 minutes later.

What is differential GPS, and how do I get it?

Differential GPS is a straightforward method to overcome the effects of SA. There 
are two basic ways to achieve differential results. The most common uses a 
computer to process data collected and stored while in the field, then downloaded 
later to a system. Another method is by receiving radio signals that provide 
corrections in real time. The first is known as Post Processed Differential, the later 
as Real-Time Differential. Each is useful, although post-processing is the most 
common, reliable, and proven method now available. Ashtech receivers operate in 
either mode. 

The fundamental theory behind differential correction is simple. At least two 
receivers must operate at the same time, with one unit located on a known point. 
Both receivers must be using the same set of satellites to derive positions. In post-
processed differential, GPS data collected on the known point (by a receiver 
usually referred to as a reference station) is used, after the field survey is 
Reliance Office User’s Guide
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completed, to remove inaccuracies from the field data. The process actually finds 
its roots in the principles of quadratic equations. 

Post-Processed differential corrects for SA after collection (post-processed), while 
Real-Time differential applies corrections while you’re in the field. 
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GPS Concepts

The Global Positioning System (GPS) is used for worldwide navigation and positioning, 
which includes surveying, mapping and Field Asset Management (FAM). Utilizing GPS 
as a FAM tool along with Geographic Information System (GIS) software will allow you 
to obtain field asset maps with very accurate positioning information in a cost-effective 
way.

Overview

GPS consists of a network of 24 orbiting satellites, maintained by the U. S. Department of 
Defense, which are open for commercial and private use by anyone at no charge. GPS 
satellites are at an altitude of about 20,000 km, which puts them in 12-hour orbits around 
the Earth. Each satellite broadcasts a coded radio signal on two frequencies - called L1 and 
L2. The Coarse/Acquisition (C/A) code is broadcast on the L1 frequency and the 
Precision, or P, code on both the L1 and L2 frequencies. Not all GPS receivers can track 
all the codes and frequencies that the GPS satellites transmit.

Use of GPS

Though GPS positioning is available around the world, GPS receivers cannot pick up the 
satellites’ signals unless they have a clear view of the sky. GPS works almost everyw
though dense tree canopies and “urban canyons” may significantly degrade GPS pos
Nevertheless, GPS is now accepted as the positioning technology by a majority of 
surveying, mapping, and FAM applications.

Accuracy

The accuracy of stand-alone GPS positions is 100 meters. This can be greatly impro
using a technique known as Differential GPS (DGPS). GPS measurements are recor
a reference receiver at a known location (called a GPS base station) at the same tim
the field measurements are recorded by the rover receiver. Data is processed after t
or “post-processed”, by sophisticated PC software. Differential GPS can also be 
performed in real-time using correction data broadcast from a reference receiver (typ
in RTCM format).

The real-time DGPS method, requiring the use of a radio link between the reference
rover GPS receivers, can provide 1-3 meter accuracy. Post-processing mode can be
accurate, (less than 1 meter for the Reliance Submeter package and as good as 1-2
decimeters for the Reliance Decimeter package), more reliable and is less expensiv
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Error Sources

The Reliance system utilizes DGPS techniques to obtain accurate position 
information. The typical error sources that affect DGPS also affect Reliance. These 
error sources include:

• GPS signal multipath
• GPS satellite geometry
• Maintaining lock to satellites
• Selective Availability (SA)

Refer to “You may also transfer Waypoint and Feature Files back from the hand
if you wish.” on page 72 in Chapter 6, Data Collection.

Coordinate Systems / Datums

While the GPS receiver performs all its position calculations in the WGS-84 
coordinate system, there are conversions available for hundreds of other coordin
systems and datums from around the world to allow you to use the appropriate 
coordinate system and datum for your application. Reliance also allows user-de
transformations.

General

The Global Positioning System (GPS) is a remarkable new technology. It can pro
a position fix virtually anywhere on the Earth, 24 hours a day, 365 days a year. 
Positions are calculated in the GPS receiver by a (relatively) simple process of 
distance measurements, working with extremely accurate time codes broadcast
network of 24 orbiting satellites. The satellite system is operated by and funded 
through the US Department of Defense. GPS receivers are passive systems, an
require no access code, user fee, or special operator’s license.

Since the US Department of Defense (DoD) is concerned with the security of Un
States, it has developed a program of intentional GPS signal disturbance, known
Selective Availability (SA). By manipulating information broadcast by the satellite
SA provides a reasonable level of accuracy for recreational use (about 100 mete
while disrupting “unauthorized usage” such as missile guidance systems and art
targeting. 

Although SA produces a disrupted signal, these “degraded” signals are still quite
usable, and a great many ways of circumventing SA have been devised. The ba
process is simple in concept, and straightforward in practice. Known as Differen
GPS, it involves the use of more than one receiver. 

Pay close attention to sampling rates when you’re working with a mixed set of 
receivers. Remember to allow for increased collection times if you’re using a bas
Reliance Office User’s Guide
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station that samples every five seconds or more. Reliance receivers have no problems 
working with these “slow” sample rates Make sure to allow for sufficient overlapp
data. Various testing programs around the United States have determined that a
minute static occupation time should fulfill virtually every GIS data acquisition 
requirement. The Reliance Decimeter system produces 10 cm + 1 ppm accurate
results with five minutes on a point.

Mobile operations may require a faster sampling rate at the reference station, 
depending on the speed of the field data collection platform, and the required de
of sampled points in the collected file. 

Decimeter operations with Reliance systems are readily achieved with RINEX d
However, you should check to make sure both CODE and CARRIER phase data
the L1 frequency, at an appropriate sampling rate, are acquired by your base un
your equipment can fulfill these basic requirements, we can process RINEX data
you originated it.

Although these upgraded units may have been changed, many systems are still
fully synched with GPS. While they will collect valid data on the second, they ma
not be in synch with the overall time standard. For example, setting a 5-second e
interval on some of these new base stations results in data collected at:06 and:1
and:16 seconds past the minute. When an Reliance system is set to a 5 second
interval, it collects at:05 and:10 and:15 and so forth. It is synched to the GPS se
and to overall GPS time. The two datasets just described will not process, since
measurements are off by one second. Make sure the reference data you work w
either fully synched to GPS time, or set your field receiver to 1 second data colle
interval in order to fit into the unreliable time frame of the reference station. 

This manipulation may sound complicated. But once you have the correct proce
it’s a simple, accurate, workable process. Ensuring compatibility is assured once
set up. Call your Reliance representative for additional technical assistance. 

GPS under Trees

GPS receivers are not at their best in forests. Signals from the GPS constellation
be able to reach the receiver for it to produce a position fix. If you’re behind a rid
building, or other solid mass, those signals won’t get through. Trees, on the othe
hand, vary in their ability to obscure and disrupt the acquisition of position fixes. 
Your ability to obtain a fix depends on issues such as crown closure, stand dens
elevation of satellites, and leaf type. 

For the most part, with proper planning you should be able to get fixes just abou
anywhere. You should collect data when satellites are higher in the sky relative 
your position. More satellites overhead means less chance for signal blockage b
trunks, the real culprits in forest-region survey work. For best results the receive
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should definitely be out in the open, but with proper planning you should be 
successful wherever you go. Take a 50-meter steel tape and good compass when 
you’re in difficult areas. If you can’t get a position fix in a particular spot, measur
out an offset and enter the value in the Reliance Field Asset Management softw
The offset position automatically makes corrections in the post-processing 
calculations. 

Multi-channel GPS receivers

Acquiring a GPS position involves, either three or four satellites, depending on 
whether we’re looking for a 2D or 3D fix. In general, if you’re looking for reliable,
accurate results, you should have at least four or more parallel channels with wh
receive data. Three-channel and fewer receivers are suitable for recreational us
are not reliable for professional applications. Ashtech Reliance systems are all 1
channel receivers. In addition to maintaining a lock on all satellites that may be 
overhead, such “all-in-view” receivers also “over-determine” a position fix using 
more measurements. Ashtech Reliance systems are designed with these featur
provide more accurate results, faster operation in areas of intermittent obstructio
and superior satellite tracking capability.

The GPS signal

Briefly, the GPS signal is time codes used to calculate distance from satellite to 
receiver.

Satellites in the GPS constellation broadcast on two Carrier frequencies, L1 and
The L1 Carrier signal carries three phase modulated messages, the C/A Code (u
virtually all GPS receivers), P Code, and a data sequence. L2 is made up of a C
phase and a P Code message. The L1 Carrier frequency has a wavelength of 19
while L2 is about 25 cm. L1 is broadcast at 1575.42 MHz, and L2 at 1227.60 MH

A cellular phone is about 850 MHz, and microwave ovens are around 2000 Mhz.   GPS signals were 
intentionally designed to be broadcast in a relatively “dead” area on the electromagnetic spectrum, 
to avoid interference problems. Ashtech receivers are noted around the world for their resistance to 
jamming from outside interference. However, many other receivers now available are adversely 
affected by sources such as microwave towers, heavy radio traffic in port and harbor operations, and
so on. Contact your local Ashtech representative for a copy of an independent survey of receivers 
under adverse RF interference conditions. The Ashtech Reliance is unaffected by power lines as a 
source of interference.
Reliance Office User’s Guide
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Course Acquisition (C/A) Code is the fundamental source of positions data. Each 
satellite has its own code, denoted by the acronym PRN, or Pseudo Random Noise. 
When you hear someone speaking about PRN 17, they’re referring not only to th
satellite, but also to the nature of the C/A Code it’s broadcasting. C/A Code has 
wavelength of about 300 meters.

L1 Carrier has a wavelength of 19 centimeters and is the most common source 
centimeter-level accuracy in position fixes. 

The Data Sequence that’s also broadcast contains useful information such as alm
ephemerides, and other “housekeeping” data important to the operation of the 
receiver. Ephemeris data are used directly in the process of computing a fix, by 
providing an orbital frame of reference. Since GPS position data are calculated i
process of trilateration (the intersection of linear measurements from a remote ob
the ephemerides provide the location from which a receiver calculates a distanc

For more information on the broadcast message and other GPS information, ref
the Guide to GPS Positioning, by David Wells of the Canadian GPS Associates.
Obtain this well-detailed (yet surprisingly accessible to the non-professional) ma
from the Canadian Institute of Surveying and Mapping, Box 5378, Postal Station
Ottawa, Ontario, Canada, K2C 3J1. You may also call and request a copy at 613
9851 use a Visa/Mastercard; the price is $35.00 Canadian, but well worth the pr

GPS Ephemerides

Ephemerides are automatically received and stored by the receiver as a normal p
its operation. They provide a precise (within the scope of SA) frame of reference 
which a receiver calculates a position fix. In addition, the Reliance system acqui
and stores an Almanac of predicted satellite orbits. This almanac is used as a “r
map” of intelligence about where satellites are, and will be. Every time you turn o
your Reliance system it uses almanac data to determine which are the most favo
satellites to use when calculating a position fix.

Dilution Of Precision (DOP) is a measure of the geometric quality of a satellite 
grouping. Since GPS positions are determined by measuring from a series of 
satellites, better geometry in the sky means better results on the ground. DOPs 
referred to on ascending scales, where 1 is great, 3 is OK and a 6+ number may
negative effects on the results. In general, the more evenly distributed satellites 
across the sky, the better your results are after the fact. You can program your 
Reliance system to warn you, or ignore, position fixes and data gathered when 
geometry is bad. You can run the mission planning software to produce a graphic
of DOP levels across your work day. As a rule of thumb for most operations, you
encounter poor DOPs when parts of the sky are obstructed, reducing the numbe
available satellites. Urban/suburban operations close by large buildings, or fores
eference  199
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natural resource applications where you’ll be under heavy tree canopy and on s
hillsides can all effect your DOP levels. The Reliance Mission Planning software
allows selective masking of various parts of the sky when you’re creating a field w
plan. If you’re on a south-facing slope, you can block out the northern sky and 
determine when the times for best accuracy.

In most cases, you need not think about DOPs very often.

Measurement Units, Map Projections, 
Coordinate Systems, and Datums

Ashtech uses standard survey measurement units, such as meters and feet (US
International). Most surveyors and GIS operators work in meters, although some
work in feet. Ashtech also offers the capability to define your own coordinate syst
and datums. This involves map projections, coordinate systems, and datums.

A map is developed using a projection, a mathematical translator between the 
round(ish) Earth and the flat map. This is actually quite complicated, because a m
flat and the Earth is not. The Earth is really not a sphere either, it’s more like an 
orange. Frankly, any map is inherently inaccurate because it “stretches the corne
fit. 

Grab an orange and try to wrap a sheet of paper around it without folds or wrink
The only way to get the paper to wrap evenly is to cut here, nip there, and tuck i
few places. That’s what a map projection does, it takes a round surface and spre
onto a flat one, doing the best job it can to avoid distortion along the way. 

The challenge is to make a projection that fits best throughout the space it covers
the least distortion possible. There are many of these projections available to the
maker, but for the most part there are a handful of projections in practical use to
Ashtech Reliance software supports all of these common projections.

Coordinate systems describe where you are in a map projection. Some people u
Northings and Eastings from an agreed-upon starting point, and describe their 
positions in meters or feet. Others work in Latitude and Longitude, which divides
Earth into degrees, minutes, and seconds. A convenient rule of thumb to use wh
working in Lat/Lon is one second of Latitude equals 30.92 meters on the ground
find the same measure for Longitude, calculate the cosine of the Latitude, then 
multiply this number by 30.92 and you’ll have the distance for a second of Longit

Datums are more refined versions of the ellipsoid. OK, so what’s an ellipsoid? T
official term for the Earth is an oblate spheroid, although for some reason it’s mo
frequently referred to as an ellipsoid. Mathematicians have developed a number
ellipsoids, the most common being Mr. Clarke’s, developed in 1866. A datum is ju
locally refined version of the ellipsoid, a more precise description of the local 
Reliance Office User’s Guide
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characteristics. (It may or may not be more precise, but it is the locally accepted 
definition.) 

As an example, in the United States, we have NAD27 and NAD83--the North 
American Datums of 1927 and 1983. Nothing’s really moved on the Earth in the
years between these two but the accuracy of the definitions has improved 
considerably. A new Worldwide Geodetic System was developed in 1984. It is u
across the globe by GPS receivers as a standard reference of datum and ellipso
importance to a GPS user is making sure you get the datum correct when you p
coordinates to your map. A mistake in selecting the correct datum almost always
results in a sizable error. The difference between NAD27 and NAD83 is minimal
Bloomington, Indiana, about 42 meters in Albany, New York, and about an even
meters in Las Vegas, Nevada. 

Why are there such differences? The NAD83 is a more refined, and better descr
mathematical description of the ellipsoid in North America. Any differences betw
it and the NAD27 are really improvements. The WGS84 is based on the NAD83
least this is the case for all practical purposes when working with GIS-level GPS
results (<1 meter accuracy) any difference between the two is centimeters of 
background noise. However, when you get into the <30 cm accuracy of the Relia
Decimeter unit, a small difference can have an effect on your results. Make sure
select the right datum when to process your data. 

Many users find the Reliance system far more accurate than the GIS base maps
example of how this shows up would be a road edge acquired by the Reliance s
follows the true line of the feature, while the road location in the GIS is offset. Th
Reliance system can then be used as a constant source of map accuracy updat
improves the relational accuracy of the GIS database every time it’s used in the 

Ashtech Reliance software takes care of all the details for you. Just make sure t
select the proper values in the Map System section of the Project Setup dialog b
and the Reliance output will match your maps. If they don’t match, look very 
carefully (on both sides of the process) to make sure you selected the right datu
projections, and coordinates. Then look at your base maps again. Chances are 
origin scale or reference method was off somewhere in their history. 

GPS is an extremely accurate tool. In more than just a few cases it’s found prob
with maps that were thought to have been quite good. If this happens to you, or 
think it’s happening, check your procedures, run your sessions again, and reche
all again. If you’re still looking at GPS positions that appear out of place after thr
tries at the data, run another check by tying a few known points together on the 
with your GPS equipment. Use National Geodetic Survey control points if possib
Since NGS points are very accurately described, you’ll have a good baseline 
measurement for comparison. If the GPS-derived distances between the points 
the values that you’ve derived from NGS-supplied materials, but the distances a
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different on your map, you’ve got a problem with your map. GPS can help you fi
these type of offsets.

Post-Processed Differential with GPS

If two identical sets of data, both degraded by SA with one set of data (one end o
quadratic equation) was gathered on a known point, a software program can calc
the magnitude of the SA-induced degradation. These calculations are then used
another software processor to remove errors from the dataset acquired in the fiel
other end of the equation). The process is automated in the Reliance software. F
basic rules must be followed:

• You must use at least two receivers.
• You must take data files at overlapping times.
• You must use the same sets of satellites in each receiver.

With a little planning, some care, and a manual nearby on your first try, you’ll fin
the differential process is easy to use. Remember the four basic requirements, a
underlying principle of identical datasets.

You can use more than two receivers at a time. In fact, with an Ashtech Continuo
Operating Reference Station (CORS), you could serve the needs of hundreds o
receivers from one centralized station. You must make sure at least one of the u
your differential operation is on a control point. Without a tie to an absolute contr
or known point, any differential results will be accurate to each other, but there w
be any reference to the rest of the world. Establishing a precise location for a co
point determines how well your field collection will tie into maps from other sourc
However you choose to collect position fixes in a particular area, make sure you 
with a consistent control point, or your results will be scattered.

Data taken by field and control receivers must be acquired concurrently. Fortuna
extremely accurate timing data is part of the GPS position record, so your data s
need only OVERLAP. Make sure your data collection is concurrent over a speci
time period. The Reliance takes care of the rest. 

Real-Time Differential with GPS

An accurate fix on your current location is achieved through a simple-in-theory 
process known as real-time differential. Real-time works in the same basic way 
post-processed differential. It compares reference data with a known position. 
However, instead of collecting data for after-the-fact correction, a radio signal is
broadcast which carries the corrections. You’ll need some form of radio receptio
Reliance Office User’s Guide



Technical R

T
echnical R

eference

tion. 
 prevent 
 on 

 of 
wer 

iles 
tive 

ed. 
adio 

these 
with 
nsult 
device tuned to the broadcast frequency and linked to the GPS receiver, which 
calculates accurate position fixes as it receives corrections. 

The drawback is that the range from the control station is limited by the power and 
type of radio broadcast system. Without radio contact, there’s no real-time correc
The Reliance system has on-screen messages, as well as setup parameters that
you from working with uncorrected data. If radio contact is lost, most people rely
post-processed differential. 

There is no way to predict the range of real-time systems. However, a good rule
thumb for portable transmission stations is 25/25/25. This refers to 25 watts of po
broadcast from 25 feet above ground level producing an effective range of 25 m
over generally even topography. If your survey area is hilly or wooded, the effec
range of your radio system can be sharply limited. New digital communications 
systems, as well as cellular telephony, can communicate real-time corrections. 
However, for most uses, a licensed set of VHF or UHF radio modems can be us
Ashtech can provide technical advice on the advantages and disadvantages of r
systems.

Real-time is so useful that companies have been formed to offer accuracy 
improvement services. Typically these companies work through FM subcarrier 
frequencies and use “pager” technology to receive the corrections. The fees for 
services are relatively inexpensive, typically around $100.00 per month, usually 
unlimited access. Some companies offer corrections data with a satellite link. Co
your local dealer for the latest Information.
eference  203
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How to contact Ashtech Technical Support

You can obtain technical support by phone, fax, electronic mail, postal mail, and through 
our bulletin board system.

• Technical Support (USA) Phone: 800-229-2400 (toll free) or 408-524-1400
• Technical Support (USA) Fax: 408-524-1500 
• Technical Support E-mail: support@ashtech.com

Technical Support by E-Mail

You may contact Ashtech Technical Support by e-mail through support@ashtech.co
Include as much information as you can to describe the problem that you are encoun

Technical Support by Postal Mail

You may contact Ashtech Technical Support by postal mail. Include as much informa
as you can to describe the problem that you are encountering. Address your 
correspondence as follows:

• ASHTECH RELIANCE SUPPORT
• 1170 KIFER ROAD
• SUNNYVALE, CA. USA 94086-5314

Technical Support by Bulletin Board System

The Ashtech Bulletin Board System (BBS) has facilities to leave support questions a
problem reports. Just follow the instructions when you log on. Be sure to tell us how 
contact you

Once on line, you may find that certain general problems have already been solved 
recommended procedures are specified waiting for you to download it to your compu
Especially read the bulletins. They will provide you with the latest information.

• Bulletin Board System (USA): 408-524-1527

Suggestions and Comments

We welcome suggestions. You can pass your suggestions to us by any of the mean
mentioned above. Short, concise suggestions can be left by phone, but long or invol
upport  205
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suggestions are best handled in writing. We have found that e-mail and BBS upload 
are the most convenient way to leave suggestions.

Sales, Marketing, and Other Business

For correspondence other than support issues, please address your correspondence as 
follows:

• ASHTECH
• 1170 KIFER ROAD
• SUNNYVALE, CA. USA 94086-5314
• Phone (USA): 408-524-1400
• Fax (USA): 408-524-1500
Reliance Office User’s Guide
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The following flow chart demonstrates how to build a new project.

 Figure A.1: New Project Flowchart
w Project A-1
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Base Station
See Reference Station.

B-File
Binary file in Ashtech format that contains 
proprietary GPS measurement data format 
which is stored in the receiver.

C/A
See Coarse/Acquisition Code.

Carrier phase data
Refers to the measurement of the phase of the 
GPS signal.

C-File
Ashtech proprietary data file containing the 
positions computed and stored by the rover 
receiver.

Coarse/Acquisition Code
Coarse/Acquisition code modulated onto the 
GPS carrier.

Datums
The mathematical definition of a surface from 
which coordinates of a given system are 
referenced.

Decimeter
One tenth of a meter or 10 centimeters.

D-File
Ashtech proprietary file which is created by 
Field collection software and stored in the 
receiver.

DGPS
Differential Global Positioning System. 
Commonly used to refer to Real-time 
differential correction techniques.
Glossary
Differential Correction
The process of applying the difference between a 
computed position at a point and its known value 
in order to apply this “correction” to other GPS 
receivers in the area.

Differential GPS
See DGPS.

DOS
Disk Operating System. Reliance uses MS-DO
developed by Microsoft.

E-File
Binary file in Ashtech format which contains the
ephemeris data.

Ephemeris Data
Information transmitted from a satellite which 
allows the GPS receiver to determine the 
satellite’s position in space.

Export
Taking Reliance data and sending it to GIS 
applications.

FAM
See Field Asset Management.

Field Asset Management
Managing items, their features and attributes, in
field environment.

Generate
The file format for the ArcInfo GIS software 
application.

Geographic Information System
A system of digital maps and attached databas
which is organized by physical location.

GIS
See Geographic Information System.
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Global Positioning System
Constellation of satellites providing worldwide 
coverage for positioning information.

GPS
See Global Positioning System.

GPS satellite geometry
The satellite distribution at a given location. 
measured by the PDOP index.

GPS signal multipath
Occurs when the GPS signal arrives at the 
antenna by a path other than a straight line. 
Causes time delay, which in interpreted as an 
error in distance by the receiver.

INF File
Refers to the file Reliance creates when 
exporting data to keep track of the native map 
system and unit information.

L1
The 1575.42 MHz component of the GPS 
signal.

L2
The 1227.60 MHz component of the GPS 
signal.

PC
Personal Computer.

Post-processing
Computations involved with refining collected 
GPS satellite measurement data.

Projects
Main element of data in Reliance.

Radio Technical Commission for Maritime 
Services

Commonly refers to a format of real-time 
DGPS format.

Reference Station
A stationary GPS receiver logging, or 
broadcasting, data from a known point. The 
Gloss-2
data is used for differential correction. Reference 
Station is synonomous with Base Station.

RINEX
Receiver Independent Exchange Format. A 
“universal” GPS measurement data format 
designed to allow compatibility between differen
brands of GPS receivers.

RTCM
See Radio Technical Commission for Maritime 
Services.

SA
See Selective Availability.

Selective Availability
A technique used by the US Department of 
Defense to degrade GPS signals.

Shape
The file format for the ArcView GIS software 
application.

Submeter
Measurement less than one meter.

Unbounded
Having the ability to switch between applications
without physically switching them

Urban Canyons
A term used in the GPS world to describe a 
operating environment where buildings along a
street create obstructions to the GPS signal.

Waypoints
A term used to describe a pre-determined 
coordinate point to which a GPS receiver can 
navigate.

WGS-84 coordinate system
World Geodetic System, 1984. This coordinate 
system is used by GPS receivers for computing
their positions.
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ACTIVITY.LOG,63
Add Theme,126
Alpha,24, 33
Antenna height,95
Area,42, 88, 100

Features,98
asset,25
Attributes,17

Copying,35
Names,2
Submenus,2
Values,2

Auto Search,136
Autonomous,69
Averaged Base Position,137

B
base station data,23
Batch

Conversion,160
processing,131
Project File,133

baud rate,77
B-File,23
binary,123
bulletin board,205

C
C/A,191
centimeter,1, 5
Change file,24
Chronological data viewer,17
CM Processor,49
COM port,77
Communications Application,84
coordinate system,196
CORS,2, 131, 137
D
Data

Manipulation,16
Post-Processing,20, 49

Data Files
Almanac,23
Change,24
Ephemeris Data,23
Feature,22
Feature Data,23
Filter,22
GPS Data,22
Information File,115
Nav g-file,160
Project,21
Rover,22
Waypoint,22

datum,145, 196
dBASE,122
Decompress,157
D-File,23
DGPS,72, 196
Differential

Correction,20
GPS,72, 192, 195

Dilution Of Precision (DOP),199
Download Rover Data,135

E
ephemeris data,161
Export,17, 192

Data,113
data types,52
formats,115

external sensor,121

F
FAM,5, 195
 Index-1



Feature,17, 47
Asset Management,21
Copying,35
Data File,23
Editor,30
File,14, 29
Information,50
names,2
nesting,46
Symbol,34
types,2

Field Asset Management,17, 198
tools,1

Field Session,13
Filter

Conditions,106
Filtering,103
FTP,62, 139

G
Generic

Area,25
Line,25
Point,25

Geographic,145, Gloss-1
GEOID 96,60
Geoid Model,9
GIS,1, 2, 5, 6, 13, 17
Global Settings,131
GLONASS data,161
GPS,1, 13, 17, 75

Ephemerides,199
Measurement Data,161
Satellite Availability,14
Satellite Geometry,196
Signal Multipath,72, 196
Sources of Errors,72

GZIP,185

H
handheld controller,18
HCOM,71
Height Above Ellipsoid (HAE),60
Index-2
Height Datum,60
Hide/Unhide Points,92

I
Import,129
Information Dialog

attribute,90
feature,88
file,80
Offsets

point,100
receiver,47, 81
waypoint,91

interface,27
Intergraph,21
Internet,2, 62, 64, 69, 75, 131, 132, 139

J
Join/Unjoin Points,93

L
length,42
line,88, 100
Line Features,98
local,95
Local Area Network (LAN),132, 158
Lock

Maintaining to Satellites,73

M
Map

System,17, 59
View,19

Mean Sea Level (MSL),60
Menu,24, 32, 33
Met-file,160
MGE ASCII Loader,128
Miscellaneous,83
Mission Planning,11, 14
Modem,132, 158
Multipath,72

N
NAV-file,160
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Numeric,24, 31, 33

O
observation file,160
Occupancy,18
offsets,47
OSU91,60
Overview Mode,45
overwrite,161

P
PDOP,5, 14, 72
perimeter,42
point,88
Point Features,98
Precision,3, 4, 5
Project,18, 187

Creation,15, 28
Exporting Data,51
Filtering Data,43
Flowchart,A-1
Loading,39
Moving,64
Viewing Data,40

Projection Types
Lambert Conformal Conic,151
Oblique Mercator,152
Stereographic,153
Traverse Mercator,150

R
real-time DGPS,195
Receiver File Selection,56
receivers,195
RINEX,73, 159, 191
RMS,106
Rover,21
RTCM,20, 75
RTCM differential,5
Ruler,97

S
Satellite Geometry,72
SCA-12,1
Index
Selective Availability,73, 196
session,18, 20, 188
Sessions,55
Set Output Directory,161
site information,161
source data files,161
spheroids,154
System

Decimeter,4, 5, 6, 49
Systems

Centimeter,1, 20
Decimeter,1, 3, 54, 69, 72, 110, 121
Submeter,3, 4, 5, 49

T
Time View,19
Tool Settings,157
Tools

Decompress GZ Files,185
Joining Files,178
RINEX Converter,159
RINEX Interpolation,175
Waypoint File Converter,181

Topographical data viewer,17
Trajectory data,108
Transformation,149, 196

U
units,60
Universal Transverse Mercator System,146
User Defined ASCII Files,116
UTC,95

W
Waypoint File,18
waypoint navigation,13, 15
WinZip™,65

Z
zone,145
 Index-3
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